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RESUMEN

En el presente trabajo de tesis se disefio e implementd un sistema de
monitoreo de adquisicion y registro de los parametros eléctricos y
atmosféricos para el control de desempefio de una micro-red eléctrica hibrida.
Se propone un sistema que cumpla con los estandares, como la Comision
Electrotécnica Internacional (IEC por sus siglas en Inglés), que sea de bajo
costo, debido a que su disefio cumple Unicamente con lo estrictamente
necesario para la adquisicion de datos, para el tamafio de la micro-red
eléctrica formada por paneles fotovoltaicos y turbinas eodlicas de 12KW de
potencia total, que se encuentra instalada en una zona costera de Lima,
alejada del sistema eléctrico nacional y que provee de energia eléctrica a la
poblacion de la zona.

En este documento se detalla el estudio realizado de las tecnologias
existentes correspondientes al monitoreo de micro-redes eléctricas y el disefio
del sistema. Concluyendo con su implementacion y verificacion de los

resultados obtenidos mediante este sistema.
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INTRODUCCION

Durante la ultima década, la demanda de energia y la preocupacion por la
contaminacion del medio ambiente se han ido incrementando
dramaticamente. Esto ha ocasionado que la generacion centralizada de
energia y su distribucion a través de largas distancias a altos niveles de
tensién no sean optimas para las necesidades futuras, asi como de zonas

rurales y/o alejadas que no cuentan con acceso a la red eléctrica [1].

Dentro de este panorama es que surgieron las micro-redes eléctricas;
sistemas que pueden solucionar algunos de los problemas presentes en las
redes de generacion eléctrica convencionales. Sin embargo, estas micro-
redes, que se encuentran en proceso de investigacion, no pueden funcionar

sin supervision para que sean mas eficientes.

Con el fin de solucionar el inconveniente de la falta de supervision, se emplean
sistemas de monitoreo; siendo el principal problema que estos suelen ser de
alto costo por las mudltiples funciones que poseen, las cuales no son
empleadas en su totalidad. Lo que implica que en pequefos proyectos de esta
indole no sean viables. En vista de la necesidad de contar con un sistema de
desempeiio confiable y de bajo costo, se vienen realizando estudios para

encontrar las soluciones mas adecuadas.

El objetivo de este proyecto es disefar e implementar un sistema de monitoreo
que adquiera y registre los parametros eléctricos y atmosféricos de una micro-
red, en base a los métodos recomendados por la IEC y que sea adecuado
para la micro-red eléctrica formada por paneles fotovoltaicos y turbinas eélicas
de 12KW de potencia total, que se encuentra instalado en una zona costera
de Lima, alejada del sistema eléctrico nacional.

Asi mismo, como parte del sistema, se debe disefiar e implementar el acoplo
de los sensores hacia el dispositivo principal de monitoreo. A su vez, se tiene
como objetivo complementario el desarrollar el dispositivo central de
monitoreo que convierta, procese y almacene las sefiales anteriormente

mencionadas.



CAPITULO 1: MICRO-REDES ELECTRICAS
1.1 Definiciéon

Una micro-red eléctrica es un grupo de fuentes de energia distribuida, como
paneles solares o turbinas edlicas, ubicadas en el lado de distribucion de la

red y que puede proveer de energia a pequefas areas geograficas. [2]
1.2 Caracteristicas y Aplicaciones

Las micro-redes poseen caracteristicas que las diferencian de las redes

eléctricas convencionales. Por ejemplo:
¢ Utilizan fuentes de energia renovables

e Trabajan a menor tension comparado con las redes de energia

tradicionales.
e Pueden trabajar de dos formas:

- Conectado a la red: La micro-red puede consumir o entregar energia a la
red principal de energia.

- Aislado: La micro-red trabaja de forma independiente, necesita de un
sistema de respaldo como baterias o un grupo electrégeno. Este es el modo

mas comun en las zonas rurales donde la red eléctrica no llega. [1]
Las micro-redes constan de 6 componentes o etapas:

e Generacion: En esta etapa se genera la energia eléctrica a través de los

distintos equipos como paneles solares, turbinas edlicas, etc.

e Regulacion: Se encarga de regular los valores variables provenientes de

los generadores hacia un valor fijo o variable constante.

¢ Almacenamiento: Consta de sistemas capaces de almacenar la energia
eléctrica proveniente de los generadores. Pueden ser baterias,

condensadores de ultra capacidad, etc.

e Cargas: Compuesta por distintos tipos como motores, alumbrado, etc.



e Interruptores: Son los puntos de interconexion entre los demas
componentes. Por ejemplo: generacion y almacenamiento, control y carga,

etc.

e Control: Esta etapa se encarga de controlar los niveles de energia
generados, almacenados y suministrados para evitar dafios en la micro-
red. [3]

1.3 Fuentes de Generacion de Energia Renovable

Son aquellas que hacen uso de recursos de energia renovable (recursos que
no se agotan, o se regeneran de forma natural en un corto tiempo) para
generar energia eléctrica. Entre los principales recursos de energia se puede
encontrar [4]:

e Solar: Se aprovecha mediante el uso de paneles fotovoltaicos, también
llamados paneles solares; son superficies, usualmente planas, que
contienen un conjunto de celdas solares. Estas celdas trabajan bajo el
proceso fotovoltaico que significa convertir energia solar (rayos solares,
fotones) en energia eléctrica (niveles de tension). Los paneles fotovoltaicos
han ido evolucionando en las Ultimas décadas; a lo largo de este tiempo se
pueden distinguir tres generaciones de celdas solares, las cuales
representan un avance en la relacién costo-efectividad. [5]. Actualmente,
en muchas partes del mundo es comun el empleo de paneles solares de
forma casera (especialmente en Europa) puesto que su uso es eficiente y
no muy complicado, sin embargo también se las puede encontrar en largos
campos abiertos. Cuando se tiene grandes areas cubiertas por estos

paneles, se les conoce como granjas solares.

e Edlica: Para su obtencibn se hace uso de turbinas edlicas. Estos
dispositivos funcionan transformando la energia generada por la fuerza que
aplica el viento sobre sus aspas en energia eléctrica. Suelen estar
montadas en altos niveles para aprovechar su rendimiento. Es comun que
se les encuentre de forma aislada en aplicaciones distintas como el bombeo
de agua o comunicaciones. Esto se debe a que el giro de las aspas hace

girar un motor, que puede generar energia eléctrica 0 mecanica
3



dependiendo de la necesidad del usuario. En aplicaciones de energia se

les puede encontrar en conjunto con paneles solares. [6]
1.4 Declaracion de la Problematica

En aplicaciones de fuentes de energia renovables, la adquisicion de datos y
el sistema de monitoreo son esenciales para recolectar informacion acerca del

rendimiento del sistema instalado y para varios propésitos de evaluacion [7].

El comportamiento de estos sistemas es complejo y variable debido a factores

gue no se pueden controlar, como los cambios de factores climéaticos [8].

Los datos requeridos para el monitoreo de este tipo de sistemas son: tension,
corriente y potencia de los generadores; tension, corriente y potencia de la

red; irradiacién solar, velocidad y direccion del viento, y temperatura ambiente
[71.

La tendencia a nivel mundial, correspondiente a la industria, es emplear los
estandares propuestos por la IEC que son mas generales y pueden ser
ampliamente distribuidos. Esto se ve justificado gracias a que el costo de este
sistema, a pesar de ser elevado, genera en la micro-red un mejor
entendimiento y aprovechamiento que se traduce en mayores ingresos. Sin
embargo, a nivel de estudios o proyectos de investigacion, se busca realizar
sistemas de monitoreo dimensionados especificamente para cumplir los

objetivos planteados.

Mas adelante se procedera a detallar algunos casos de sistemas de monitoreo
orientados a micro-redes para evaluar la situacién actual en la que se
encuentran. Del mismo modo se buscara encontrar los elementos comunes
entre estos sistemas a fin de poder contar con una idea general de su

composicién y funcionamiento.
1.5 Andlisis de la Problemética

El tema de tesis propuesto esta orientado a una micro-red eléctrica con
caracteristicas de potencia y fuentes de generacion particular, pero busca

poder ser aplicable en distintos escenarios.



La micro-red en cuestion es aislada y esta conformada por paneles solares y
turbinas edlicas y cuenta, ademas con un datalogger que, junto con los
sensores, realizan la funcién de monitoreo. Siendo el datalogger el dispositivo

encargado de almacenar los datos registrados.

Este sistema implementado constituyd un gran costo para la compafiia, sin
embargo, este equipo es capaz de medir valores meteoroldgicos Unicamente.
Esto ocasiona que no se tenga un registro de los parametros eléctricos
presentes en la micro-red y por consiguiente no se pueda hacer una

evaluacion de eficiencia energética.

Es en base a esta necesidad que se buscara disefiar e implementar un
sistema de monitoreo que sea capaz de medir no solo parametros
atmosféricos, sino eléctricos también para que puedan ser almacenados y

analizados.



CAPITULO 2: SISTEMAS DE MONITOREO DE DESEMPENO
2.1 Estado del Arte
2.1.1. Estado de la investigacion

En la actualidad, existen diversos sistemas de monitoreo de desempefio
enfocados a sistemas de generacion de energias renovables. Muchos de
estos se integran con sistemas de supervision y control; sin embargo, estos

suelen ser mas complejos que los requeridos, por lo que su precio se eleva.

Como se puede observar en la referencia [9], un sistema de monitoreo de
desempefio (SMD), por mas basico que sea, debe poder gestionar un gran
namero de datos de forma automatica. Para lograr acceder y elaborar célculos

en grupos relevantes de datos, se debe contar con tres etapas principales:

* Adquisicibn de datos: Conformado por sensores y transductores, se

encarga de recopilar datos del sistema y/o entorno.

+ Almacenamiento: Encargado del almacenamiento de los datos adquiridos.

Puede ser un dispositivo externo dedicado o interno al sistema.

* Procesamiento de datos: Consiste en procesar los datos obtenidos para

brindar una informacién que sea entendible por el usuario.

Dependiendo de los requerimientos y necesidades del sistema, asi como su

entorno, el sistema de monitoreo puede ser alambrico o inaldmbrico.

Por ejemplo, en el sistema de mediciones implementado en la Universidad
Distrital Francisco José de Caldas ubicada en Bogota, Colombia; referencia
[8], se hace uso de una Red Inalambrica de Sensores (WSN por sus siglas en

inglés).

Una WSN estd conformada de 2 tipos de nodos, nodo sensor y nodo
sumidero. Esta se conecta luego a un servidor que sirve de puerta entre la
WSN y un administrador de tareas que se encarga del procesamiento de los

datos, tal como es ilustrado por la figura 1.
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Figura 1. Clasico despliegue de una WSN [8]

Tal y como detalla la referencia [8], el tipo de tecnologia de comunicacién a
implementarse depende basicamente del arreglo geografico donde un nodo
de sensor ha sido posicionado y que depende del despliegue geografico de la
micro-red. De esta forma se puede hacer uso de wi-fi, ondas microondas, fibra
Optica, entre otros.

Para la adquisicion de datos se empled un sistema AMI (Infraestructura
Avanzada de Medicién en inglés) que es capaz de adquirir informacion en
tiempo real o a ciertos intervalos. El sistema AMI tiene como caracteristicas
mas importantes: fecha y tiempo exacto de medicién, habilidad para auto-
detectar, configurar y reparar problemas de configuracion, habilidad de lectura

remota, precision de datos adquiridos de la red.

Un esquema general de este sistema es presentado en la figura 2, donde los
sensores adquieren los datos deseados que luego son transformados de
sefales analdgicas a digitales por los ADC. Para después ser procesados y

almacenados en un médulo de datos.
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Figura 2. Esquema general de un colector 0 nodo sensor para un sistema AMI [8]

De permitirlo el despliegue del sistema, los nodos de sensado pueden ser

conectados de forma alambrica y disminuir costos.

Si bien es cierto que el tema de micro-redes es relativamente nuevo, ya
existen ciertos estandares como la IEC 61850 o la IEEE 1547 que buscan

regularizar su disefio, operacion y control.

En la referencia [10] se detalla los resultados de una encuesta realizada sobre
los distintos sistemas de monitoreo actuales correspondientes a Paneles
Fotovoltaicos. Asi mismo, estos sistemas pueden ser aplicados para la

medicion de eficiencia de las turbinas edlicas.
A continuacion se presenta los métodos evaluados:

a) El primer método sigue las instrucciones de la Comision Electrotécnica
Comercial (IEC por sus siglas en inglés). Este método es el mas usado por
estudios enfocados en la evaluacion inicial del sistema. El método es mas
costoso debido a que requiere equipos apropiados de sensado y
adquisicion de datos. Para el escenario de paneles fotovoltaicos se cuenta

8



con la norma IEC 61724, mientras que para las turbinas edlicas se tiene la
norma IEC 61400-12-1 [10].

b) Un segundo método consiste en utilizar los dispositivos de regulacion ya
empleados en el sistema. Este método permite un ahorro de componentes,
presupuesto, asi como de espacio. El inconveniente radica en la
manipulacion del dispositivo para realizar las modificaciones pertinentes.
En el caso de paneles solares se puede hacer uso del regulador Seguidor
Punto de Maxima Potencia (MPPT por sus siglas en inglés) o Modulacion
por Ancho de Pulsos (PWM); mientras que en las turbinas edlicas, el

inversor.

c) Otro método conlleva la especializacién en el caso de estudio. Esto quiere
decir que, dependiendo de la situacion exacta de estudio o proyecto, se
implementa un forma novedosa de monitoreo. Por ejemplo, la Union
Europea, en su proyecto PVSAT-2, adoptdé un método que hace uso de un
satélite y un sistema de bajo costo de interfaz de usuario para monitorear
un sistema fotovoltaico [10].

d) Dependiendo de donde se realicen las mediciones, los datos varian y con
ellos la aplicacion de estudio. Por ejemplo, en [11] se realizan las
mediciones en cada celda del panel PV. Esto debido a que se buscaba
medir de forma indirecta la eficiencia de estos paneles. En el caso de una
micro-red, los puntos de medicion suelen ser en las distintas etapas,
tratando de no profundizar en cada elemento.

2.1.2. Sintesis sobre el asunto de estudio

Los sistemas de monitoreo de desempefio son indispensables para tener los
datos en tiempo real de las micro-redes o redes de generacion; Ya sea que
se tenga como fin la evaluacién del desempefio del sistema, el control o
supervision del mismo. Para que se pueda disefiar e implementar estos
sistemas de monitoreo se debe tener en consideracion, no solo los factores

gue intervienen, sino también el motivo y finalidad que se le dara.



2.2 Dispositivos para Adquisicion de Datos

Son aquellos dispositivos encargados de sensar parametros y sefales para
gue puedan ser procesadas; ya que en su estado inicial no son reconocidas

por el procesador, o pueden dafiar el sistema.

En el presente sistema se requiere hacer la medicion de las siguientes

variables:

a) Tension Alterna: Es la mas comun en redes de potencia ya que es la usada
por los dispositivos de consumo eléctrico. Su valor suele ser elevado para
los ADC, por esto se acondiciona la sefial. Algunos de los métodos de

acondicionamiento son los siguientes:

e Divisor resistivo: Consiste en utilizar un arreglo de resistencias que divide
el valor de tension entre algun factor de relacion. EI mayor problema de

este método es la pérdida de energia.

e Transformador de tension: Transforma el valor de tensién mediante un
factor de transformacion. Tiene como ventaja que la pérdida de energia
depende de la calidad del transformador, mas suele ser minima. Solo

pueden ser empleados en tension alterna.

b) Tensiébn Continua: Componentes como los paneles fotovoltaicos o las
baterias entregan tension continua. Su valor también suele ser elevado, por

eso se emplea el siguiente método de acondicionamiento:

e Divisor resistivo: Arreglo de resistencias que divide el nivel de tension.

Presenta pérdidas de potencia.

c) Corriente Alterna: Debido a que los ADC funcionan con valores de tension,
se debe buscar una relacion entre la corriente que se desea medir y la

tensiéon obtenida. Para esto existen los siguientes tipos de transductores:

¢ Resistencia shunt: Es una resistencia muy pequefia que se coloca en serie
con la linea de energia. La tension generada en los extremos de esta

resistencia es proporcional a su corriente y es de un valor pequeiio.
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e Transformadores de corriente: Aprovecha el campo magnético alrededor
de la linea para generar un valor de tension proporcional a dicha corriente.
Estos transformadores pueden ser de distintas formas dependiendo del

disefio de su nucleo.

v Nlcleo entero: El nlcleo es de una sola pieza. Necesita interrumpir la

conexion de la red para que el cable pase por su centro.

U

N

Figura 3. Transformador de corriente de nucleo entero [12]
v Nucleo partido: Cuenta con una apertura por la cual puede ingresar el cable

de corriente. No necesita interrumpir la conexion de la red.

Figura 4. Transformador de corriente de nucleo partido [13]
d) Corriente Continua: A diferencia de la corriente AC, un transformador
comun no podria detectar la corriente DC puesto que no varia
constantemente. Para poder medir su corriente se usan los sensores de

efecto Hall:

e Circuito integrado: Detecta el campo electromagnético inducido por la

corriente y lo transforma en un valor de tension para que pueda ser medido.

e Transformador de corriente toroidal: Este transformador incorpora un
sensor de efecto Hall en el nlcleo, que le permite sensar la corriente DC

gue pasa por su interior.
11



e) Velocidad de viento: Es proporcional a la energia generada por los

f)

aerogeneradores. Por lo tanto su medicion es importante para evaluar el
desemperio de las turbinas. Esta se realiza mediante un aparato llamado
anemometro, el cual transforma la energia del viento en una sefial eléctrica

cuya frecuencia es proporcional a la velocidad del viento

Direccion de viento: Las corrientes de aire tienen su estudio propio, el cual
es usado para provecho de las instalaciones. Por ende es vital evaluar que
vientos son los que transitan por la micro-red. La direccibn se evalla
mediante una veleta que transforma la direccion del viento en un nivel de

tensién proporcional a la misma.

g) Intensidad luminosa: Los paneles fotovoltaicos funcionan transformando la

energia luminosa en eléctrica. Siendo la intensidad luminosa proporcional
ala energia generada. Su medicion se realiza mediante un piranoémetro que

la convierte en una sefial de corriente eléctrica proporcional.

2.3 Dispositivos para Procesamiento de Datos

Para el procesamiento de datos se necesitan componentes capaces de

realizar distintas operaciones con los valores obtenidos de los sensores.

Debido a que las operaciones posibles a realizar son muchas, los dispositivos

existentes también lo son y varian de acuerdo a las necesidades.

Hay componentes que son capaces de realizar operaciones ldgicas basicas

como AND u OR, otras que pueden hacer operaciones de suma y resta, hasta

componentes capaces de realizar multiples operaciones en simultaneo como

los CPU’s de las computadoras. Debido a la complejidad del proyecto, se

pueden encontrar 2 tipos de dispositivos factibles de ser empleados:

Microprocesadores: Su desarrollo esta orientado al mercado de los
ordenadores personales y estaciones de trabajo. Soporta una elevada
potencia de calculo, manejo de gran cantidad de memoria y gran velocidad

de procesamiento. Son mas caros que los microcontroladores.

Microcontroladores: Son usados en aplicaciones donde se deben realizar

un pequefio niumero de tareas al menor costo. Ejecutan un programa
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almacenado permanentemente en su memoria, el cual trabaja con algunos
datos almacenados temporalmente e interactda con el exterior a través de

las lineas de entrada y salida de que dispone.
2.4 Dispositivos para Almacenamiento de Datos

La variedad de dispositivos de almacenamiento es muy amplia hoy en dia.
Estos han ido evolucionando a través de la historia, pasando desde los
disquetes, discos duros, CD-ROM, hasta las unidades flash como los USB’s y
las tarjetas SD’s. Para nuestro proyecto se necesitan dispositivos pequefios y
livianos que no aumenten la complejidad del dispositivo pero que ofrezcan

garantia a los datos obtenidos.
2.5 Modelo Tedrico

El sistema de monitoreo de desempefio es necesario e indispensable para un
sistema de energia, en especial para una micro-red. Debido a que esta no es
de gran escala como una planta de generaciéon industrial, los sistemas de
monitoreo comerciales resultan muy costosos para su implementacion. Es en
este contexto que surge la necesidad de disefar un sistema que sea confiable
y de bajo costo.

Para poder escoger el tipo y caracteristicas del sistema de monitoreo se debe
tener en consideracion las caracteristicas de la micro-red. En nuestro caso,
se cuenta con una micro-red basada en energia generada por paneles
fotovoltaicos y turbinas edlicas. El sistema de generacidbn se encuentra
instalado sobre el techo de un local comunal y el sistema de regulacion se

encuentra dentro del mismo.

Las etapas de generacion y regulacion se encuentran contiguas fisicamente,
esto implica que los puntos de sensado también se ubicaran de forma
cercana. Al contar con una micro-red de estas caracteristicas, se optara por
un sistema de monitoreo alambrico, que no solo ahorrara la necesidad de
adquirir moédulos de comunicacion inalambrica, sino que le otorgara

simplicidad al sistema.
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La zona en la que esta ubicada la micro-red es Laguna Grande, Paracas. Las
coordenadas de la zona son 14°8'50.16”S 76°16°06.46°0. En esta zona vive
una comunidad pesquera que no cuenta con sefial telefénica y por
consiguiente con conexion a internet. De la misma forma, al no contarse con
un personal dedicado a la evaluacion constante del desempefio de la micro-
red, la Gnica opcidn que se tendria para poder hacer un monitoreo en tiempo
real es que haya una comunicacion inalambrica entre esta zona y Lima (donde
se encuentra la empresa encargada de la instalacion y monitorizacion de la
micro-red). Dado que no se cuenta con conexion telefonica y los dispositivos
punto a punto no tienen tanto alcance, se optara por un monitoreo por
periodos. El periodo propuesto es de 1 mes, periodo en el cual es factible
realizar una evaluaciéon del comportamiento de la micro-red, después del cual

Se acercara una persona encargada a recoger los datos obtenidos.

En la figura 5 se muestra la ubicacion exacta donde se encuentra instalada la

micro-red.

Figura 5. Ubicacion de la micro-red
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Figura 7. Ubicacion de la micro-red en Laguna Grande



Para el almacenamiento se cuenta con distintas opciones, todas muy similares
en precio y capacidad. Sin embargo, se optara por una tarjeta SD ya que es

la mas comercial en sistemas de monitoreo.

Como se menciono anteriormente, el tipo de monitoreo que sigue las normas
IEC 61724 e IEC 61400-12-1 es el mas preciso para evaluar desempefio. Sin
embargo implica un costo mayor por los dispositivos de sensado de
condiciones climaticas. En nuestro caso, la micro-red instalada cuenta con
ciertos sensores como un anemémetro, veleta y un piranometro que recaudan
datos y los almacenan en un datalogger de modelo NRG SYMPHONIEPLUS
3. El presente proyecto no solo busca determinar la eficiencia de la micro-red
de forma comercial, sino también mejorarla a través de un estudio posterior.
Por dicha razon, el sistema a desarrollar debe ajustarse a las necesidades

especificas de la micro-red.

El sistema de monitoreo deberd ser capaz de sensar todas las variables
necesarias para poder realizar un estudio, y posterior mejora, de la eficiencia
de la micro-red. Los datos adquiridos, en su mayoria analégicos, seran
digitalizados y procesados por la unidad de procesamiento. Esta unidad se
encargara a su vez de realizar las distintas evaluaciones para obtener valores
derivados de los sensados; por ejemplo, la potencia eléctrica del sistema en
los distintos puntos de medicion. Luego de ser procesados, estos datos seran
almacenados en la tarjeta SD determinada en un formato que identifique los
valores con sus respectivas fechas y horas. Por ultimo, haciendo uso de un
software, ya sea personalizado o general, la persona encargada debera ser

capaz de visualizar los valores medidos con sus distintas fechas.

En la figura 8 se presenta un diagrama tentativo del sistema de monitoreo de

desemperio que sera disefiado e implementado.
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Figura 8. Diagrama tentativo del sistema de monitoreo propuesto

basado en el proyecto de Retno Tri Wahyuni y Yusmar Palapa Wijaya [14]
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CAPITULO 3: DISENO DE UN SISTEMA DE MONITOREO DE
DESEMPENO DE BAJO COSTO PARA UN MICRO-RED

3.1 Objetivos
3.1.1 Objetivo General

Disefiar un sistema de monitoreo que adquiera y registre los parametros
eléctricos y atmosféricos de una micro-red en Laguna Grande, que presente

un error de medicion no mayor al 2% y que sea de bajo costo.
3.1.2 Objetivos Especificos

a) Disefar los dispositivos de acoplo de los sensores hacia el dispositivo
principal.

b) Desarrollar el dispositivo central que convierta las sefales de los sensores,
los procese y los almacene.

c) Evaluar la precision y error de las mediciones.
3.2 Andlisis del sistema

La micro-red en nuestro estudio se encuentra en Laguna Grande y fue
instalada por Waira Energia Sac. La misma que cuenta con 2 turbinas edlicas,
un arreglo de paneles fotovoltaicos de 6000W, un banco de baterias, asi como
controladores, inversores y reguladores tal como se muestra en la figura 9. En
este se puede identificar las conexiones de los componentes (lineas blancas)
ademas de los puntos donde se planean medir los parametros eléctricos
(puntos verdes).
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Figura 9. Esquema de micro-red hibrida en Laguna grande

Esta micro-red cuenta con un sistema de monitoreo para factores anicamente
meteoroldgicos. Este sistema esta conformado por un datalogger Symphonie
PLUS3 de NRG Systems, un anemémetro NRG 40C, una veleta NRG 200P y

un piranémetro li-cor 200 [Anexos A, By C].

Como se menciono al, los sistemas de monitoreo de desempefio cuentan con

3 etapas principales. Estas son:

e Adquisicién de Datos

e Procesamiento de Datos

¢ Almacenamiento y Analisis de Datos
3.2.1 Adquisicion de Datos

En esta etapa se recolectaran los datos (meteorolégicos y eléctricos)
mediante el uso de sensores y transductores. Para esto se debe considerar
los rangos de valores que se tienen para la medicién asi como el tipo de

funcionamiento de cada uno.

¢ Velocidad de viento: Para su medicion se utilizar4 el anemémetro NRG
40C, cuyas caracteristicas obtenidas de su hoja técnica son mostradas en
la tabla 1.
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Tabla 1. Caracteristicas del anemometro

Modelo NRG 40C
Rango de sensor 1a96 m/s
Sefial de salida (proporcional) 0al25Hz
Error maximo 1%

En la figura 10 se puede observar el anemometro NRG 40C que cuenta con

tres aspas y dos terminales.

Figura 10. Anemémetro NRG 40C [15]

e Direccion de viento: Para su determinacion se empleara la veleta NRG

200P que cuenta con las caracteristicas sefialadas en la tabla 2 obtenidas

de su hoja de datos. Esta funciona con un voltaje de excitacion (5V en

nuestro caso) y ofrece un voltaje de salida proporcional al grado de

rotacion.

Tabla 2. Caracteristicas de la veleta

Modelo

NRG 200P

Rango de sensor

360° de rotacidon continua

Sefial de salida (proporcional)

0 a Voltaje de excitacion

Error maximo

+0.45 m/s a 10 m/s
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La figura 11 muestra la veleta de modelo NRG 200P, la cual es usada por la

empresa Waira Energia.

Figura 11. Veleta NRG 200P [16]

¢ Intensidad luminosa: Se empleard el piranometro li-cor 200R que entrega

una sefal de corriente. Este necesita de un Moédulo Acondicionador de

Sefal para ser reconocido por el Symphonie, pero si se quisiese leer con

el Arduino se necesitaria de una resistencia. La resistencia de 22Kohm que

da valores de tensién entre 0 y 4.95V fue obtenida de la ecuacion 1. En la

tabla 3 se muestran las especificaciones del piranémetro li-cor 200R

obtenidas de su hoja técnica.

R = (Vmax — Vmin) / (Imax — Imin) .....(1)

Tabla 3. Caracteristicas del piranémetro

Modelo

Li-cor 200R

Rango de sensor

0 a 3000 W/m2

Sefal de salida (proporcional)

0 a 225uA

Error maximo

1%

El piranédmetro li-cor 200 se puede observar en la figura 12.
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Figura 12. Piranémetro li-cor 200R [17]

e Corriente alterna: Para la medicion de corriente alterna se opt6 por un
sensor de nucleo partido. Este permitira maniobrar el sensor sin necesidad
de interrumpir la conexion. Tomando en consideracion que la corriente
maxima en la red es de 70A, se procedié a comparar distintos sensores
optando por el del fabricante CR Magnetics Inc, cuyo modelo posee las
caracteristicas detalladas en la tabla 4, la resistencia externa R fue

calculada con la ecuacion 2 brindada por el fabricante.

R = (Vmax * 3750) / Imax .....(2)

Tabla 4. Caracteristicas del sensor de corriente AC

Modelo CR3111-3000

Rango de sensor 0 a 100A

Senal de salida (proporcional) 0 a 1.492V (R=470hm)

En la figura 13 se observa el sensor de corriente AC escogido.

Figura 13. Sensor de corriente AC de nucleo partido CR3111-3000 [18]
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e Corriente continua: En el caso de la corriente continua, se opto por usar un
sensor de efecto hall de nucleo entero, ya que no interrumpe la conexion
eléctricay su precio es menor al de nucleo partido. En la red que poseemos,
la corriente continua maxima que se tiene es de 50A. Por ello se eligio el
siguiente sensor fabricado por Tamura Corporation que posee las

caracteristicas sefaladas en la tabla 5 obtenidas de la hoja de datos del

sensor.
Tabla 5. Caracteristicas del sensor de corriente DC
Modelo L01Z100S05
Rango de sensor -100 a 100A
Sefal de salida (proporcional) 0ab5Vv
Error maximo 1%

La figura 14 muestra el sensor de corriente DC escogido

Figura 14. Sensor de corriente DC de nudcleo entero L01Z100S05 [19]

e Tensidn alterna: Para adquirir los valores de tension alterna, se empleara
un transformador de medida que tiene una relacién de transformacién de
220:12. El uso del transformador es necesario para separar la tierra del
sistema de monitoreo del neutro de la micro-red. A su vez, se empleara un
divisor resistivo que reducira la tension proveniente del transformador a su
décima parte. Debido al consumo del divisor, las resistencias pueden ser
de un cuarto de vatio. Las caracteristicas del divisor mixto se detallan en la

tabla 6.
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Tabla 6. Caracteristicas del sensor de tensién AC

Modelo Transformador + divisor resistivo
Rango de sensor 0 a 260V
Sefial de salida (proporcional) 0al.418Vv
Consumo maximo 15mwW

En la figura 15 se muestra el transformador a utilizar y el esquematico del

divisor resistivo.

oy
addm
2)

AL

Figura 15. Transformador y divisor resistivo

e Tensidn continua: Para la medicidon de la tensién continua, se usara un

divisor resistivo que asegure la linealidad. Las caracteristicas de este

arreglo se detallan en la tabla 7. Este divisor ser4 seguido de un OPAMP

en configuracion seguidor para evitar la aparicién de corrientes de fuga. El

OPAMP debia ser de proposito general y poder ser alimentado con 5V, por

lo que se escogid el LM324N que satisface las necesidades.

24



Tabla 7. Caracteristicas del sensor de tensiéon DC

Modelo Divisor resistivo
Rango de sensor 0 a 120V
Sefial de salida (proporcional) 0absVv
Consumo maximo 60mw

El esquematico del divisor resistivo y OPAMP en configuracion seguidor
se observan en la figura 16.

o —

z

O ¢ C

Figura 16. Divisor resistivo y OPAMP seguidor

e Potencia eléctrica: La potencia eléctrica se calculara de forma digital en
base a los valores de corriente y tension obtenidos.

Las sefiales provenientes de los sensores de corriente y tension AC son
valores mas pequeiios de tension AC. Los valores que suelen ser
transformados y procesados por los distintos equipos de procesamiento
requieren sefiales DC, por lo que estas sefiales deben pasar por una etapa
previa de acondicionamiento, la cual tendrd como salida valores entre 0 y
3.5Vdc.

Para la etapa de acondicionamiento, se evaluaron tres opciones:
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¢ Rectificador de onda completa mediante puente de diodos: Es el sistema
mas simple pero a su vez menos preciso. Presenta caidas de tension
debido a los diodos empleados, lo que no lo hace ideal para aplicaciones

de medicion.

¢ Rectificador de onda completa mediante OPAMP: Logra convertir la seial
AC en DC evitando las caidas de tension en los diodos. Provee de
linealidad al sistema pero se ve limitado por las caracteristicas del OPAMP,

condensadores y resistencias.

¢ Circuito integrado convertidor de RMS a DC: Es el mas preciso de las tres
opciones, pero a su vez el mas costoso. Convierte el verdadero valor RMS
a DC y brinda gran precision, pero su precio es diez veces el precio de las

otras opciones.

Finalmente se optd por la rectificacion de onda mediante OPAMP’s, ya que
evita las caidas de tension del puente de diodo y no incrementa
significativamente el costo del sistema. En la figura 17 se observa el

esquematico del circuito rectificador.

LM324 LM324
bt 1

AW
. R2

b 4

Figura 17. Circuito rectificador de precisién para acondicionamiento de corriente [20]

Para este disefio, se optd por seleccionar R2=R3=10kOhm con el fin de
conservar la simetria de la onda rectificada. Luego se busca amplificar la sefial
obtenida 2 veces. Por lo tanto, segun la ecuacién 3, seleccionamos
R4=R5=10kOhm. Todos los OPAMP’s seran LM324N puesto que deben ser
de proposito general que puedan ser alimentados con 5V y de bajo consumo
(700uA).

G=(R4/R5)+1 ....(3)
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3.2.2 Procesamiento de Datos

Durante esta etapa se realiza la digitalizacion de los datos adquiridos para que

puedan ser procesados y posteriormente almacenados y analizados.

En la micro-red en cuestion se cuenta con el datalogger Symphonie PLUS3
que realiza esta accion de forma eficaz y que muestra los parametros en
tiempo real, asi como informacion referente al estado de las baterias, entre

otras opciones.

En la figura 18 se muestra los parametros correspondientes a las veletas
conectadas a los canales 7 y 8 del datalogger. Por otro lado, en la figura 19
se observa el estado de las baterias, fecha y hora del sistema.

Figura 19. Informacion del datalogger mostrada en el mismo
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Ademas, el datalogger cuenta con un software que muestra y organiza los
datos obtenidos durante un periodo de tiempo, tal como se muestra en la
figura 20, el software provee los datos por periodos de tiempo y permite

observar su variacion.

Interpreted Data - C:'NRGRawData',012520021230136.R _ |EI |£|
Bile  Wiew
10.8 10.8
945 ', 9.45
g.1 8.1
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O 54 L1 54
£ 405 A A 4.03
27 \ A ‘ 'l ﬂL ﬁ‘ 27
135 '\%_ IRV .M IVJ hYA 135
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Averages 1203002002 1203002002 12/30/2002| 123002002 12/30/2002) 123002002 12/30/2002
00:00:00 00:10:00 00:20:00 00:30:00 00:40:00 00:50:00 01:00:00
MNEG #40 Anemometer
MNRG #40 Anemometer 4.8 34 40 EX 25 1.0 13
MNRG #40 Anermometsr 4.1 30 32 31 1.8 0.s 0.s
MNRG #40 Anermometsr 2.1 1.7 1.8 1.7 1.1 05 0B
MRG #40 Anemometar 4.1 3.0 3.z 31 1.8 n.a n.a
Mowvalynx Rainguage 0.oa 0.oa 0.0 0.oo 0.0 0.00 0.00
#200F Wind vane 16 4 33 41 53 48 166
#200F Wind vane 16 4 33 41 53 48 166
#1103 Temp Sens (F) 2.7 216 208 206 201 195 18.6
BF-20 Barometar 30.4 30.4 30.4 30.4 304 304 30.4
FH-5 FBelative Humid. 723 4.0 751 763 778 791 g1.0
Licor Pyranometer 0.0 0.0 0.0 0.0 0.0 0.0 0.0

»

Figura 20. Gréfica de valores histéricos mediante Symphonie Data Retriever [21]

En primera instancia se propuso emplear el datalogger como medio de
procesamiento. Entre las razones para escoger usar el sistema existente esta
el disefio industrial con el que cuenta, el mismo que le permite una expansion
de actividades pero que no son usadas, por ejemplo la transmision de datos
mediante el estandar Sistema Global para las Comunicaciones Maoviles (GSM
por sus siglas en inglés). Por otro lado, también se consideré importante
contar con un software de analisis de datos. Por ultimo, hacer uso del producto

ya existente significa un ahorro en el tiempo y presupuesto del proyecto.

Sin embargo, como se menciond anteriormente, el Symphonie esta pre-
configurado para medir valores meteorolégicos Unicamente. Es por esta razén
que los parametros eléctricos deberan ser acondicionados para que el

datalogger los interprete como valores meteoroldgicos. Esto deberia ser
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posible debido a que el datalogger cuenta con seis canales digitales, seis
analdgicos y tres que pueden funcionar como digital o analdgico dependiendo

de cdmo se configure.

El funcionamiento de los canales analdgicos es similar al de un convertidor
ADC, el cual recibe un nivel de tensién analdgico y lo transforma a digital para
poder ser procesado. El rango de tensiones admitidas lo limita su tension de
alimentacion (1.5V). Por lo tanto, el acondicionamiento de sefiales para este
canal se basaria en reductores de tension para lograr los niveles de tension

deseados.

Por otro lado, el funcionamiento de los canales digitales se basa en sefales
de frecuencia. Los canales digitales estan pre-configurados para sensar
anemometros digitales que funcionan generando sefiales cuyas frecuencias

son lineales a la velocidad de giro de sus aspas.

Para el acondicionamiento de una sefial eléctrica, se debe buscar una forma
de generar una sefal cuya frecuencia esté relacionada a un nivel de tencién
dado. Sin embargo este procedimiento es muy complejo, espacioso y caro.
En un principio se planteé la opcion de utilizar un microcontrolador que
generase estas sefiales PWM, pero las frecuencias que este podia generar

eran fijas y no lineales.

Se propone entonces usar un microcontrolador que proporcione la cantidad
de canales digitales y anal6gicos necesarios, asi como capacidad de
procesamiento y memoria requeridos a un precio modico. Se opté por el uso
del Arduino MEGA 2560 que procesara todas las sefiales de los sensores y
las almacenard en un dispositivo de almacenamiento sin hacer uso del

datalogger.

En la figura 21 se muestra el Arduino Mega 2596 que se usara como unidad

de procesamiento.
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Figura 21. Arduino Mega 2560 [22]

El Arduino Mega cuenta con 16 ADC que permitiran digitalizar las sefiales de

los parametros eléctricos, asi como de la veleta y el piranémetro. Por otro

lado, la frecuencia de la sefial a la salida del anemometro puede ser obtenida

mediante uno de los canales digitales del microcontrolador. Sus entradas

soportan sefiales de hasta 5V, por lo tanto, se usara el acondicionamiento

previamente desarrollado para las sefiales.

Las sefales de los sensores se conectaran segun lo indica la tabla:

Tabla 8. Canales de conexién de los sensores

Sensor Canal Sensor Canal
Voltaje Alterno 1 A0 Corriente Continua 4 A9
Corriente Alterna 1 Al Voltaje Continuo 5 A10
Voltaje Continuo 1 A2 Corriente Continua 5 All
Corriente Continual A3 Voltaje Continuo 6 Al12
Voltaje Continuo 2 A4 Corriente Continua 6 Al3
Corriente Continua 2 A5 Piranébmetro Al4
Voltaje Continuo 3 A6 Veleta Al5
Corriente Continua 3 A7 Anemdmetro D49
Voltaje Continuo 4 A8
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Como se observa en el cuadro, el sistema permitira conectar catorce sensores
de pardmetros eléctricos (pre-calibrados para una salida de entre 0 y 5V), un
piranometro (li-cor 200R), una veleta (NRG 200P) y un anemoémetros (NRG
40C). En el caso de las veletas, que necesitan una tension de excitacion,

seran alimentadas con 5V.

Debido a que el Arduino no cuenta con un sistema de alimentacion
permanente, la hora y fecha no son fijas en el mismo. Es por esta razén que
se usara el modulo RTC DS1307 que proporciona la fecha y hora en tiempo
real. Su alimentacion es mediante una pila de reloj de 3V que le otorga una
autonomia de entre 5y 10 afios. En la figura 22 se observa el médulo que se
conectara al Arduino mediante comunicacionl2C y haciendo uso de los pines

indicados en la tabla 9.

Figura 22. Médulo RTC DS1307 [23]
Tabla 9. Pines de conexion del médulo RTC DS1307

Pin RTC DS1307 Pin Arduino Mega 2560
SCL D21
SDA D20
VCC 5V
GND GND
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3.2.3 Almacenamiento y Analisis de Datos:

El almacenamiento de los datos se dara en una tarjeta micro SD. La cual se
colocara en el médulo SD-MICRO_PCB de Arduino, mostrado en la figura 23,

con el que se comunica de forma serial segun la tabla 10.

Figura 23. Médulo Arduino Micro SD [24]
Tabla 10. Pines de conexion del médulo SD-MICRO_PCB

Pin Modulo Micro SD Pin Arduino Mega 2560
CS D4
SCK D52
MOSI D51
MISO D50
VCC 5V
GND GND

Los datos seran almacenados en formato CSV (Valores Separados por Coma
por sus siglas en inglés) para que luego puedan ser vistos y evaluados usando
el software Microsoft Office Excel. En la figura 24 se muestra un ejemplo de
datos guardados en este formato y representados en Excel.
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Iriicio Insertar Disefio de pagina Farmulas Dataos Revisar Vista Programador Complementos

’Eé\ FEEEETTEL-TY IR DA DATALOG - Microsoft

P |- | Sraistortets 2
53 Capiar =
Pegar T =|| = combinary centrar - IEE - % 000/ %8 78 co:zzzz?alv E
7] 0

A A B B D E F G H | J
1 |Fecha(DD/MM/YYY) Hora Vacl lacl vdcl Idcl IntLum DirViento  VelViento

2 10/11/2017 19:49:56 225.35 60.43 109.31 0.09 183.65 355 47.04

2 10/11/2017 19:50:39 226.57 60.33 109.78 0.09 183.65 335 39.326

4 10/11/2017 15:50:54 222.29 60.33 109.5 0.05 183.65 224.52 359.37

5 10/11/2017 19:51:22 224.43 60.33 110.01 -0.24 20.74 181.84 21.77

6 10/11/2017 19:51:37 223.82 60.43 110.01 -0.24 20,74 179.06 8.01

7 10/11/2017 15:52:06 226.57 60.12 110.13 0.05 20.74 163.1 3.01

) 10/11/2017 19:52:21 1] 60.22 110.01 0.09 94.79 180.45 8.01

9 10/11/2017 19:52:36 222.85 60.33 110.04 43.75 94.79 180.8 8.01

10 10/11/2017 159:52:51 224.07 60.33 109.69 0.05 54.79 181.49 3.01

11 10/11/2017 19:53:06 227.43 60.43 110.04 0.09 26.66 233.89 19.56

12 10/11/2017 19:53:21 3.97 60.22 109.92 0.09 26.66 271.72 17.98

13 10/11/2017 19:53:36 o 1.05 109.8 0.09 26.66 323.77 18.07

14 10/11/2017 19:53:51 0.61 1] 109.92 0.09 1] 1] 18.07

15 10/11/2017 19:54:06 592.19 54.46 109.8 0.09 1] 1] 18.07

16 10/11/2017 19:54:21 168.21 54.88 109.69 0.09 o 60.38 30.81

17 10/11/2017 19:54:36 214.61 55.09 95.62 0.09 1] 77.04 28.32

18 10/11/2017 19:54:51 211.56 54.88 94.1 37.89 1] 137.07 28.32

19 10/11/2017 19:55:06 0.31 54.88 54.1 37.23 o 125.97 38.2

20 10/11/2017 19:55:21 0.31 1] 94.22 38.21 1] 90.57 36.8

21 10/11/2017 19:55:36 0.61 50.59 94.22 37.56 1] 274.14 37.99

22 10/11/2017 19:55:51 0.61 50.48 54.1 37.56 o 1] 37.98

23 10/11/2017 19:56:06 0.61 11.31 94.1 0.09 1] 333.83 45.69

Figura 24. Captura de pantalla de los datos guardados
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CAPITULO 4: IMPLEMENTACION Y PRUEBAS
4.1 Implementacion del Sistema

Para implementar el sistema general, se procedié primero por el disefio y
elaboracion de las 2 placas de circuito impreso necesarias [Anexo G]. La figura
25 muestra el panel de la Placa Central, mientras que la figura 26, el panel de

la Placa de Conexiones.

Figura 25. Panel de Placa Central
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Figura 26. Panel de Placa de Conexiones

La figura 27 muestra la Placa Central que contiene los circuitos de
procesamiento de las sefiales sensadas disefiados en el capitulo anterior, asi
como los distintos componentes necesarios. Esta placa interactia con el
Arduino Mega mediante un conector Berg de 20 pines. Asi mismo, se usara
otro conector Berg de 8 pines para brindar alimentaciéon de +5VDC y GND a
los distintos periféricos que lo requieran. Una bornera de 4 canales se usara
para conectar el transformador necesario en la medicion de tension AC y otra
bornera de 4 canales sensara para la alimentacién de esta placa. La placa
Central trabaja directamente sobre las sefiales de sensado, las cuales
provienen de la Placa de Conexiones mediante un conector DB-25 mostrado
en la figura 28.
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Figura 28. Conector DB-25 [25]

La figura 29 muestra la Placa de Conexiones, la cual se encargara de agrupar
todas las sefiales de sensado y permitira la interaccion de los sensores con

las borneras de conexion.
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Figura 29. Placa de Conexiones del Datalogger

Una vez completadas las placas de circuito impreso, se procedio a realizar el
chasis del dispositivo. El disefio del chasis [Anexo H] estuvo a cargo del
tesista, pero la fabricacion de estuvo a cargo de la Empresa Waira Energia.
El chasis esta fabricado en aluminio y no cuenta con ninguna protecciéon IP

puesto que es un prototipo inicial.

En la figura 30 se observa el chasis que cuenta con ranuras para los siguientes

periféricos:

e Pantalla: Permite al usuario observar en tiempo real las mediciones de los
distintos canales.

e Teclado: Posibilita la interaccion con el sistema, para escoger la medicion
a observar.

e Tarjeta micro SD: Permite el ingreso y retiro de la tarjeta micro SD.

e Puerto USB de Arduino Mega: Habilita la comunicacion con el ordenador
y asi la modificacion del cédigo fuente.

e Jack de alimentacion de +12VDC: Alimentacion de todo el sistema.

e Bateria de 12VDC: Sistema de respaldo de energia.

e Conector DB-25: Permite la comunicacion entre la Placa Central y la Placa
de Conexiones.
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Figura 30. Chasis del Datalogger

Posterior a la fabricacion del chasis, se procedioé a ensamblar todo el sistema.
Una caracteristica de este sistema es que no cuenta con una conexion a tierra
debido a que el conector de alimentacién es el mismo que el usado para el
Arduino Mega,; por ello se procur6 aislar cada componente del chasis y asi

evitar posibles interferencias.

4.2 Pruebas del Sistema

Teniendo listos todos los componentes del sistema, se observa el
funcionamiento del sistema, el cual sensa los parametros requeridos cada

segundo y almacenarlos en la tarjeta micro SD externa cada quince.

4.2.1 Adquisicion de Datos

Para el momento en que el sistema termind de ser ensamblado, la mayoria de

sensores se encontraban en funcionamiento en otras locaciones, por lo que
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la prueba propia en la micro-red fue realizada Unicamente con los sensores
de tension y corriente. Lo que se evalué en esta prueba fue el correcto
funcionamiento de los sensores empleados y la interfaz, puesto que

anteriormente se realizaron las pruebas con cada uno de los sensores.

La figura 31 muestra la fachada del local comunal donde se encuentra el
equipamiento de la micro-red en estudio. En la figura 32 se observa la
instalacion del datalogger en la micro-red. Mientras que en la figura 33 se

muestra la instalacion de los sensores.

; NI*AR!O DE ELECTRIFICAC[ON‘

. LAGUNA GRANDE 5.
AYUDA
0 GRACIAS A LA s
mﬂco‘?‘@gmmsmcmo DE DESARR!

N3BID

Mejorando vidas

JULIO - 2016

¢ z (]
ICRO RED ELECTRICA HIBRIDA DISENADA
INSTALADA POR
o

ENERGIA Y MOVILIDAD SOSTENIBLE

GANADORES DEL PREMIO BID-IDEAS 2015

Www.waira.com.pe

‘Q_ W Guillermo Dansey 1685, Lima . Tel 998 375152 @

Figura 31. Fachada de la Micro-red en Laguna Grande
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Figura 32. Instalacion del Datalogger

Figura 33. Instalacion del Sensores
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Para la adquisicién de datos, se realizaron experiencias con cada uno de los
sensores en la etapa previa al ensamblado.

El anemémetro se simulé con el empleo de sefiales cuadradas a distintas
frecuencias para representar distintas velocidades de viento. La figura 34

muestra la representacion de la experiencia.

fritzing)

Figura 34. Verificacion de sensado de frecuencia

En la figura 35 se observa a la veleta sensando valores de posicién angular,

para esto se gir0 la veleta en distintas posiciones para observar su variacion.
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fri’tz'ing'

Figura 35. Prueba de sensado con veleta

La figura 36 muestra el piranometro conectado al Arduino y midiendo la

intensidad luminosa presente.

Fri’tzjna'

Figura 36. Prueba de sensado con el pirandmetro
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El sensor de tension AC se conectd a una fuente de tension alterna variable
tal como se observa en la figura 37.

fﬁtzi’ng'

Figura 37. Experiencia de sensado de tension AC

Por otro lado, los valores de tensién DC fueron obtenidos de una fuente de

tencion DC variable segun se observa en la figura 38.

fritzing]

Figura 38. Experiencia de sensado de tension DC
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Para la medicién de corriente AC se utilizé una fuente de tensién AC variable

conectada a un resistor variable como se muestra en la figura 39.

Figura 39. Experiencia de sensado de corriente AC

La figura 40 muestra la experiencia realizada para sensar la corriente DC.
Para esta se empleo la fuente de tension variable DC conectada a una

resistencia variable.

fritzingl

Figura 40. Experiencia de sensado de corriente DC
44



4.2.2 Procesamiento de Datos

El procesamiento de los datos implica convertir las sefiales analdgicas en
digitales y se realiza de forma directa por los convertidores ADC del
microcontrolador. Asi mismo, parte del procesamiento de estos datos
involucra mostrarlos luego de aplicarles un factor de correlacion que es

definido por la funcién transferencia del circuito de acondicionamiento.

4.2.3 Almacenamiento de Datos

La experiencia realizada para comprobar el almacenamiento de datos
consiste en observar si el monitor serial muestra algin mensaje de error. De
no ser asi, se retirara la tarjeta micro SD y se insertara en el ordenador, luego
se abrird el archivo creado y se comprobara que los datos hayan sido
guardados con relacion al formato establecido. La figura 41 muestra el archivo
creado por el Arduino en la tarjeta micro SD.

- | [ = | Herramientas de unidad ~ WAIRA (G:) — O
Inicio Compartir Vista Administrar
- Bﬂsalecuonartodo

= . £

Anclar al Eliminar Nueva Propiedades o .
|Acceso rapido ) - carpeta - £ Historial D‘:‘In\remr seleccion

Mo seleccionar ninguno

Portapapeles Organizar Muevo Abrir Seleccionar
< “ T - » Esteequipo > WAIRA (G:) v O Buscar en WAIRA (G
~

- DATA (D:) 2 Mombre Fecha de modifica...  Tipo Tamario

= Unidad de CD (F =} DATALOG 01/01/2000 1:00 Archivo de valores.. 289 KB
. WAIRA (G)

= RICHARD (H)
= RICHARD (H:)
= WAIRA (G:)

¥ Red

Figura 41. Archivo creado en la tarjeta micro SD

4.3 Andlisis de Resultados

Para el analisis de resultados se procedié a adquirir una serie de valores
distribuidos a través de su rango para cada sensor con el fin de evaluar la
exactitud y linealidad del sistema. Asi mismo, para cada valor se tomaran

mediciones a fin de calcular la precision del instrumento.
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Las formulas utilizadas son las siguientes:

Precision = DesviacionEstandar (medidal, medida2, medida3) .....(4)

Exactitud = Error relativo ((medida promedio - referencia)/referencia) .....(5)

La tabla 11 muestra los datos y calculos de frecuencia realizados para el

anemometro, mientras que la figura 42 ilustra la linealidad de las mediciones

para el anemometro.

Tabla 11. Datos y calculos de frecuencia

DATOS CALCULOS
Valor Mediciones del Sistema Medicién de Osciloscopio Precision Error de
Referencial | medida1 medida 2 medida8 | promedio Tektronix medicidn (%)
8.00 8.01 8.01 8.01 8.01 8.00 0.00 0.12
18.00 18.07 18.07 18.07 " 18.07 18.05 " 0.00 0.11
28.00 28.32 28.32 28.32 " 28.32 28.25 " 0.00 0.25
38.00 37.98 37.98 37.98 " 37.98 37.88 " 0.00 0.26
48.00 48.05 48.05 48.05 " 48.05 48.08 " 0.00 -0.06
58.00 57.91 57.91 57.91 " 57.91 58.47 " 0.00 -0.96
68.00 68.31 68.31 68.31 " 68.31 68.50 " 0.00 -0.28
78.00 77.96 77.96 77.96 " 77.9 77.88 " 0.00 0.10
88.00 87.44 87.44 87.44 [ 87.44 87.41 " 0.00 0.03
98.00 96.73 96.73 96.73 " 96.73 96.71 " 0.00 0.02
108.00 106.44 106.44 106.44 [ 106.44 106.40 " 0.00 0.04
118.00 119.14 119.14 119.12 [ 119.13 119.10 " o001 0.03
125.00 126.47 126.49 12650 [ 126.49 126.60 " 0; -0.09
PROMEDIO 0.00 -0.03
140.00
120.00 /
100.00
20.00 4 FRECUENCIA
(ANEMOMETRO)
60.00 — Linealidad del sistema
40.00 y = 0.9998x- 0.0259
20.00
0.00 T T )
0.00 50.00 100.00 150.00

Figura 42. Linealidad del Arduino
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La tabla 12 muestra los datos y célculos realizados para la veleta, mientras

que la figura 43 ilustra la linealidad de las mediciones para la veleta.

Tabla 12. Datos y calculos de angulo de la veleta

DATOS CALCULOS
Valor Mediciones del Sistema o Error de
. - - - - Precision L,
Referencial | medidal medida2 medida8 | promedio medicion (%)
0.00 0.69 0.69 0.69 0.69 0.00 -
45.00 39.91 39.91 39.91 39.91 0.00 -11.31
90.00 90.61 90.61 90.61 [ 90.61 [ 0.00 0.68
135.00 136.38 136.38 136.38 [ 136.38 [ 0.00 1.02
180.00 181.14 181.14 181.14 [ 181.14 [ 0.00 0.63
225.00 233.89 233.89 233.89 [ 233.89 [ 0.00 3.95
270.00 272.41 272.41 272.41 [ 272.41 [ 0.00 0.89
315.00 324.46 324.46 32446 | 32446 [ 0.0 3.00
PROMEDIO 0.00 -0.16

350.00

300.00 //’

250.00 /

200.00 / % VELETA

150.00

// —— Linealidad del
100.00 sistema
50.00 / Y= 1.0327x-2.7092
000 / T T T 1
0.00 100.00 200.00 300.00 400.00
-50.00

Figura 43. Linealidad del sistema veleta - Arduino
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La tabla 13 muestra los datos y calculos realizados para el sensor de tension

DC, mientras que la figura 44 ilustra la linealidad de las mediciones para el

sensor de tension DC.

Tabla 13. Datos y calculos del sensor de tension DC

DATOS CALCULOS
Valor Mediciones del Sistema Medicion de Precisién Error de
Referencial] medidal medida2 medida3 | promedio Fluke 175 medicion (%)
15 14.77 14.77 14.77 14.77 15.36 0.00 -3.84
30 29.65 29.65 29.65 i 29.65 30.33 i 0.00 -2.24
40 39.61 39.61 39.61 " 39.61 40.30 i 0.00 -1.71
50 49.69 49.69 49.69 i 49.69 50.30 f 0.00 -1.21
65 64.45 64.45 64.45 | 64.45 6500 [ 0.00 -0.85
73 72.42 72.42 72.42 [ 72.42 73.00 i 0.00 -0.79
80 80.39 80.39 80.39 i 80.39 80.80 i 0.00 -0.51
87 87.07 87.07 87.07 " 87.07 87.40 f 0.00 -0.38
95 94.22 94.34 94.22 i 94.26 94.30 i 0.07 -0.04
100 100.46 100.46 100.46 i 100.46 100.60 0.00 -0.14
110 109.92 109.80 109.92 i 109.88 109.90 0.07 -0.02
PROMEDIO 0.01 -1.07
120.00
100.00
80.00
60.00 ¢ TENSIONDC
—— Linealidad del sistema
40.00
y=1.0072x-0.9079
20.00 ./
000 T T T T T
0.00 20.00 40.00 60.00 80.00 100.00120.00

Figura 44. Linealidad del sistema sensor de tensién DC - Arduino
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La tabla 14 muestra los datos y calculos realizados para el sensor de tension

AC, mientras que la figura 45 ilustra la linealidad de las mediciones para el

sensor de tension AC.

Tabla 14. Datos y calculos del sensor de tension AC

Figura 45. Linealidad del sistema sensor de tensién AC — Arduino

DATOS CALCULOS
Valor Mediciones del Sistema Medicion de Precision Error de
Referencial| medidal medida2 medida8 | promedio Fluke 175 medicion (%)
20 19.54 19.54 19.54 19.54 20.40 0.00 -4.22)
40 39.69 39.69 3977 [ 3972 40.15 [ 0.05 -1.08
60 59.53 59.53 5953 [ 59.53 6040 | o000 -1.44
80 81.20 80.90 80.90 [ 8100 8160 [ 017 -0.74
100 100.74 100.74 10044 [ 100.64 10000 [ o017 0.64
120 119.97 119.97 119.97 [ 119.97 12040 [ o000 -0.36
140 140.43 141.65 14165 [ 141.24 14050 [ o070 0.53
160 161.80 161.49 161.18 | 161.49 16100 [ o031 0.30
180 181.64 180.72 18133 [ 181.23 18070 [ o047 0.29
200 202.40 203.01 20270 [ 202.70 20200 [ o031 0.35
220 227.43 226.21 2464 [ 226.09 2360 [ 140 1.12)
PROMEDIO 0.33 -0.42
250.00
200.00
¢ TENSIONAC
150.00
—— Linealidad del
100.00 sistema
y=1.0125x-1.2971
50.00 /
0,00 T T T T
0.00 50.00 100.00 150.00 200.00 250.00
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La tabla 15 muestra los datos y calculos realizados para el sensor de corriente

DC, mientras que la figura 46 ilustra la linealidad de las mediciones para el

sensor de corriente DC.

Tabla 15. Datos y calculos del sensor de corriente DC

DATOS CALCULOS
Valor Mediciones del Sistema Medicién de L Error de
. Precision L,
Referencial| medidal medida2 medida3 | promedio Fluke 175 medicion (%)
6 6.60 6.60 6.60 6.60 6.68 0.00 -1.20
13 13.45 13.45 1345 [ 1345 129 [ o000 3.78
16 16.71 16.71 1671 [ 1671 1647 [ o000 1.44
20 19.96 19.96 1996 [ 19.96 1995 [ o000 0.04
23 23.22 23.22 232 [ 232 2322 [ o000 0.02
27 27.13 27.13 2713 [ 2713 2648 [ 000 2.45
30 30.39 30.39 3039 [ 3039 29 [ 000 1.63
33 33.65 33.65 3365 [ 3365 3328 [ 000 111
37 37.23 37.23 37203 [ 37.23 3664 | 000 1.61
40 40.49 40.49 4049 [ 40.49 3996 [ 000 1.33
a4 44.40 44.40 4440 [ 4440 4318 [ 0.0 2.83
48 48.64 48.64 4864 | 4864 4741 [ 0.0 2.60
PROMEDIO 0.00 1.47

60.00

50.00

40.00

¢ CORRIENTEDC
30.00
—— Linealidad del
20.00 sistema
=1.0269x-0.2738
10.00 o Y
0,00 T T T T
0.00 10.00 20.00 30.00 40.00 50.00

Figura 46. Linealidad del sistema sensor de corriente DC — Arduino

50



La tabla 16 muestra los datos y calculos realizados para el sensor de corriente

AC, mientras que la figura 47 ilustra la linealidad de las mediciones para el

sensor de corriente AC.

Tabla 16. Datos y calculos del sensor de corriente AC

DATOS CALCULOS
Valor Mediciones del Sistema Medicion de pinza Precision Error de
Referencial| medidal medida2 medida3 | promedio amperimétrica medicion (%)
9 9.01 8.90 9.01 8.97 8.70 0.06 3.14
20 20.30 20.30 2030 [ 2030 19.90 0.00 2.01
20.5 20.63 20.63 20.63 " 2063 20.50 0.00 0.63
25 24.93 24.93 24.93 [ 2493 25.10 0.00 -0.68
30 29.43 29.43 29.43 [ 29.43 29.60 0.00 -0.57
33 33.62 33.73 33.62 [ 3366 34.50 0.06 -2.44
38 37.70 37.70 37.70 [ 37.70 38.00 0.00 -0.79
42 42.31 42.31 42.21 [ 428 42.50 0.06 -0.53
47 46.71 46.71 46.71 " 46.71 47.00 0.00 -0.62
50 50.48 50.38 5048 [ 5045 50.70 0.06 -0.50
55 55.09 55.46 55.41 [ 5532 55.00 0.20 0.58
60 60.75 60.64 60.64 [ 6068 60.07 0.06 1.01
PROMEDIO 0.04 0.10
70.00
60.00
50.00
40.00
¢ CORRIENTE AC
30.00 ——Linealidad del sistema
20.00 y=1x-0.0432
10.00 &
000 T T T 1
0.00 20.00 40.00 60.00 80.00

Figura 47. Linealidad del sistema sensor de corriente AC — Arduino
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CONCLUSIONES Y OBSERVACIONES

Al finalizar el trabajo de tesis, se obtuvieron las siguientes conclusiones y

observaciones:

e Se concluye que el sistema de monitoreo desarrollado, logra recopilar
satisfactoriamente los parametros eléctricos y atmosféricos tal como se
muestra en las tablas de resultados presentados en el punto 4.3 Analisis
de Resultados.

e El sistema de monitoreo es confiable pues se esperaba un error no mayor
al 2%, y este presenta un error de medicion menor al 1.5% para los
parametros DC (tensién y corriente) incluso menor al 0.5% para los demas
parametros.

e La precision del sistema es favorable, siendo menor a 0.04 unidades en
todos los parametros excepto la tension alterna, donde la precision es de
0.33V.

e Los componentes utilizados pueden ser conseguidos localmente, con
excepcion de los sensores; por lo tanto su implementacién puede ser
replicada facilmente en universidades.

e Se puede observar que el sistema de monitoreo implementado requiere

de una calibracion previa al funcionamiento.
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RECOMENDACIONES

Para que el sistema de monitoreo desarrollado pueda ser replicado y

mejorado se recomienda lo siguiente:

e Los valores de las resistencias deben ser medidos previamente para
determinar con exactitud su valor real, y asi poder calcular la funcién de
transferencia exacta entre los parametros de entrada y los valores del
microcontrolador.

e Larelacion de conversion de la sefial AC a DC se debe ajustar mediante
mediciones a la entrada y salida del convertidor.

e Se debe aplicar tensiones o valores offset a las sefiales que asi lo
requieran.

e Debido a que el sistema de referencia de tension es el mismo para todo
el sistema, las sefiales de tension DC a sensar deben tener una referencia
comun (GND) con el fin de evitar cortocircuitos.

e Se recomienda sensar sefiales DC libres de ruido, por lo tanto usar filtros
gue posibiliten su medicion.

e Se recomienda conectar y desconectar la tarjeta microSD cuando el
sistema no se encuentre energizado.

e Se sugiere realizar mayores experimentaciones para validar el
funcionamiento del equipo.

e Es recomendable tener un mayor niumero de valores para evaluar la
precision y exactitud.

e Es necesario calcular la capacidad de datos que se pueden almacenar en

una tarjeta microSD de determinada capacidad y periodo.
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TRABAJOS FUTUROS

El presente trabajo de tesis fue desarrollado siguiendo unos objetivos
establecidos. Sin embargo, este puede afadir ciertas etapas a futuro que

ayudaran en su funcionamiento.
Entre los trabajos futuros que se plantean se encuentran:

e Opcion de calibracion en tiempo real: No cabe duda que la calibracion del
sistema es esencial para conseguir los valores de precision esperados.
En el actual sistema este debe ser calibrado mediante codigo y debe
realizarse previamente a las mediciones. Por lo que se propone modificar
el codigo en un futuro para que sea capaz de calibrar cada sensor sin
necesidad de modificar el codigo, simplemente usando el teclado para
modificar variables de calibracion.

« Optimizar el disefio y arreglo del sistema: El prototipo del sistema funciona
correctamente, mas es voluminoso y no aprovecha al maximo todo el
espacio disponible. Por tanto, se propone mejorar el disefio de las tarjetas
y el chasis para hacerlo mas compacto y cuente con las Certificaciones
de Proteccion IP para una mayor seguridad.

o Afadir una conexién a tierra al sistema: Una conexion a tierra en el
sistema de medicién afadiria una mayor robustez al datalogger, lo que

prolongaria su expectativa de vida.
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Customer Support

Customer Support

Renewable NRG Systems offers a variety of support options to help you get the most from your Renewable NRG Systems
product. If you have questions about your Renewable NRG Systems product, first look in the printed product
documentation, the Knowledge Base, or in the Technical Forum in the Tech Support section of the Renewable NRG
Systems web site. If you cannot find the answer, contact your salesperson or Renewable NRG Systems Technical Support
for assistance using the information below. Customer support is available 8:30 AM to 5:00 PM EST, Monday through
Friday.

Renewable NRG Systems Telephone: 802-482-2255

110 Riggs Road

Hinesburg, Vermont FAX: 802-482-2272

05461 U.S.A. Email: support@renewablenrgsystems.com

When you call or email, you should have the appropriate product documentation at hand and be prepared to give the
following information:

Customer name

Who purchased equipment

Item number or description

Serial numbers of logger and iPack

When equipment was purchased

Where equipment is installed - terrain conditions
Description of the problem with some detail

What events took place leading up to the problem

What you have tried while attempting to solve the problem

Renewable NRG Systems maintains an extensive website which includes an in-depth customer support area for
Renewable NRG Systems customers. If you need assistance at times other than our regular business hours, we suggest
visiting our website, www.renewablenrgsystems.com.

All instruments, sensors, software and towers manufactured by Renewable NRG Systems are designed to be reliable and
easy to use. We welcome your comments and appreciate your help in making Renewable NRG Systems products the best
available.
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Introduction

Introduction

Welcome!

Congratulations on your purchase of the Symphonie PLUS3 data logger. The revolutionary Symphonie PLUS3 data logger is
part of the world’s most advanced Internet enabled data logger system. It gives you all the accuracy and durability of
other Renewable NRG Systems loggers, but allows you to collect data without leaving your desk. Symphonie PLUS3 stores
data on a standard SD card. With an optional iPack or iPackGPS, you can send data via your Internet provider over an
embedded standard, satellite, or cellular phone. You get an email with an attached data file at any interval you choose.

The SymphoniePLUS3 is a further evolution of the Symphonie-PLUS logger. Built on the proven designs of the Symphonie
and SymphoniePLUS, Symphonie PLUS3 offers 3 “flex” channels compatible with either analog or digital sensors with the
addition of an SCM. The universal anemometer inputs of the Symphonie PLUS3 are compatible with most commonly used
anemometers — no SCMs required! Optional plug-in Signal Conditioning Modules (SCMs) are available and pre-configured
to work with analog sensors from Renewable NRG Systems or other manufacturers.

The look and feel of Symphonie PLUS3 as well as the menu structure and user programming tasks remain largely
unchanged from Symphonie and SymphoniePLUS. SCM auto-detection allows the logger to display flex channel
information according to whatever SCM is inserted in the corresponding channel. A new programming feature in the SDR
software allows logger programming using a laptop through the iPack programming port.

If you can program a SymphoniePLUS, you already know how to program a Symphonie PLUS3

The complete Internet enabled Symphonie PLUS3 data logger system is comprised of the Symphonie PLUS3 data logger;
optional iPackGPS kit for (2G) CDMA cellular, (2G) GSM cellular, (3G) GSM cellular (HSPA), or satellite communications,
plus Symphonie Data Retriever Software. The Ethernet based iPackACCESS is also available and is very well suited for use
at reference towers where real time SCADA networks polling for MODBUS data are utilized. Starting in June 2010, all
wireless based Symphonie iPacks will ship pre-configured for WindLinx wireless service. WindLinx allows for uniform
activation of communications services and features the WindLinx web portal, which allows for remote management and
monitoring of wireless account activity.

Using This Manual

The Symphonie PLUS3 logger User’s Manual is an indispensable part of the Symphonie PLUS3 logger system. Read this
manual completely before installing and operating the Symphonie PLUS3 logger. Follow all instructions and
recommendations closely. Several checklists and forms have been included to facilitate preparing for installation and site
visits. Avoid jeopardizing the reliability of your data collection system by being prepared with the required information and
tools.

This document and the instruments described herein may use the following symbols:

1] e —
== Earth (Ground) Read the Manual = DC Voltage

Definitions
This type style is used for the general body of this manual and is used for general descriptions and instructions to the
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user.

Instructions in Bold Type refer to Symphonie Data Retriever Software and require you to press a button on the computer
screen, open a file, or select from a program menu. For example: File>Open.

Instructions in [Brackets] refer to Symphonie PLUS3 logger keypad navigation and require you to press a series of keys
to perform a specific function. For example, pressing the [Home/Esc] key will always return the display to the Main
Menu.

This type style is used to show actual prompts and messages that appear on the logger display.

This type style is used to warn users of a potential danger, either to themselves or to the equjpment or data.

SymphoniePLUS3 Set-up Overview

SymphoniePLUS3 is a very flexible logging system that can be set up as a stand alone unit or as an Internet enabled
logging system. When used as a stand alone unit, data files are retrieved manually through regular site visits. When used
in conjunction with a snap-on CDMA, GSM, or satellite communications iPack, data files are delivered to the user as email
attachments.

Stand Alone Users (no iPack)

Stand alone SymphoniePLUS3 configuration is fairly straightforward for those familiar with data loggers. Follow the
sections on logger setup carefully. Stand alone users may skip the headings in this manual referring to iPacks and do not
need to install the SDR software in order to configure a logger. All software related operations including software
installation can be skipped until files need to be processed.

Internet Enabled Users (with iPack or iPackGPS installation)

This manual provides full instructions in a chronological order for Symphonie PLUS3 [ iPack / iPackGPS systems. It is
recommended that the manual be followed in chronological order for configuring an iPack or iPackGPS System. The term
“iPack” as used throughout this manual refers to either the iPack or iPackGPS except where a difference in programming
or features is explicitly noted.

As of June 2010, all iPacks ship pre-configured for WindLinx wireless service. Through WindLinx unified wireless service,
iPack and iPackGPS users can set up Internet service provider accounts in addition to cellular or satellite accounts from a
single provider. The WindLinx web portal will generate necessary programming parameters for the iPack. Instructions for
programming the iPackGPS, released February 2011, are the same as for iPacks except where explicitly noted.

Theory of Operation

The Renewable NRG Systems SymphoniePLUS3 data logger is an Internet ready, ultra-low power microprocessor-
controlled data logging system specifically designed for the wind energy industry. Addition of a wireless based iPack with
a small PV panel provides convenient autonomous power (with its built-in 12V battery and charge controller), and allows
for Internet transfer of data via email through wireless networks. The Ethernet based iPackACCESS is suitable for
windfarm reference towers which require real time and statistical data for SCADA networks.

The Symphonie PLUS3 logger has a fixed averaging interval of 10 minutes. Each of the 15 channels’ averages, standard
deviations, and other statistical values are calculated from continuous 1 second data samples. Data intervals are
calculated every 10 minutes, time stamped with the beginning time of each interval and written to the SD Card (SD) at
the top of each hour.

Symphonie Data Retriever (SDR) software is then used to process raw data files stored on your computer either from an
SD Reader or email. Configuration of iPacks is also performed by the SDR software with the use of a programming cable.
Sensor scales and offsets programmed into the Symphonie PLUS3 logger can be edited later with SDR if there is a mistake
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or if a sensor is added or changed. The parameters in SDR’s Site Information Editor are used to create the tab-delimited
text file (ASCII), so there is always an opportunity to make changes to how the raw files will be processed before
generating ASCII data files.
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Features of the SymphoniePLUS3 Logger System

The Symphonie PLUS3 logger is a 15 channel data logger optimized for the needs of the wind energy assessment user. It
is designed to be easy to install and reliable in any climate. Wherever you need to measure the wind, no matter how
demanding the environment, SymphoniePLUS3 and the “plug and play” iPacks make data collection as easy as reading
your email.

It provides up to 9 counter inputs used for measuring wind speed or other frequency signals such as rain gauges
or other totalizer type sensors.

All counter inputs can accommodate the RNRG Class 1 Anemometer, RNRG 40C Anemometer or other digital
anemometers and do not require SCMs. Only flex channels (channels 4, 5, and 6) require SCMs.

3 flex channels can be configured for analog or anemometer/counter input signals by inserting an SCM card.

It provides up to 9 analog channels (6 dedicated analog channels plus 3 flex channels) used for measuring wind
direction or a range of other parameters including temperature, barometric pressure, relative humidity and solar
energy.

The Symphonie PLUS3 logger is wind energy industry specific and pre-configured to industry standards. All
features for wind energy assessment are built in. Symphonie PLUS3 requires no complex configuration.

Convenient “plug and play” Signal Conditioning Modules (SCMs) are pre-configured for a large variety of
additional sensors.

Configuration of channels 4-6 and 9-12 can be altered at any time for different sensors by simply changing the
corresponding SCM. Channels 4 — 6 offer the option of accepting either analog or anemometer/counter SCMs.

Symphonie PLUS3 uses standard, non-volatile Secure Digital (SD) Cards (SD) for data storage. Cards are available
almost anywhere in the world and provide secure data storage.

The SD card provides over 2 years of data storage.

Average, Standard Deviation, Maximum and Minimum values are recorded for all wind speeds and most analog
channels at every 10 minute interval. Set up is done for you.

Free Symphonie Data Retriever Software is included and produces versatile tab-delimited text files. Data files can
be used with a wide range of data processing software, including SQL databases, Microsoft Excel and Access, and
more. International numeric formats are supported.

The 4 line x 20 character display is easy to read and provides easy to understand real-time data and configuration
information.

Dedicated navigation buttons (up, down, left, right, home), plus a data entry keypad make the full-text, menu
driven display easy to use.

Separate lithium battery-backed real-time clock provides accurate and reliable time stamping.

Wiring panel provides additional gas tube electro-static damage (ESD) protection for each input channel.

Symphonie PLUS3 runs on two alkaline D-cells (included) for up to one year, depending on sensor configuration.

iPack kits for CDMA cellular, GSM cellular, and satellite communications provide remote data collection via e-mail.
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Symphonie iPack | Power Only kits provide additional power for higher consumption sensors such as barometric
pressure sensors or relative humidity sensors.
Loggers with iPacks allow remote changes to sensor configuration and communication parameters via email.

Symphonie Data Retriever Software allows pre-installation programming of iPacks and Symphonie loggers
through a programming cable.

Call Now and antenna test features allow on-site testing of iPack communications.

iPack battery can be recharged after office testing using a convenient wall charger (available from Renewable
NRG Systems).

Symphonie Data Retriever Software version 7 and later is compatible with data from Symphonie PLUS3,
ISI);mphonie, Wind Explorers, 9200-PLUS, and 9300 series loggers and their readers (DataPlug Reader, EEReader
Improved support for DBCS systems.

Data filtering in Symphonie Data Retriever Software can exclude icing data and faulty sensor data from reports.
Support for SMTP authentication for iPacks version 14 and later.

iPackGPS can have its firmware upgraded via e-mail or on site using SDR and the iPack programming cable.
POPAuto feature included with Symphonie Data Retriever Software automates extraction of emailed data.
Convenient access to complete sensor history information in the Site Information Editor screen.

Customized ASCII export available.

Integrated Global Positioning System (GPS) in iPackGPS

More detailed iPackGPS info such as iPackGPS serial number, signal strength, modem identifier, and firmware
version available in header of each raw data file.
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Precautions

Notes for First Time Users

It is recommended that you take the time to become familiar with your new logger and its operation before going out in
the field. Please read the manual and experiment with all the functions and features of the Symphonie PLUS3 data logger.

Practice the following in your office before going to the field:

installing SCM cards

setting Symphonie PLUS3 parameters (through the keypad, or through the iPack with the iPack programming cable)
attaching the sensors to the SymphoniePLUS3 logger

using the keypad

formatting and changing SD cards

changing batteries

installing and configuring iPacks (ALWAYS verify successful data transfer before field installation!)

using Symphonie Data Retriever Software

transferring data from the SD card to your PC

Grounding

Whenever coming in contact with the SymphoniePLUS3 logger, either in the field or indoors, it is good practice to first
grasp a piece of grounded (earthed) metal to avoid a potentially damaging electrostatic discharge (ESD) to the logger.

Meteorological sensors, loggers, and towers will accumulate static charge unless they are properly grounded. Both high
wind speeds and low humidity increase the rate of charge accumulation. Static charge can change the electric potential of
the logger and sensors by thousands of volts relative to ground. Charge will continue to accumulate until the developed
voltage difference causes dielectric breakdown and static discharge.

Electrostatic discharge will damage any scientific instrument, including a Symphonie PLUS3 logger. It is very important
that you ground your logger immediately after mounting and prior to connecting a sensor. If a copper clad ground rod
cannot be driven into the ground at the base of the tower, a grounding cable should be buried in the ground for sufficient
distance to reduce the resistance between the logger ground stud and the earth. Failure to adequately ground a
Symphonie PLUS3 logger will cause damage to the logger, sensor damage, and loss of data.

Equipment that is not properly grounded is not covered by Renewable NRG Systems’ warranty.

Recharging the iPack Battery

Lead acid batteries such as the one used in the Symphonie PLUS3 iPack need to be kept fully charged. It is very important
to recharge the iPack before installing it in the field, especially after programming or communications testing. All lead acid
batteries will lose their capacity over time.
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The battery must be recharged if an iPack is kept in storage or is unused for any period of time.

An iPack battery charger is available from Renewable NRG Systems (item #3615).

[Pack models released after April 2006 have an additional set of terminals for a 12 V external power source (battery bank
with charge controller, for example). Please review the following table to make sure you are making the correct

connections.

Connection Point

Do

Do NOT

Functional Notes

PV Terminals

Do...connect PV panels, DC power
sources between 14 and 28 V DC

Do NOT...connect power sources in
excess of 28 V DC, including large PV
panels

IThe PV terminals will charge the iPack’s
internal battery; the PV terminals will NOT
charge an external battery.

External Battery
Terminals

Do...connect 12 V battery and/or
external charge controller up to 14.3 V
DC

Do NOT...connect PV panel or power
sources in excess of 14.3 V DC

IThe external battery terminals are an input
only, an external battery will NOT be
charged from the iPack through these
terminals nor will the internal iPack battery.

Ground Terminal

Do...connect to logger ground stud and

trim ground wire to the required length.

Do NOT...leave disconnected or connect
other wires such as shields; do NOT coil
or roll excess ground wire.

[This terminal will help provide protection
from electrostatic discharge for the iPack

and logger.

If the iPack battery is not fully charged before being installed in the field, the battery may discharge faster than the
photovoltaic panel can recharge it. This is more likely when using sensors with greater rates of power consumption such
as barometric pressure and relative humidity sensors. Like most lead acid batteries, if the iPack battery remains at low
capacity for an extended period of time, the battery will no longer accept or maintain a charge.

Environmental Considerations

Grounding requirements are site specific; determine soil type before installation.

Sensor cables become less flexible and are more easily damaged at very low temperatures.

Make sure that all sensor cables are securely fastened to the tower so they do not flap in the wind.

Be sure that all connections are tight and securely fastened to ensure reliability in high winds.

Low temperatures can diminish battery performance. Always use good quality alkaline batteries, and always stay

within reasonable limits when establishing your battery replacement schedule. Replace alkaline batteries at least
once per year to avoid leakage.
e Make sure that all sensor cables are spiral wrapped (2 wraps every three meters) around the tower to discourage
natural frequency vibrations. Use a high quality electrical tape rated for extreme conditions to further secure the
cables to the tower.
e Coat terminal connections with anti-corrosive or petroleum jelly to reduce corrosion.

Site Records

Understanding the assignment of site numbers is the single most important step in setting up a wind assessment

system.

The Symphonie PLUS3 logger system requires that you assign a unique site number to each logger site.

The assigned site number must stay with the site even if the tower, sensors, and logger are dismantled and moved

to another location.
e An abandoned site number is never re-used or assigned to a new location. It remains as a reference to the

historical data from the abandoned site.

An accurate description of each site is essential to your wind measurement program. Your SymphoniePLUS3 logger can
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be configured to label datasets with the following information:

e Latitude and longitude (programmed automatically when using iPackGPS)
e Site elevation (programmed automatically when using iPackGPS)
e Sensor heights

It is advisable to record additional site information that may help in the analysis of your data:

Type of terrain (open plain, mountainous forest, etc.)
Type and height of trees

Type of climate

A topographic map of the area

Additional procedures and recommendations for keeping good site records can be found in the American Wind Energy
Association’s siting standards document. Standard Procedures for Meteorological Measurements at a Potential Wind

Turbine Site. This document can be found on the AWEA web site, www.awea.org.

Other good resources for site configuration guidelines can be found here:

http://www.nyserda.org/publications/wind resource assessment handbook10 30.pdf
http://www.measnet.com/measnet_siteassessment vl 0.pdf

In the Appendices, we've provided some blank site data sheets that may be helpful in organizing site information.
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SymphoniePLUS3 Logger Components (Quick Tour)

Unpacking the SymphoniePLUS3 Logger System

Follow standard precautions for handling electronic components when unpacking the Symphonie PLUS3 logger.
Discharge static electricity from your body by touching a piece of grounded metal or wearing a ground strap.

Do not remove the brown desiccant pack from the clear plastic package at this time. During the field
Installation procedure, you will remove the clear wrapper and place the desiccant pack inside the
logger enclosure to keep it dry.

Confirm that you have received all components by comparing your order to the packing list shown below. Immediately
contact Renewable NRG Systems if any of the components are missing.

You should find the following standard equipment:
1 — Symphonie PLUS3 data logger unit
2 — 1.5 volt D-cell alkaline batteries
1 — 3 volt lithium clock battery (installed)
1 — 10 foot (3 meter) 10 Ga. ground cable with connector
2 — 10-32 hex machine nuts
4 —10-32 x 0.50 inch (13 mm) mounting screws
1 — desiccant pack
1 — Renewable NRG Systems SD card with protective case
1 — field wiring panel
1 — sheet of paper referring users to Renewable NRG Systems’ website for downloading the latest version of
Symphonie Data Retriever Software and the Symphonie PLUS3 User’s Manual
1 — screwdriver with Renewable NRG Systems logo

Be sure to double-check your order for any optional equipment ordered, such as SCMs, extra SDs, etc.
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SymphoniePLUS3 Logger Components Map

Here is an illustration of the logger with the cover open and the battery cover removed.

Display
SD Card Slot——~[ ]
ar © ’ 1. Measurements ] =
2. Status |
ﬂ 3. Utilities
4, Settings L
|| ——Navigation Keys
| - | —1 (Left, Down, Up, Right)
] = I

Keypad——
\

D Boﬂeries\

Reset Button
(Partly Under Frame)

EANEY

Input Connector
@ L

M/Ground Stud

Clock Battery
Use CR2032 Lithium Cell b
+ to Right I

If Red Warning LED is on, SCM for

Clock Battery is BACKWARDS Analog 12

[ SCM for
SCM for / Analog 11

Flex Channel 4 L scMfor SCM for
X Flex Channel 6 Analog 10

iPack / /
Aecesskod | scMmfor SCM for
Flex Channel § Andadlog 9

Keypad

e Two field types are utilized when programming the SymphoniePLUS3 logger - numeric only and alphanumeric. While
in a numeric only field, pushing a numbered key allows direct entry of any numeric value. While in alphanumeric
fields, the keys will scroll through each of the assigned characters. For example, push the [2] key, and it types the
number “2.” Push the same key again and it types the letter "A” or "a.” Press the same key again, and it types the
letter “B” or “b.” The navigation keys in the top row are used to toggle between upper and lower case letters (see
below).

e In this manner, the digits 0-9, the entire alphabet, as well as special characters, can all be entered utilizing only ten
keys.

e The zero [0] key can be used to enter a blank space or the characters “*” and “#.” Pressing the [Home/Esc] key
will always return the display to the Main Menu.

e Take some time to experiment with the keypad to become familiar with its operation.
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Navigation keys

The keys in the top row are the navigation keys — left, down, up and right. These keys can be used to page forward and
backward, move the cursor on data entry screens, and enter decimal points “.” or negative “-" characters. Additionally,
the up and down keys are used to toggle between capital and lower case letters in alphanumeric fields. The exception to
this is that the up and down arrow keys are used for the semi-colon and colon characters while in the Manual Dial screen
of the iPackGPS.

Display

e The liquid crystal display is built into the logger to facilitate site visits and is activated by pressing any key on the
logger keypad. The user can view present wind conditions and logger parameters without additional equipment.

e As a power saving function, the display will always shut off after one minute without any key inputs. The logger
continues to collect data while the display is off.

D-cell Batteries

The logger runs on standard D-cell batteries which are protected by a battery cover. Batteries should be changed one at
a time so that logging operations are not disrupted during the battery change.

It is recommended that high quality alkaline batteries are used (such as Energizer or Duracell), and they should be
changed at least once per year to avoid leakage and equipment damage.

Input connector

This male DB-62 connector interfaces to the field wiring panel. Sensor wires are connected to the field wiring panel with
the supplied Renewable NRG Systems screwdriver.

iPack access port

This port allows connection of the Programming Adapter for iPack and logger programming while the iPack or iPackGPS is
connected to the logger.

Ground stud

This 10-32 stud is designed to be connected directly to earth ground with the supplied ground cable. The logger must be
grounded!

Clock battery

A lithium battery powers the logger clock even if D-cell batteries are not present. This allows the logger to retain date and
time in the event of a reboot. Clock batteries will last many years under normal use.

Clock battery warning LED
This LED illuminates if the clock battery has been installed backwards.

Reset Button
Any time the reset button is pressed, the logger will begin a new data file.

e A reset button is provided in the unlikely event that a nearby lightning strike or ESD event causes the
Symphonie PLUS3 data logger electronics to lock up. It is located between the battery box and the clock battery.

e Should it become necessary to reset the Symphonie PLUS3 logger, place the Renewable NRG Systems screwdriver
(provided) in the upper corner just to the left of the “Channel 4” SCM slot and slide down.

e Resetting the unit will cause up to 10 minutes of data to be lost (depending on how long since data was last written
to memory) and will start a new data file.
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e Symphonie PLUS3 loggers with attached iPacks will initiate an automatic call (“cold boot call”) 10 minutes after the
logger is powered up. If no antenna is attached or the call can't be completed, no attempt will be made to call again
until the next scheduled call or a “Call Now” is initiated by the user.

e Collected data already written to memory and all configuration settings will be retained.

e The reset button can also be used during field installation to start a new data file from the point at which all sensors
have been connected.

Note that a reset can be also be initiated by the built-in watchdog in response to an ESD (electrostatic discharge) event.
When an iPack is connected to a logger with no D-cells, this will also initiate a reset. The iPack provides auxiliary power to
the logger and therefore powers it up in the absence of D-cells.

SD Card Slot
The SD memory card installs into this slot with the beveled front corner down.

Channel Description

The Symphonie PLUS3 Logger has 15 input channels; 6 channels are counters, 6 are analog, and 3 channels can be either
counter or analog.

Channels 1 — 3 and 13 — 15 (Counters)

Channels 1 through 3 and 13 through 15 have built-in sensor interfaces for the RNRG Class 1 Anemometer, RNRG 40C
Anemometer and other anemometers such as the P2546A WindSensor, Thies First Class, Vector, etc. Flex channels 4
through 6 can be configured for anemometers or analog sensors by plugging an SCM into the corresponding SCM slot for
that channel. The SCM provides the electronics to configure the input for the connected sensor. The SCM also sets up the
channel as a speed (frequency) or totalizer for sensors such as tipping-bucket rain gauges or kWh meters.

SCM slots for flex channels 4, 5 and 6 (analog or counter / anemometer)

Each slot accepts an analog or counter / anemometer type Signal Conditioning Module (SCM). These are used to
configure the logger for additional analog or counter /anemometer channels (in addition to the 6 built-in
counter/anemometer channels). When you insert the SCM, the correct type of sensor should be automatically detected by
the logger and only show programming options appropriate for that type of sensor.

Channels 7 — 12 (Analogs)

Channels 7 and 8 have built-in sensor interfaces for the RNRG 200P wind vane or other wind vanes with similar output
signals. Channels 9 through 12 are configured by plugging an SCM into the corresponding SCM slot for that channel. The
SCM provides the electronics to configure the input for the connected sensor. Appropriate SCMs in analog channels 9
through 12 also describe to the logger whether the analog channel is a vane or other type of analog sensor (relative
humidity, barometric pressure, temperature, etc.).

SCM slots for analog channels 9, 10, 11 and 12

Each slot accepts an analog type Signal Conditioning Module (SCM). These are used to configure the logger for additional
wind vanes (in addition to the 2 built-in vanes channels) or other analog type sensors.
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Pre-Installation Setup: Logger Configuration

It is important to follow the instructions in this section in the sequence presented. Logger programming can be done
using the logger’s keypad, or programming information can be uploaded to the logger using SDR. Uploading from SDR
requires an iPack and connection through the logger’s iPack access port. The Logger Direct Editor screen is accessed
through SDR'’s Modify iPack Settings screen.

Grounding

Whenever coming in contact with the SymphoniePLUS3 logger, either in the field or indoors, it is good practice to first
grasp a piece of grounded (earthed) metal before touching the logger to avoid a potentially damaging electrostatic
discharge (ESD) to the logger.

Installing SCMs

If your site configuration requires more than the 6 built-in anemometer / counter channels and 2 built-in vane channels, it
will be necessary to install appropriate Signal Conditioning Modules (SCMs) for each additional anemometer / counter
sensor (channels 4 through 6) and each additional analog sensor (channels 4 through 6, and channels 9 through 12) to
be connected to the Symphonie PLUS3 logger. Each SCM provides the necessary signal conditioning (filtering, gain,
buffering and protection) electronics for the specific sensor type to be connected to the channel.

Additionally, each SCM automatically sets the logging mode for the channel. The logging mode determines how the
Symphonie PLUS3 logger will process data gathered by each channel. For each flex channel 4 through 6, the SCM
identifies the logging mode as a vane or analog (other than vane), frequency (speed), or totalizer, and for each analog
channel 9 through 12, the SCM identifies the logging mode as vane or analog (other than vane).

Before inserting an SCM in the appropriate slot, be sure to grasp the ground stud on the logger to prevent a
potentially harmful static discharge. The SCM has a metal strip on the top edge to facilitate grounding while
being handled.

e In order to install an SCM, it is necessary to remove the battery cover by loosening the three thumbscrews. It is

preferable that the logger is not powered while installing or removing SCMs, so the D-cells or iPack should not be
installed at this time.

e Install the SCM into the appropriate slot with the pins facing downward and the circuit components facing to the
right.

e Do not force the SCM.
e The pins and connectors are “keyed” so that a counter SCM cannot be inserted into an analog slot.

e Once the SCMs have been installed, the D-cell batteries can be installed, and the channels can be configured.

e Allow 4 seconds between inserting and removing SCMs as they take a few seconds to be recognized by the logger
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Installing D-Cell Batteries

Open the logger enclosure and remove the battery box cover. If you just installed SCMs, the cover should already
be off.

Insert two fresh D-cell batteries, one at a time, into the battery holders with the positive terminals of the batteries
(the end with the bump) oriented towards the sides of the enclosure. When the batteries are first inserted, the
display will read:

NRG Systems, Inc.
SymphoniePLUS3
SN: 00000
Press [HOME]
Replace the battery box cover.
As a power saving function, the display will always shut off after one minute without any key inputs.
The display may also be shut off by pressing [Home] [3] [3].
The logger continues to collect data while the display is off.

SCM cards installed under battery cover

Setting Logger Display Contrast

The Symphonie PLUSZ's display contrast is pre-set at the factory but can be adjusted if necessary. Please note that
changes in contrast are temporary. When the display is powered up again, the default contrast setting will appear. This is
to avoid the screen being accidentally set so that it can’t be read (completely black or completely white).

[Home][3][2] = Set Display Contrast

Use up and down keys
to adjust contrast

ESC=Quit Set=Accept

Setting and Verifying Logger Units (Imperial or SI)
Sensor lists are used to configure each channel of the logger. There are two internally stored factory loaded sensor lists,
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one with scale factors in Imperial units and one with scale factors in SI (metric) units. Setting the logger units to Imperial
will load the sensor list with the scale factors in miles per hour, and the site elevation and sensor height units will default
to feet.

Setting the logger units to SI will load the sensor list with the scale factors in m/s, and the site elevation and sensor
height units will default to meters.

Note that this will not change the currently stored scale factors for each channel in the logger. You must
always confirm the scale factors and units for each logger channel individually.

Press [Home][4]1[3][3]

Use the [UP] and [DOWN] navigation keys to select Imperial or SI.

Press the [Set] key to accept the selected units or press [ESC] to quit without changing the units.

With an iPack connected and using the programming adapter in the logger’s iPack access port, you may set the
Default Units using SDR's Logger Direct Editor Screen (found in the File menu of the Modify iPack Settings screen).

Channel Configuration Sequence — choosing a sensor, setting and verifying each logger channel

It is recommended that the channels are configured only after the logger units have been set to either Imperial or SI as
described above. Default sensor configuration values are preprogrammed for Renewable NRG Systems sensors and can
typically be used to simplify the configuration process.

With an iPack connected and using the programming adapter in the logger’s iPack access port, you may configure each
sensor channel using SDR's Logger Direct Editor Screen (found in the File menu of the Modify iPack Settings screen).

Channel Configuration Using SDR'’s Logger Parameter Editor

To begin the configuration process using SDR, make sure your logger is connected to an iPack and that you have a
programming adapter installed in the logger’s iPack access port. Connect your computer running SDR to the programming
adapter, and choose Modify iPack Settings from the Site menu. Then choose Logger Parameter Editor from the
File menu. Click the Load from Logger button to see the current settings in the logger.

Site Elevation ||;||;||:|1 12 i

Latitude |N 440 20313

Longitude |w 073 05684

SymphoniePLUS3_Data_Logger_Manual |

Default Units] | j

Serial Number ISN: Vane

Height |m

Scale Factor ||:|_35'|

Offset ]180

Units |,:|Eg

i Logger Parameter Editor I r ﬁ
Symphonie Logger #5158 detected Load fram Logger ‘ Save to Logger ‘
Site # ||:|1 04 Channel # | T | bl Load Defaults
Time Zone | 5 -] Description I#EDDP Wind Vane

Rev 16
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Use the arrow buttons to scroll through each channel to review current settings and make changes as needed. If a
channel isn't listed, it means there is no SCM currently installed for that channel and it is therefore inactive. Once changes
are complete, click the Save to Logger button.

symphonie Dats e S ©

Are you sure you wish to overwrite the current logger settings?

Click Yes to accept the changes or No to discard them.

Channel Configuration Using the Logger’s Keypad
To begin the configuration process using the logger’s keypad, press [Home][4]. The following display will appear:

1. Counter Channels
2. Analog Channels
3. Logger Settings

Pressing [1] will display a list of the currently active counter channel descriptions.

Pressing [2] will display a list of the currently active analog channel descriptions.

Scroll through the list of channels using the [UP] and [DOWN] arrows. If a channel isn't listed, it means there is
no SCM currently installed for that channel and it is therefore inactive.

e Press the corresponding number for the channel you wish to configure [for example, 1, 4 for channel 14]. This will
display the currently active channel description.

e You may now edit the currently displayed channel by pressing [SET], or you may select a new configuration from
the loaded sensor list by pressing the [Down] arrow key to scroll until the desired sensor description appears.
When you have scrolled to the correct sensor description, press [SET] to edit. Any changes will be loaded as a
working copy into temporary memory and will be saved and finalized after the configuration process for the channel
is completed.

¢ Note that the currently selected sensor description will be followed by [Set] to Change on the LCD.

Channel 1: Frequency
NRG #40C Anem m/s
[Set] to Change
[Down] for Defaults

Other available sensor description choices will be followed by Up, Down to select and ESC=QUIT SET=ACCEPT.

-> Description (Sensor Model)

Edit the sensor description if desired by using the keypad and navigation keys. Press [SET] when the sensor description
is correct. The description is now loaded into the temporary memory and will be saved after the configuration process for
this channel is completed. The scale factor editing screen will appear next.

-> Scale Factor

Enter the scale factor exactly and be careful to place the decimal point into the correct place. Edit the sensor scale factor
if desired by using the keypad and navigation keys. Press [SET] when the sensor scale factor is correct. The scale factor
is now loaded into the temporary memory and will be saved after the configuration process for this channel is completed.
The offset editing screen will appear next.
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-> Offset

Edit the sensor offset if desired by using the keypad and navigation keys. Press [SET] when the sensor offset is correct.
The offset is now loaded into the temporary memory and will be saved after the configuration process for this channel is
completed. The units editing screen will appear next.

-> Units

The SymphoniePLUS3 Logger may be set to use “mixed” units — that is, one can use SI units for some channels and
Imperial units for others. Additionally, the units for each channel do not need to match the units that have been set for
site elevation (altitude) and sensor height. Edit the sensor units if desired by using the keypad and navigation keys. Press
[SET] when the sensor units are correct. The units are now loaded into the temporary memory and will be saved after
the configuration process for this channel is completed. The height editing screen will appear next.

-> Height
Edit the sensor height if desired by using the keypad and navigation keys. The sensor height may be up to 4 characters.

Press [SET] when the sensor height is correct. The height is now loaded into the temporary memory and will be saved
after the configuration process for this channel is completed. The serial number editing screen will appear next.

-> Serial Number

Edit the sensor Serial Number (SN) if desired by using the keypad and navigation keys. It is an 8 character
alphanumeric field. Press [SET] when the sensor Serial Number (SN) is correct.

All channel parameters that were loaded into temporary memory during editing are now finalized, and the configuration
of this channel is now complete. The SymphoniePLUS3 data logger will return to the channel selection menu, and the
process is repeated for the next channel.

Setting and Verifying Site information, Time Zone, Clock and Data Encryption

Time Zone and Logger Clock (Time and Date)
e Press [Home] [4] [3] [1] to display the screen that sets the appropriate time zone (the logger defaults to zone -
5: American Eastern Standard Time).
e Use the [Up] or [Down] arrows to scroll to the proper zone for your site, then press [Set] to accept. The logger
will update the time zone and then display the prompt:

Set Date and Time
02/15/2003 15:26
mm/dd/yyyy hh:mm
ESC=Quit SET=Accept

Remember to use local standard time (not daylight savings time). Press [Set] to accept.

e With an iPack connected and using the programming adapter in the logger’s iPack access port, you may set the
Time Zone using SDR’s Logger Direct Editor screen (found in the File menu of the Modify iPack Settings screen).

Site Number

e Press [Home [4] [3] [2] to set your unique site number.

e The Site Number field initially defaults to the logger’s serial number but can be reset to any four digit number.

e With an iPack connected and using the programming adapter in the logger’s iPack access port, you may set the Site
Number using SDR’s Logger Direct Editor screen (found in the File menu of the Modify iPack Settings screen).

Site Altitude (Elevation) (optional)
e Press [Home] [4] [3] [4] to set site elevation.
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Site elevations will be expressed using the units (Imperial or SI) previously selected.

Site elevations below sea level can be set by using a “-" in the first position. The “-* can be found in the navigation
keys (the top row of the keypad).

If an iPackGPS with adequate GPS signal is connected to the logger, this setting will be updated automatically at
the end of a successful call.

With an iPack connected and using the programming adapter in the logger’s iPack access port, you set the Site
Elevation using SDR’s Logger Direct Editor screen (found in the File menu of the Modify iPack Settings screen).

Site Latitude and Longitude (optional)

Press [Home] [4] [3] [5] to set site latitude.

Use the [Up] [Down] navigation keys to toggle between north and south ("N” and “S”), and use the keypad to
edit the displayed latitude information.

When the latitude information appears as desired, press [SET].

Use the [Up] [Down] navigation keys to toggle between east and west ("E” and “"W"), and use the keypad to edit
the displayed longitude information.

When the longitude information appears as desired, press [SET].

Enter latitude and longitude in decimal degrees (rather than degrees, minutes, seconds)

If an iPackGPS with adequate GPS signal is connected to the logger, this setting will be updated automatically at
the end of a successful call.

With an iPack connected and using the programming adapter in the logger’s iPack access port, you may set the
Latitude and Longitude using SDR’s Logger Direct Editor screen (found in the File menu of the Modify iPack
Settings screen).

Data Encryption PIN Number (optional)

As a security measure, Symphonie PLUS3 can encrypt data before storing it on the SD. A Data Encryption PIN Number can
be entered into the logger to enable data encryption. Note that this is an optional feature intended only for those for
whom data theft is a risk. Data encryption can be disabled by setting the PIN to 0000. The data encryption PIN number is
set to 0000 (disabled) at Renewable NRG Systems before shipment. If the data are stored in encrypted format on the SD,
the encryption PIN number will also be needed for the SDR software to decrypt the data.

Do not lose the Data Encryption PIN number! You must know the PIN in order to disable or change it.

Keypad Security (optional)

As an added security measure, SymphoniePLUS3 allows you to set a 6 digit lockout code for the logger’s keypad. When a
key is pressed, the first screen displayed will be:

NRG Systems, Inc.
SymphoniePLUS3
SN: 00000

Enter Security Key

Failure to enter the correct security key will result in a message:

NRG Systems, Inc.
SymphoniePLUS3
SN: 00000

Locked, 7 tries left
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If the correct security key isn't entered during one of the remaining attempts, the keypad will lock out the user for
approximately 2 days. Note that this is an optional feature intended only for use by those for whom logger theft is a
serious risk. Keypad security can be disabled by setting the security key to 000000. The security key is set to 000000
(disabled) at Renewable NRG Systems before shipment.

Failure to enter the correct security code within 8 attempts will lock the SymphoniePLUS3’s keypad for approximately 2
days, and there is no way to defeat the lockout — use caution!
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Symphonie Data Retriever Software and Accessories

Symphonie Data Retriever Software Functions

e Reads binary data files that have been stored on the computer hard disk from an email or SD card reader, or MMC
card reader source.

e Stores site information.
Configures iPacks and Symphonie PLUS3 loggers through the use of a programming cable.
Reads files generated by Symphonie PLUS3, SymphoniePLUS, Symphonie, 9300, 9200-PLUS, and Wind Explorer data
loggers, scales them according to a user-defined site file, and converts them to tab-delimited ASCII files readable by
Notepad, Excel, etc.

e Imports data into a self-contained Microsoft Access compatible database.
Exports data as tab-delimited 10 minute, 60 minute .txt files or WASP format for any time range.
Generates Wind Rose, Frequency Distribution and Summary reports for any time range.

Please be sure to open the "Read Me” file and check for any updates that may not have been included
in the printing of this manual.

System Requirements

e Symphonie Data Retriever runs on Windows 95/98/2000, Windows ME, Windows XP Home, Windows XP
Professional, Windows 7, and Vista computer operating systems and can be downloaded from
www.renewablenrgsystems.com.

e An SD card reader is required to read the SD Card. This may be built into your computer or may be an external
reader.

e A standard DB9 COM port is required to program the iPack parameters. Note that in many cases, a USB to serial
converter can be used in place of a real COM port.

Related Hardware Accessories

e iPack programming cable
e Optional USB to serial converter cable with driver

Installation

Symphonie Data Retriever Software must be installed in order to program iPacks or read data files. Download the latest
version from Renewable NRG Systems’ website.

1. Go to the Renewable NRG Systems web site at http:/ /www.renewablenrgsystems.com, and go to the Free
Software Downloads section of the Tech Support page.

2. Click on the link for Symphonie Data Retriever Software and when asked, choose "Run from current

location.”

When the download is complete, the program will start.

Select the options you want to install. If you are not sure, leave all the boxes checked. Hit “"Next.”

Choose the target directory for your installation. If you are not sure, leave it un-changed and hit "Next.”

When the installation is complete, hit "Close.” If you are prompted to restart, do so now.

ouA W
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7. You are now ready to program iPacks or Symphonie PLUS3 loggers or process files.

Please note that a default printer driver must be assigned before the software will run. You may use Windows Control
Panel to do this. Some versions of Windows do not allow users without administrator access to modify Windows system
files. The user must have access privileges to install Symphonie Data Retriever.
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Pre-installation Setup: iPack Accounts

WindLinx Wireless Service

iPacks shipped after June 1, 2010 are pre-configured for WindLinx wireless service. WindLinx streamlines the wireless
account set-up process and simplifies overall management of met tower data transfer from multiple sites around the
world. WindLinx provides satellite, GSM, or CDMA service plus Internet service via the WindLinx web portal, all from a
single supplier. A form with instructions for activating and managing WindLinx accounts is included with each iPack.

To activate the WindLinx service, go to the WindLinx web portal at www.windlinx.com and click the link under New
Users:

@) WindLinx : Unified Wireless Service - Morilla irefox L e e o e ——— e

File Edit View Higtory Bookmarks Iools Help

@ > C A (i httpy/fwwaindling,com

adlines

B! Most Visited | | Getting Started &) Latest

indLinx : Unified Wireless Service

W’NDL INX"‘ HOW IT WORKS RATES & PLANS SUPPORT ABOUT US FAQ LOGIN CONTACT

Welcome to WindLinx, a unified, one-source wireless service solution specifically designed for wind site measurement

campaigns and competitively priced with traditional wireless service options worldwide.

WindLinx offers you...

« One source for pre-configured iPack equipment, cellular service, email delivery, cellular account management, and cross-platform
consolidated billing (GSM, COMa, Iridium Satellite)

« No more waiting on hold for cellular company service/support

« pre-configured {Packs reduce errors and set up time

* Self-service, online tool to manage fleet of iPack cellular accounts

* Monitor the status of your wind data delivery in real-time 24/7/365

« Rate plan flexibility not offered by traditional wireless services — rate plans that make sense to wind measurement campaigns

Field Service Managers | Accounting/Purchasing Field Technicians
== WindLinx saves you time and money. See Before/After Process
z ) L = New Users
_ = One, unifarm service for met tower sites anywhere in the world simplifies wireless account set up and management.
A Create an account or
& Traubleshooting is made easier by in-depth, real-time wireless activity reporting web portal. login for the first time

« Technical support is smarter because Wireless Innovation understands NRG Systems’ Symphonie iPack communication systems.

« Site wireless billing reports are fast and easy to compile using WindLinx site portal — eliminates the time consuming task of
reconciling site activity bills for multiple sites under multiple carriers. We've sained peace of mind, Everything is secure

in one place, with a backup. There's no need to

worry about data loss from bad email addresses or

 windLinx unifies and simplifies your wireless service management — the task definitions are abways the same, whether
sensranhically local or distant.

Dene

During the setup process, the WindLinx web portal will generate necessary programming parameters for the iPack (an
*.ipk file), so much of the information provided in this section and the next chapter, Pre-installation Setup: iPack
Configuration is not required for WindLinx subscribers.

Customers wishing to work with their own service providers have the option to do so according to the instructions
provided below.
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GSM Cellular Account

Before installing your GSM iPack, a GSM cellular account must be activated by a cellular service provider. Your GSM
service provider will supply you with a SIM card that contains the GSM cellular account programming information.

In August 2014, the GSM 3G iPackGPS (model 7984) became available and is compatible with 3G HSPA networks (as well
as 2G GPRS networks). In many locations 2G GSM (GPRS) is still available, and the (2G) GSM iPackGPS (model 4622) can
still be utilized. However, in 2014, a growing number of network providers are migrating from 2G to 3G and 4G service
(for example, AT&T in North America). Be certain to work with the cell provider in your area to determine which services
are available, and obtain an appropriate account and SIM. Circuit Switched Data (CSD) is no longer available in most
areas. Please note that GSM iPacks shipped prior to April 2006 (SN:3122xxxx) cannot handle GPRS connections. GSM
iPacks shipped after June 1, 2010 include a WindLinx enabled SIM.

The SIM card must be installed into the GSM iPack before the iPack can be installed. Detailed instructions for opening and
closing the iPack can be found in the next chapter of this manual. A PIN (Personal Identification Number) number may
also be provided and its use is supported by the iPack. Be sure to inform your cellular service provider that you need the
account enabled for data service.

Record your GSM iPack cellular parameters using the GSM iPack Data Sheet worksheet found in the Appendices of this
manual.

CDMA Cellular Account (Verizon)

Before using your CDMA iPack, a data account must be established with Verizon. In order to activate your CDMA account,
you will need to provide Verizon with the CDMA iPack’s Electronic Serial Number (ESN). The iPack’s unique ESN can be
found on a label on the CDMA iPack. Once you have given the ESN to the cellular provider and the account has been
activated, you will need to register the phone in a Verizon home area. This is done through SDR by connecting the iPack
directly to your computer, or by accessing the iPack through the logger’s iPack access port, or through menus accessed
from the logger’s keypad. The phone will then download the account information automatically. It is absolutely essential
that a test call is performed prior to installing the CDMA iPack in the field.

iPackGPS users can use the Manual Dial feature [Home][3][4][5] to switch a CDMA iPackGPS to WindLinx or from
WindLinx to Verizon through use of an initialization string (*22899;). Sending this initialization string updates the
iPackGPS modem’s PRL (Preferred Roaming List). When entering *22899; in the Manual Dial screen, use the up arrow to
enter a *, use the right arrow key to enter a semi-colon, and then press the “"SET” button on the logger’s keypad.

NOTE: If opting out of WindLinx service for a CDMA iPackGPS, it is necessary to contact Wireless Innovations with the
serial number and ESN before registering with Verizon.

Satellite Account

Before installing your satellite iPack, an account must be established with a satellite service provider that utilizes the
Iridium satellite network. Complete the Windlinx activation form included with the satellite iPack and fax to the satellite
service provider as instructed on the form. The satellite phone in the iPack will be active once confirmation is received
from the satellite service provider.

Internet Service Provider (ISP) Account (all iPacks)

Before installing your iPack, an Internet Service Provider (ISP) account must be activated. iPacks shipped after June 1,
2010 are pre-configured for WindLinx wireless service, which includes Internet service. If you choose a different ISP, it
must be capable of handling dial-up connections, be compatible with either PAP or CHAP authentication methods, be able
to recommend Domain Name Service (DNS) servers, and have an SMTP server available for use. The SMTP server can
connect over user defined ports (for example ports 25, 587, 465). A POP3 server name, mailbox name and mailbox
password are required, and you may use the ones provided by your ISP. POP3 ports are also user definable.
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With GPRS service, SMTP server information can sometimes be obtained from the cellular service provider. Remember
that SMTP servers are used to send email from the logger. However, you will still need a POP3 mail account (to receive
patch files), which will likely not be provided by the cellular carrier. Multiple loggers can share one POP3 account between
them, but this account should not be used for anything other than Symphonie PLUS3. If you do not already have a POP3
account for your loggers, you can obtain one from an email provider.

The POP3 mailbox MUST remain clear of SPAM and other email. The iPack checks the POP3 mailbox at the end of each
successful data transmission. Email other than a patch file residing in this mailbox will increase airtime unnecessarily.

Multiple loggers can share a single ISP account just as multiple users can share one ISP account. Check with your ISP
provider to see if more than one user can be logged in to an ISP at any one time.

Renewable NRG Systems recommends having a separate, iPack-only ISP account to make handling your data easier and
avoid access conflicts. It is recommended that the assigned iPack ISP account is NOT the same account you use for your
personal Internet access. Each ISP account allows access for one user at any given time. This means that your day-to-day
office Internet access could obstruct the iPack’s Internet access. If the ISP is busy with another user, the iPack will try
again later. Repeated attempts to access the Internet should be avoided.
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Pre-installation Setup: iPack Configuration

Items required to configure (program) an iPack

You will need the following items to configure an iPack or iPackGPS. Be sure you have all of these items before
continuing:
e Symphonie Data Retriever Software
e Computer - system requirements are specified in the Symphonie Data Retriever Software and Accessories section
of this manual. You must follow the instructions to install the software before proceeding.
e iPack programming cable (available from Renewable NRG Systems)
e USB to serial converter with driver (if your computer does not have a 9-pin serial port)
e Al ISP and phone account information (WindLinx subscribers will be provided this information and an *.ipk file
from the WindLinx web portal)

Configuration (Programming) recommendations

iPack configuration should always be done in the office before going to the field. Bringing an “active, ready to go” iPack to
the field will insure the installation can be performed as quickly as possible, saving valuable field time and expense.
Please note that if your logger revision is 8, 7, 11 or later, you have the ability to program the iPack through the logger’s
iPack Access Port. However, the iPack Access Port is intended for field use. For pre-installation programming of iPacks in
your office, we recommend using the programming cable with PC as described below.

Grounding

Please take care to observe good grounding practices when configuring your iPack. If you are in a dry office environment,
make sure to discharge yourself before handling the iPack. The best solution is to place the iPack on a grounded anti-
static mat.

Connecting the iPack to the Computer

Connect the iPack using a standard 9-pin female to 25-pin male AT Modem cable to the serial port on your PC. The 9-pin
end goes to the PC, and the 25-pin end goes to the iPack. Connect the computer end first, and then connect the iPack
end. If your computer doesn't have a 9-pin serial port, you will need to use a USB to serial converter.

Starting Symphonie Data Retriever iPack Configuration Software

Start the Symphonie Data Retriever Software from the Windows Start menu. The program is usually found here:
C:\NRG\SymDR\SDR.exe.

Establishing communication between the computer and iPack

From the main SDR Window, select Site>Modify iPack Settings. Check the lower left hand corner of the Modify iPack
Settings window for a message.

If you receive no message or “iPack Communication Failed,” it is likely that the COMM port on your computer is not
configured properly. You must disable any programs such as Palm HotSync that might be trying to access the COMM port.

Select Options>Comm Port from the menu, and select the communication port you will be using to connect to the
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iPack. The COMM port setting will be restored the next time you use the program and only needs to be entered the first
time you use the program or following a reinstallation of SDR software.

Select Comm Port s

COM3 b

Note: If none of the COMM ports in the Select Comm Port window can be selected, you will need to use Windows Control
Panel’s Device Manager to change the available COMM port number to 1, 2, 3, or 4. Please note that iPackGPS users may
choose COMM ports 1 through 16.

If the port is properly configured, you should see the message “Verifying iPack Connection” and then “iPack detected” at
the bottom of the window. iPackGPS users will see a tab labeled “iPackGPS/ACC” displayed. The “iPackGPS/ACC” tab
(shown in many of the following screen shots) will not be visible if an older iPack is detected.

“I” Madify iPack Settings o

Eile QOptions

ISP Information | Cal Schedule | iPackGPS/ACE | Modbus |

l Email Configuration ] I ail Becipients ]

Frimany ISP Phone Mumber | r

Primary DMS Murmber |[nooo

Secondary DMS Mumnber |no.oo

Authentication Method PP

lzer Mame |

a1 O 7

Ilzer Password |

AP Mame [GPRS Only) |

| PackGPS GSM-3G w60 detected

Phone Programming & Initialization Overview - Set Up Phone

You will want to take extra care during this section. It is strongly recommended that you get the iPack working
before bringing it to the field for installation!

.

At this point, you have established communication between the iPack and your computer. The embedded GSM phone will
need to be programmed through SDR with the account information provided by your cellular service provider.

iPacks with WindLinx are pre-initialized at the factory; non-WindLinx CDMA and Satellite iPacks require initialization.
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Note that you may select Options>Set up Phone, and then use the Get button to retrieve the IMEI Number or ESN
Number from the iPack’s phone modem. The appropriate type of phone (GSM, CDMA, Satellite, etc.) button should
already be selected

Set Up Phone Set Up Phone
Connection Type- 1 Conmection Type: I
" Dialup AMPS % GSM (" Dialup 7 AMPS % G5M S
" DoCobo © COMA © Satelite {7 DoCoMo  COMA T Satelite /
G5 Cellular Phone Parameters T G5M Cellular Phone Parameters 1 L
IMEI Murnber: Click 'Get' IMEI Number: 011393000003530
[~ PIN Humber Required I PIN Mumber Required
PIM Mumber PIM Mumber
[ |
|| |

Start &ntenna T est ' Start Antenna T est

Other options available on this screen are the ability to set a PIN Number using the Send button or perform an antenna
test without a logger attached to the iPack using the Start Antenna Test button.

Phone Programming - GSM cellular

The GSM phone programming functions are performed through the GSM SIM (Subscriber Identity Module, a smart card
containing the telephone number of the subscriber, encoded network identification details, the PIN and other user data
such as the phone book). Your GSM provider will supply you with a SIM that you will install into the phone. In August
2014, the GSM 3G iPackGPS (model 7984) became available and is compatible with 3G HSPA networks (as well as 2G
GPRS networks). In many locations 2G GSM (GPRS) is still available, and the (2G) GSM iPackGPS (model 4622) can still
be utilized. However, in 2014, a growing number of network providers are migrating from 2G to 3G and 4G service (for
example, AT&T in North America). Be certain to work with the cell provider in your area to determine which services are
available, and obtain an appropriate account and SIM. Circuit Switched Data (CSD) is no longer available in most areas.
Please note that GSM iPacks shipped prior to April 2006 (SN:3122xxxx) cannot handle GPRS connections. GSM iPacks
shipped after June 1, 2010 include a WindLinx enabled SIM.

Installing a SIM card into a GSM iPack

WindLinx subscribers do not need to open the iPack as the WindLinx SIM is already installed. However, other GSM users
will need to open the iPack and install a SIM card into the GSM Data Modem.
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Opening the iPack
Be sure to touch the metal shell of the DB25 connector on the iPack before opening the enclosure in order to safely
discharge any static electricity.

The iPack enclosure consists of two halves secured together by four recessed screws, two from each side of the

enclosure. A gasket in between the two halves and 8 o-rings provide an environmental seal for the iPack protecting the
internal electronics from the elements.

GSM Transceiver

)
R offire.explovsan o baresDu 8

wr
el or bk s 65°CH

w o B [l

Remove the four recessed screws, and the iPack will separate into two halves. For older iPack models a short cable will
connect the two halves. One half contains the iPack electronics, and the other half contains the rectangular battery which
is secured by Velcro. Newer GSM iPacks will have the battery and electronics on the same half. The GSM transceiver is

located to the left of the battery. 7ry not to lose any of the o-rings, and be careful not to rip or tear the gasket if it should
come loose.

Battery
¥ "Support

Antenna GN)
—

- %3V Su /1
1] T|C
DOCOMD PR g JFRYVITIC
370O5v [or4\G) v
% TP303.3v
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Once the iPack cover is off, find the GSM transceiver. Install the SIM in the GSM Data Modem by gently sliding it in. Older
GSM Data Modems will have an outline of the correct SIM orientation. Be sure to install the SIM so that the gold contacts
are facing down and the SIM card’s notched corner is aligned to the top right, as seen in the picture above. First-
generation GSM Data Modems will have a hatch that needs to be opened before the SIM can be inserted. Secure the
hatch (if applicable), and then reassemble the iPack.

Socketmodem
, _ Interface

° 9090000
r\\_/" — 2

Closing the iPack

Insert the (4) 2-'2 inch mounting screws up through the half of the enclosure that contains the iPack electronics.
Set the gasket into the groove of the shell.

Slide the cover (the half with the battery) over screws being careful not to pinch the battery cable.

Make sure the gasket is not pinched, and then install the screws. It is a good idea to make sure the screws fall
back into the existing threads in the iPack enclosure. An easy way to do this is to gently turn the screw
counterclockwise one turn — it will fall into the existing threads in the iPack enclosure.

PIN Number

Setup parameters for GSM phones are stored on the user-installed SIM card. Some SIM cards, however, require an un-
locking PIN number to be entered every time the phone is used. The iPack uses this PIN humber to initiate a call. The PIN
should be a 4 to 8 character string and must be entered in the Set Up Phone screen shown below.

Press Send to send the PIN number into the modem. If your iPack does not require a PIN, do not press Send, and make

sure the PIN Number Required box is un-checked and no characters appear in the PIN Number field. Return to the Modify
iPack Settings window by closing the Set Up Phone window when done.
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8 B
Set Up Phone [

Connection Type- |
" Dialup 7 AMPS & GSM

" DoCoto  CDMA © Satelite

G5M Cellular Phone Parameters

IME| Humnber: Click 'Get'

[~ PFIM Mumber Required

PIN Number

Phone Programming — Satellite

The satellite phone in the iPack will be active once confirmation is received from the satellite service provider. There are

no phone parameters to program. Clicking “Get” will provide the satellite phone’s IMEI number.
Set Up Phone

| S|
Connection Tupe
" Diaup ( AMPS O et ]| 3=

" DoCobo { CDM& &

Satelite Phone Parameters

ESM /IMEl Mumber:  Click 'Get'

Start Antenna Test

I — |

Phone Programming — CDMA (Verizon)

The CDMA phone in the iPack will be active once confirmation is received from Verizon. Clicking “Get” will provide the
CDMA phone’s electronic serial number. The CDMA phone must be initialized on Verizon’s network by clicking the
“Initialize Phone” button. The CDMA iPack will configure the same way as a wireless card on Verizon’s network (using an
initialization string of *22899). The phone can also be initialized through the logger’s keypad by pressing
[Home][3][4]1[4].
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Set Up Phone X
Connection Type- 1
C Dislp (' AMPS  C GSM e ) Bend

" DoCobo & & O Satellite

COMA Phone Parameters -

ESN Number: Click 'Get
Reqistration String: #25899

Start Antenna Test

For iPackGPS, the initialization is done through the Manual Dial screen, [Home][3]1[4][5]. When entering *22899; in
the Manual Dial screen, use the up arrow to enter a *, use the right arrow key to enter a semi-colon, and then press the
“SET" button on the logger’s keypad.

In order for the iPack to work, the CDMA phone must be initialized (registered) on Verizon’s home network!

The cellular provider that Verizon is partnering with in the "extended coverage area" must support the CDMA IS95 call
protocol and also provide a "modem pool" for the CDMA iPack. To insure a successful installation, we recommend that
you determine who the Verizon partner is in the extended coverage area and contact them to see if they support 1S95
and have a modem pool available. As a result, placing a call from a Verizon handheld phone is not a complete test of a
site's compatibility with a CDMA iPack.

Note that you ALWAYS need to activate the CDMA iPack in a Verizon "home" area network and then bring the unit to the
site. When setting up service with Verizon, find out which system (A or B) the phone will register on for your intended
installation site. When performing an antenna test, if your iPack accesses the other system, your site is likely in an
“extended coverage area.” A manual initialization process may sometimes resolve the issue (contact Renewable NRG
Systems for assistance).

CDMA iPacks with WindLinx are pre-initialized at the factory and therefore do not require this step.

ISP Programming Overview (All iPack types)

You are now ready to enter all of your ISP settings. WindLinx subscribers will be provided this information through the
WindLinx web portal. For non-WindLinx iPacks, the process for programming ISP information is the same for every type
of iPack. You must have all of your ISP information (obtained from your Internet service provider) to program the iPack
and connect to the Internet. The process is much the same as if you were configuring a PC to connect to the Internet.
You may want to ask your company’s IT department for assistance if they regularly configure your computer systems for
Internet access. The programming has been organized into a familiar folder-tab system. The programming will be
discussed tab by tab.

You will want to take extra care during this section. Even a minor typographical error will prevent the iPack from

connecting to the Internet. It is strongly recommended that you get the iPack working before bringing it to the field for
installation!
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Viewing the Pre-Loaded iPack Settings

From SDR'’s Modify iPack Settings window, select File>Load from iPack from the menu. The status line on the bottom
of the screen should show the message “Transferring >>>>>>" followed by the message “Done!” You will now see the

fields populated with information that is currently programmed into your iPack.

Pre-installation Setup: iPack Configuration

' defaultGSM.ipk - Modify iPack Settings S
File Options
Call Schedule | iPackGPS/ACE | Madbus |
Internet Settings ]Email Eonfiguration] Mail Becipients]
Primary 1P Phare Mumber 1*99***1 # L
Prirnary DMS Mumnber ]D. 000 I
Secondary DMNS Nurmber ]D. 0.0.0 |
Authentication Method PaP |
Uzer Mame ] I
Uzer Pazzwornd ] I
AP Mame [GPRS Only] 1your carier's apn [
iPackGPS GSM-3G vE0 detected

ISP Programming — ISP Access Tab

You may edit the pre-loaded iPack configuration (*.ipk file) that is currently being viewed with the information you have
obtained from your ISP by selecting the checkbox to the right of each setting.

Note: The maximum number of characters for each field is 22 for iPacks with firmware version 60 or earlier.

To select all the checkboxes, select Options>Check All.

I defaultGSM.ipk - Modify iPack Settings S5
File Options
Lall Schedule | PackGPSAACC | Modbus |
Intermet Settings ] Email Configuration ] I ail Recipients ]
Primary ISP Phone Hurmber |xggx=¢x~| i v
Prirnary OMS Murnber [nooo [v
Secondary DNS Numnber |D.D.D.EI v
Authentication kethod PaP - [
Uszer Mame | v
User Password | [
APN Name [GFRS Only) [pour carrier's apn [v
! iPackGPS GSM-3G vE0 detected
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All the checkboxes will be checked, and you may now edit each setting. General information regarding each setting is
provided below.

Primary ISP Phone Number
This is the number the iPack will use to dial and access the Internet Service Provider (ISP).

Enter the number with no spaces or dashes.

GSM iPack users with GPRS service will set the ISP phone number to: *99***1#

CDMA iPack users will set the ISP phone number to #777

Satellite iPack users will use the ISP phone number in the default satellite *.ipk file

Check that there are no leading or trailing spaces in your entry.

If you are using a satellite iPack, two leading zeroes are required for the ISP phone number (0088160000603, for
example). This is standard Iridium satellite dialing protocol.

Primary DNS Number and Secondary DNS Number
These are the Domain Name Server entries that the ISP uses.

GPRS, CDMA, and satellite iPack and iPackGPS users will enter primary and secondary DNS numbers of: 0.0.0.0
Enter the numbers with no spaces.

Be sure to enter the decimal points between numbers.

Check that there are no leading or trailing spaces in your entries.

Authentication Method

Symphonie PLUS3 supports both PAP and CHAP authentication methods. Select the authentication method provided by
your ISP.

User Name
This is the account level user name your phone service provider gives you or you select when you sign up for an account.

e Satellite iPack users will typically enter: michmail
GSM iPack users with WindLinx accounts will typically enter: web
GSM iPack users with non-WindLinx accounts will typically enter something like:

ISP@CINGULARGPRS.COM

Web

Internet

movistar

Or something else provided by your GSM service provider.

CDMA iPack users with WindLinx accounts will typically enter: web

CDMA iPack users with Verizon accounts will typically enter the 10 digit Verizon phone number followed by
@vzw3g.com Example: 1111111111@vzw3g.com

Enter it exactly as provided, and do not enter any extra spaces or quotation marks.

Check that there are no leading or trailing spaces in your entry.

For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

User Password

e This is the account level password your phone service provider gave you or you selected.
e Enter it exactly as it is provided to you.
e Satellite iPack users utilizing the michmail service will leave the User Password field blank.
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e GSM iPack users with WindLinx accounts will typically enter: web

e GSM iPack users with non-WindLinx accounts will need to enter the user password provided by their GSM service
provider.
CDMA iPack users with WindLinx accounts will typically enter: web
CDMA iPack users with Verizon accounts will typically enter: vzw

e When you enter your password, it will be displayed as asterisks (*) so it will be secure if someone else reads the
information from the iPack.

e When you read the parameters from the iPack and then save them to the iPack, all parameters, including the
password, are returned unchanged unless the user changes them and then chooses File>Save to iPack.

e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

APN Name (GSM and 3G iPackGPS)
e GSM and 3G iPackGPS users will need to set the APN Name to whatever the provider gives you.
e GSM iPack users with WindLinx accounts will use an APN of: nrg.windlinx.com
e The format may be something like “apn.provider.com.”
e An APN is NOT required for CDMA or Satellite iPacks (leave APN blank).

Once the information on this tab has been edited and double checked, move to the Mail Access tab. More details
regarding programming requirements for specific service providers can be found in the Knowledge Base section of the
Renewable NRG Systems web site.

ISP Programming — Email Configuration

All the checkboxes should still be checked, and you may edit each Mail Access setting. General information regarding each
setting is provided below. Note that the SMTP server setting is used to send the email from the logger and should not be
confused with the POP3 server, which is used to access patch files addressed to the logger and iPack and firmware
updates addressed to the iPackGPS.

Note: The maximum number of characters for each field is 22 for iPacks with firmware version 60 or earlier.

GSM iPack users with GPRS accounts may obtain the SMTP server setting from their GSM service provider but will need to
obtain access to a POP3 server through another provider.

‘I defaultGSM.ipk - Modify iPack Settings [
File QOptions
|5P Infarmation ] Call Schedule | PackGPSAACT | Madbus |
Intermet Settings ] Mail Becipients ]
SMTP Server |y M T Pserver r
by SMTF Server requires authentication & e I
SMTF Login |yourUselname@yourSMTF‘ r
SMTP Pazaword | I
POP3 Server [pauPOPS erver r
Mailbox Mame |Iogg|3l emall addrezz r
ailbox Password | r
Internet Time Server [iwmere. st o r
| I
iPackGPS G5M-3G B0 detected

e —
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SMTP Server Name

This is the SMTP server name that your ISP will provide and/or you can find on your ISP’s web site. It is used to send
mail from the logger. GSM iPack users with GPRS service will need to get the SMTP server name from the cellular service
provider rather than from an ISP. CDMA iPack users utilizing packet switched connections (1xRTT) will need to make sure
that the SMTP server is authenticated.
e Enter it exactly as your ISP provided.
WindLinx users will use an SMTP server name of: smtp.packet-mail.net
Do not enter any extra spaces or quotation marks.
Check that there are no leading or trailing spaces in your entry.
Non-WindLinx users will enter an SMTP Server name that looks something like:
smtp.myisp.com
smtpauth.myisp.net
e The SMTP port can be configured on the “iPackGPS/ACC tab”.
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

My SMTP Server requires authentication

Some SMTP servers require a login and password before allowing you to send mail. If the SMTP server does not require
authentication, select “"No.” If your ISP requires SMTP server authentication, select “Yes” and enter the SMTP login and
password. WindLinx requires SMTP Server authentication. The formats are often identical to those of the mailbox nhame
and password. However, check with your ISP if you are unsure. Please note that CDMA iPack users will need to use an
authenticated SMTP server.

POP3 Server Name

This is the name of the POP3 server that your ISP will provide and/or you can find on your ISP’s web site.
e Enter it exactly as your ISP provided, and do not enter any extra spaces or quotation marks.

Check that there are no leading or trailing spaces in your entry.

WindLinx users will use a POP3 server name of: pop3.packet-mail.net

Non-WindLinx users will enter a POP3 Server name that looks something like:
pop.myisp.com
mail.myisp.net

The POP3 port can be configured on the “iPackGPS/ACC tab".

For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

Mailbox Name
This is the mailbox account name your ISP provided or you selected when you set up your email account for the iPack.

e This is the mailbox account name on the POP3 server that the logger points to in order to retrieve mail (patch files,
for example).
Enter it exactly as your ISP provided.
Do not enter any extra spaces or quotation marks.
Check that there are no leading or trailing spaces in your entry.
It should be something like:
Logger
7345552555
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

Mailbox Password
This is the mailbox password your ISP provided or you selected that allows access to your mailbox.

e Enter it exactly as it is provided to you.
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e When you enter your password, it will be displayed as asterisks (*) so it will be secure if someone else reads the
information from the iPack.

e When you read the parameters from the iPack and then save them to the iPack, all parameters, including the
mailbox password, are returned unchanged unless the user changes them and then chooses File>Save to iPack.

e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

Internet Time Server Name

e As part of the iPack’s calling routine, it gets the current time (in UTC) from the Internet and updates the
Symphonie PLUS3's clock.
e The user must enter a local time server for the iPack to use.
o NOTE: for standard iPacks (rev 40 and older) the local time server must be compliant with RFC 868 time
servers that respond to requests on port 37. There are many on the Internet, and your ISP may be able to
suggest one that is RFC 868 compliant. The iPackGPS (rev 50 and newer) uses SNTP protocol on port 123
o Enter the time server name exactly as provided, and do not enter any extra spaces or quotation marks.
e Check that there are no leading or trailing spaces in your entry.
e Be sure to include the decimal points in the name.
e WindLinx users will use an Internet Time Server Name of: time.packet-mail.net
e For non-WindLinx users, this entry should look something like one of the following:
wwv.nist.gov
nistl-atl.ustiming.org
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

Once the information on this tab has been edited and double checked, move to the E-Mail Info tab.

ISP Programming — Mail Recipients

All the checkboxes should still be checked, and you may edit each Email Info setting. General information regarding each
setting is provided below.

Note: The maximum number of characters for each field is 22 for iPacks with firmware version 60 or earlier.
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“I" defaultGSM.ipk - Modify iPack Settings [
File Options

ISP Information | Call Schedule | PackGPS ACT | Modbus |

Internet Settings] Email Configuration  Mail Becipients l

Recipient's E-Mail Address |Jmphonie_data@nrgs_l,lstems.c:um v
Recipient's Mame |test datd v
CC E-Mail Address | v
CC E-Mail Address 2 | v
Sender's E-Mail Address |lngaer email address v
E-Mail Subject Line |Symphonie Dats from site s W
Patch pasgwaord 123455745 v

iPackGPS GSM-3G vE0 detected

Recipient’s E-Mail Address
This is the primary e-mail address where the Symphonie PLUS3's iPack is going to send the data.

This can be your e-mail at work.
Enter it exactly as your ISP provided.
Do not enter any extra spaces or quotation marks.
Check that there are no leading or trailing spaces in your entry.
It should look something like:
jsmith@mycompany.com
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

Recipient’'s Name
This field is the text portion of the e-mail address.

e If you look at an e-mail in your in-box, it will have the “To” item as something like, “John Smith”
<jsmith@mycompany.com>.
e This entry is the “John Smith” portion of the recipient’s e-mail address.
This field is optional but is useful if someone has to sort through incoming emails.
It could look something like:
John Smith
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

CC E-Mail Address

This is an additional e-mail address where the Symphonie PLUS3"s iPack is going to send the data. For iPacks with
firmware version 60 or earlier, the maximum number of characters for this field is 22.
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CC E-Mail Address 2

This is also an additional e-mail address where the Symphonie PLUS3's iPack is going to send the data. For iPacks with
firmware version 60 or earlier, the maximum number of characters for this field is 22.

Sender’s E-Mail Address

This is the e-mail address that will appear in the “from” of the emails being sent to the recipient’s email address from the
iPack. It is often identical to the Mailbox Name plus the “@myisp.com” part of the email address. However, the Sender’s
E-Mail Address is NOT necessarily the address to which patch files should be sent.

e Do not enter any extra spaces or quotation marks.
e Check that there are no leading or trailing spaces in your entry.
e It should look something like:
logger@mycompany.com
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

E-Mail Subject Line

This entry will become the subject line of the e-mail that you receive from the iPack and may contain letters, numbers
and other symbols.

e Itis typically a description of the logger that will be calling.
e It should look something like:
Site 1234 — Derry Mountain
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

Patch Password
The patch password is a security measure that protects your data logger from unwanted or accidental patching.

e Enter a patch password — do not leave blank.

Once the information on this tab has been edited and double checked, move to the Call Schedule tab.
e For iPacks with firmware version 60 or earlier, the maximum number of characters for this field is 22.

Call Schedule Programming — Call Schedule Tab
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“|” defaultGSM.ipk - Modify iPack Settings LX)
Eile Options

ISP Information  Call Schedule l iEackGF'S.-’ACC] Modbus]

[v Include in Change

Mext Call Time
| 90B00PM = | Fridey . August 152014 |

Call Interal
| 7 Minz
1 " Haurs

* Daps

[

[
| iPackGPS GSM-3G +E0 detected

Next Call Time and Call Interval
These entries give the iPack a first time to call and how often to call thereafter.

The Next Call Time entry can actually be in the past, but the logger will initiate its call schedule calculations using
this entry as a starting time. Using the Next Call Time and date entered in this screen, the logger calculates the
next possible time to call.

This combination is used to force iPacks to call at specific times during the day or week.

If you want an iPack to call daily at 6:45am, set the next call time to any day at 6:45am and the call interval to 1
day.

If you want an iPack to call every 2 days at 7:30pm starting tomorrow, then set the next call time and date to
tomorrow at 7:30pm and the call interval to 2 days.

If you set the next call time to a week from now and set the call interval to 1 day, the iPack will not wait until next
week to call but will immediately start calling daily at the time specified in the next call time field.

You can determine when the iPack will make the first call by taking the difference between the scheduled call time
and the current time, dividing the total time by the call interval and work your way backwards (or forwards) from
the “next scheduled call time” by subtracting (or adding) the call interval from the “next scheduled call time.”
Notice that if the call interval is less than the amount of time between the current time and the “next scheduled call
time”, the iPack will call before the next scheduled call time.

iPack GPS users can enter a 10-minute call interval; more frequent call intervals are not supported.

Due to increased phone power requirements and potential problems with overlapping phone calls, use caution when
choosing a multiple daily call schedule.

Setting iPack Preferences — iPackGPS/ACC Tab (iPackGPS only)

This screen provides access to new features of the iPackGPS unavailable in previous iPack versions, such as the ability to
set SMTP and POP3 ports.
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. .
“I defaultGSM.ipk - Modify iPack Settings 5

File Options

15F Information ] LCall Schedule

Settings l Actions ]

Download partial files * Ye: Mo 2
Check POP mailbox  Yex (" Mo v
Enable SMTP & Yes 7 Mo v
POP Port e ¥
SMTP Port ’25— v

Thesge zettings can be zaved to any ipk file, but will only take effect
when downloaded into an iPackGPSAACCESS unit.

PackGPS GSM-3G vE0 detected
Settings (SMTP, POP3 ports, etc.)

Like all other screens in the Modify iPack Settings window, once you have made a change, you must go to File and
choose Save to iPack.

e SMTP and POP3 port settings allow a user to select specific ports when communicating with these servers. For
example, some SMTP servers are no longer responding to port 25 (Brazil), and port 587 should be used instead
(be certain to ask your provider).

¢ The “"Download partial files” setting allows the user to toggle on and off downloading of partial files.

e A partial file” refers to a file that includes less than 24 hours of data, typically from midnight up until the iPack’s
scheduled call time.

e Disabling the downloading of partial files and checking of POP3 can reduce air time. However, this is generally
not recommended for remote sites.

e If POP3 checking is disabled, the iPack will not be able to receive patches or firmware updates until the setting is
changed via a direct connection to SDR.

- y
‘]’ defaultGSM.ipk - Modify iPack Settings =

File Options

5P Information ] LCall Schedule

Settings ] Actions ]

Diownload partial files * ez Mo v
Check POP mailbox ™ Ye: (* No [
Enable SMTP @ Yez Mo v
POP Part [110 [w
SHMTF Part |5a7 [w

These settings can be saved to any ipk file, but will only take effect
when downloaded into an iPackGPSAACCESS unit.

W arhing: turning off POP checking will prevent the iPack from being
able to receive configuration patches or remote firmware upgrades!

iPackGPS G5M-3G v60 detected
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Actions (firmware updates, extract events, etc.)

e iPack battery voltage and voltages from various locations on the iPack’s circuit board are displayed here when
the Get Voltages button is clicked.

e iPackGPS firmware version can be updated via SDR and the iPack programming cable using the Firmware
Upload button.

e Alink to the site used for remote firmware updates is also displayed on this screen.

e The iPackGPS event log will show "UPDATE_DOWNLOAD_EVT” and “"UPDATE_APPLY_EVT" to help track the
installation of the new firmware.

e Remote firmware updates for some iPackGPS types (satellite) will be completed over the course of several calls.

e Firmware updates via SDR and the iPack programming cable are completed in a few seconds.

‘I’ defaultGSM.ipk - Modify iPack Settings [
File Options

15F Information] Call Schedule  iPackGPS/ACC lMDdbus]

2% alt Supply:
Get Voltages
3.3%ol Supply:
| 5%alt Supply:
Extract Event Log
1 12wl Batteny:

Firrmware upload |

These features will only work on an iPackGPS/ACCESS unitl

To perfarm remate firmware updates, go to:
hittpe Ao rerewablenngsystems. comtechnical-support/software

iPackGPS GSM-3G vEB0 detected

S

Saving the iPack Displayed Setup to the connected iPack

After editing the parameters on the screen, save the changed parameters to the iPack by selecting File>Save to iPack.
This will download all of the checked settings to the attached iPack. On the lower left of the Modify iPack Settings window
you should see the message “Transferring>>>>>>" and then “Done!” You've now completed programming the iPack.

Saving a copy of the iPack File (.ipk) to your computer

Save a copy of the iPack settings by selecting File>Load from iPack. This will load the current iPack configuration to
your computer screen. Then choose File>Save iPack File. This will save a copy of the iPack configuration (*.ipk file) to
your computer. Remember to send a copy of the iPack file to your site management team — it is important to keep the
*.ipk file safe!
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21|

Save in | sdr | eEekEr

=] defaulth mps.ipk
] defaltDialup.ipk
=] defavitGsM.ipk
=] jack.ipk

] jackh.ipk

] testg.ipk

Save

[ s |
Cancel |
7

File name I

Lef Lef

Sawve as type IiPackf\Ies (*ipk)
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Opening a Saved iPack File (.ipk)

From the Modify iPack Settings Window, select File>Open iPack File. In the future, you may want to open a saved
iPack file, edit the settings and then send it back to the iPack. You can also do this to check the saved iPack file.

2]x
Laook jn: Iﬁsdr j - & B
sldefauitimps.ipk.
8] clefasitDialup.ipk
o8] cefaLitGSM ik
e8] jack ipk.
=] jackn.ipk
(=] testg.ipk
File name: I j Open I
Files of type: I\Packﬂ\es *ipk) LI Cancel

7|
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Office Testing

Why It’s Important

Office testing your SymphoniePLUS3 system prior to installation in the field will save you time and money. Internet access
capabilities rely on perfect coordination between iPack, cellular phone, and ISP settings — if these are not set up correctly,
the system will not work. Troubleshooting is much easier in the comfort of your office than in the field, in foul weather,
with a crackling, intermittent handheld cellular phone connection as your only lifeline to civilization. It is likely that if you
experience communication problems, you will need to contact your cellular account representative or your ISP to resolve
the problem.

During office testing, be sure to fill out Data Sheet forms (found in Appendices) with setup parameters. A copy of these
forms should be made for field personnel so setup parameters are readily available.

What You’ll Need

If you haven't done so already, read the rest of this manual, paying particular attention to the chapter covering
SymphoniePLUS3 Start-up. If you are ready to begin office testing your Symphonie PLUS3 system, you should have
already completed the tasks found in the chapters Pre-Installation Setup: Logger Configuration, Pre-Installation Setup:
fPack Accounts, and Pre-Installation Setup: iPack Configuration. You'll also need a few test sensors with cables, the field
wiring panel and related hardware, an SD card, the antenna(s) included with your iPack or iPackGPS, a Phillips head (+)
screwdriver, and a computer running the latest version of Symphonie Data Retriever Software.

Installing the iPack to the Logger (iPack users only)

Connect the antenna to the iPack. GSM iPackGPS and CDMA iPackGPS users will also connect the GPS antenna. Carefully
set the iPack (connector facing up) flat on a table, preferably on an anti-static mat. Connect an earth ground to the
logger’s ground lug. Place the logger (connector facing down) over the iPack and mate the two units together, and
connect the iPack’s ground wire to the logger’s ground lug. While mated, handle the units with care. While performing
office tests, it is recommended that you connect a 15 V DC regulated and fused adapter to the iPack PV input to
prevent draining the batteries during testing. However, this is necessary only if initiating more than 5 calls.

Note that a cold boot call can be triggered when an iPack is initially connected to the logger. During a call, the Call Now,
Antenna Test, and iPack programming features are unavailable, but all other logger programming functions are available.
The iPackGPS allows further navigation to iPackGPS menus and logger menus while a call is in progress. If no D-cells are
installed in the logger and then the logger is plugged onto the iPack, the iPack provides auxiliary power to the logger and
therefore powers it up regardless of the lack of D-cells. The iPack will then dial the ISP to transfer data, and the iPack
status screen will indicate that a call is being made (“iPack busy or not present”, or in the case of iPackGPS, a sequence
of status screens such as “checking for file”, “detecting GSM band”, “connecting modem”, etc.). However, if you have
already completed the logger programming in the Pre-installation Setup: Logger Configuration chapter, the logger
batteries are already installed, so attachment of the iPack will not initiate the automatic call.

Pre-Installation Testing

To test before installing in the field, do the following:
1) If using an iPack or iPackGPS, connect it to the logger as described above.

SymphoniePLUS3_Data_Logger_Manual | Rev16 19 November 2015 | support@renewablenrgsystems.com || 61


mailto:support@renewablenrgsystems.com

Office Testing

2) Check logger status (battery voltage, date, time, internal temperature, revision numbers).
3) Connect the wiring panel according to instructions in the Field Installation chapter.

4) Connect the test sensor(s) and verify logger programming of each input channel.

5) Install and format SD card.

6) Check SD status (logging, files stored, days left).

7) Check iPack status (if present), noting the iPack battery voltage.

8) Verify cellular signal strength with the antenna test.

9) Verify iPack communications by performing a Call Now.

10) Verify that the *.rwd files are successfully received by the intended recipient(s).

For detailed instructions on performing these tests, refer to the chapter on SymphoniePLUS3 Start-Up.

Recharging the iPack Battery

Under normal use, the iPack battery will stay charged through an installed 15 Watt 12 V photovoltaic (PV) panel.
However, the iPack battery must be fully charged before field installation. Connect a regulated and fused 15 V DC
source to the PV input of the iPack. The iPack’s charging circuit will draw a maximum of 750 mA (earlier iPacks will draw a
maximum of 500 mA). A completely discharged battery can be recharged in about 6 hours with such an adapter. An iPack
charger is available from Renewable NRG Systems (item #3615).

After completing tests, you may want to pre-assemble the logger and iPack in the logger’s shelter box. This can simplify
the transport of the equipment and save time. See the Field Installation chapter for detailed instructions.

The iPack has two sets of terminals. When recharging the iPack battery, you MUST use the PV terminals; do not use the

12 V external battery terminals. For more information about these terminals, see the following sections regarding
connecting a PV panel to the iPack.
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Tools Required

diagonal wire cutters to trim sensor wire leads

wire strippers to strip sensor cables if hecessary

7/16 inch nut driver or wrench for installing optional yagi antenna
5/16 inch nut driver for hose clamps, mounting screws (PV and logger)
2 inch crescent wrench to tighten ground acorn nut

Y4 inch nut driver for sensor terminals

3/8 inch nut driver or wrench for ground stud nut

electrical tape

small flat blade RNRG screwdriver (included with logger) for sensor wires
Phillips head screw driver for PV terminals

5/16 inch open end wrench

drill to tighten hose clamps - optional

tin snips to cut excess hose clamp - optional

Site Grounding Recommendations

For many sites, the Renewable NRG Systems Grounding Kit provides all the needed parts to earth ground your
TallTower™ and instrumentation. The Grounding Kit includes a copper-clad lightning spike, copper ground wire, and two
copper-clad ground rods. It is recommended that you determine the soil type of your site and classify its resistivity.

The lower the resistivity, the better the earth ground is.

Soil Type Average Soil Resistivity per cm (Ohms/cm)
1. ashes, cinders, brine, waste 2370

2. Clay, shale, gumbo, loam 4060

3. Same, with varying proportions of sand and gravel 15800

4. Gravel, sand, stones with little clay or loam 94000

The Renewable NRG Systems Grounding Kit will perform adequately in type 1 and 2 soils. For other soil types, or for sites
with a high incidence of lightning, you will need to augment the earth grounding system.

The best approach to grounding will depend on the soil type in your area. Soil resistivity is directly related to moisture
content AND temperature. The colder it gets, the higher the resistivity will be for a specific moisture content. Any
moisture content below 20% quickly increases ground resistivity exponentially to dangerous levels. In most climates,
moisture content and soil temperature change seasonally. During times of the year when the soil is very dry or very cold,
soil resistivity is at its highest, and getting a good ground is more difficult. Keep this in mind when evaluating your site -
it's better to put in too much grounding than not enough.

You may want to consult a local utility regarding grounding techniques they've successfully used in the site area.
e Use longer ground rods, and/or install additional rods.
e Cut the logger’s ground wire to the required length; do not roll or coil any excess length of ground wire.
e Additional contact surface helps, and soil conductivity improves with depth. If multiple rods are used, they must
be installed far enough away from each other [at least 2 meters (6 feet)] so that each rod's effective resistance
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area does not overlap.

Use high compression fittings at all conductor/rod connections.

Ensure that the single strand, bare copper conductor is 10 gauge.

Ensure that the grounding rod(s) is free from non-conducting coatings such as paint or enamel.

Wire all grounding rods together to provide electrical continuity.

Where rock is encountered, drive the ground rod at a 45 degree angle, or bury it in a trench at least 0.6 m (2

feet) deep (deeper is better; the key is to maximize the soil contact area).

e Protect the above-soil end of the rod and its electrical conductor attachment against damage. Where the soil can
become frozen, drive grounding rods below the frost line.

e Apply an anti-oxidation agent to all grounding connections.

Installing a Stand Alone SymphoniePLUS3 Logger

To install a stand alone Symphonie PLUS3 logger (no iPack), insert 10-32 x 2 inch mounting bolts through the mounting
holes in the back of the shelter box, and then align with the threaded mounting holes in the back of the logger and
tighten. You may now skip the instructions related to iPack installation and proceed to the instructions for Mounting the
Shelter Box to the Tower.

= r—

™.

Mounting the iPack and Logger to the Shelter Box

Prior to mounting to a Renewable NRG Systems TallTower, the Symphonie PLUS3 logger and iPack should first be installed
in a shelter box to protect the unit from the elements. You may find it easier to remove the cover of the shelter box prior
to attaching the logger, iPack, or PV panel.

SymphoniePLUS3_Data_Logger_Manual | Rev16 19 November 2015 | support@renewablenrgsystems.com || 64


mailto:support@renewablenrgsystems.com

Field Installation

N

Removing protective sticker from Logger
When ready to install the iPack to the logger, remove the protective water resistant sticker from the back of the logger.

Inserting Screws into Shelter Box

Continue installation of the shelter box according to the following instructions. Mounting holes are pre-drilled in the
optional SymphoniePLUS3 shelter box. To install a Symphonie PLUS3 with an iPack, insert four 10-32 x 2 2 inches
mounting bolts through the mounting holes in the back of the shelter box, through the iPack, and then align with the
threaded mounting holes in the back of the logger and tighten.

Mounting inside the Shelter Box

If your shelter box has keyhole slots, insert the mounting bolts through the iPack and logger assembly and screw them in
until they are about 1 cm away from the back of the iPack. The Symphonie PLUS3 and iPack can be hung in the shelter
box by inserting the mounting screws in the keyhole slots. The mounting screws can then be tightened from the back of
the shelter box.

SymphoniePLUS3_Data_Logger_Manual | Rev16 19 November 2015 | support@renewablenrgsystems.com || 65


mailto:support@renewablenrgsystems.com

Field Installation

2
*
L
-
.
s
»
»
3
.
:
>
s
)
»
.
.
»
.
»

Connecting the iPack Ground Wire to the Logger

If you haven't done so already, connect the iPack’s green/yellow striped ground wire to the logger’s ground stud. To do

this, remove the nut and lock washer from the logger ground stud, place the ground wire lug from the iPack over the
logger ground stud, replace the lock washer and nut; tighten the nut.

+ + 1=
12V Ext. Bat
15.28V 2| 14V MAX

Installing the optional PV panel (iPack users only)

Inside the PV panel carton you will find a PV panel and four screws. Remove the five plastic plugs from the
Symphonie PLUS3 shelter box door.
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Read the back of the PV panel and note the polarity of the wires. Feed the PV panel wire through the center hole in the
shelter box door, and then secure the PV to the shelter box door with the four mounting screws.

Feed any excess PV wire back into the hole behind the PV panel. Connect the PV wires with the polarity that you noted to
the iPack PV input screw terminals located on the right side of the iPack. Shade the PV panel from direct sunlight while
wires are being connected to avoid sparks.
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Connecting the PV Panel and/or External Battery Wires

The iPack has an extra set of terminals that allow for connection of an external 12 V DC power source such as a battery
in addition to the PV panel. There are some basic rules for these terminals as described below.

/\ IMPORTANT USER NOTE /\

The battery contained in this product was fully charged before
leaving the factory. Depending on time in transit and other
factors, when this package is opened the battery will need to
be charged before deployment.

READ THE USER MANUAL

for battery charging instructions!
Failure to maintain the battery will have
negative iPack performance consequences.

To charge use a DC source from 15 to 28V.
External battery is NOT charged from iPack.

Field Installation

S e &
PV 12V Ext. Bat| .~
Connect
15..28V == | 14V MAX | to Logger

Connection Point |Do

Do NOT

Functional Notes

PV Terminals

Do...connect PV panels, DC power
sources between 14 and 28 V DC

Do NOT...connect power sources in
excess of 28 V DC, including large PV
panels

IThe PV terminals will charge the iPack’s
internal battery; The PV terminals will NOT
charge an external battery.

External Battery
Terminals

Do...connect 12 V battery and/or
external charge controller up to 14.3 V
DC

Do NOT...connect PV panel or power
sources in excess of 14.3 V DC

IThe external battery terminals are an input
only, an external battery will NOT be
charged from the iPack through these
terminals nor will the internal iPack battery.

Ground Terminal

Do...connect to logger ground stud and
trim ground wire to the required length.

Do NOT...leave disconnected or connect
other wires such as shields; do NOT coil
or roll excess ground wire.

[This terminal will help provide protection
from electrostatic discharge for the iPack

and logger.

Mounting the Shelter Box to the Tower

The Symphonie PLUS3 shelter box is mounted to the tower 1.5 to 2.0 meters (5 to 6 feet) above the ground (or above the
maximum height of the annual snowfall) using the two stainless steel hose clamps (provided).
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Trimming the Hose Clamps

The hose clamps are long enough to mount the shelter box to towers up 10 inches (25 cm) diameter. If your tower is a
smaller diameter, it will speed up the installation to trial fit the clamps to your tower and trim them to length. Place your
hand between the tower and the clamp to allow for the logger. Trim off the excess hose clamp material using a pair of tin
snips. Be careful not to cut off too much. Note that if you have a drill on site, it may not be necessary to trim the hose
clamps.

Mounting Technique
Mount the logger and shelter box to the tower using the hose clamps. Thread the hose clamps through the slots in the

back of the shelter box from the inside. It is best to pass the end of the hose clamp through the right slot first (as viewed
from inside the enclosure), then around the tower, and back through the left slot, since this will provide easier access
when tightening the hose clamp. Connect the logger ground wire to the ground rod at the base of the tower, passing the
ground wire into the shelter box through either the lower wire slot or through one of the upper wire knockouts. Trim the
logger ground wire to the required length; do not coil or roll excess ground wire.
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Field Wiring Panel

All sensor wires connect to the field wiring panel. Please note that the SymphoniePLUS3, SymphoniePLUS, and
Symphonie wiring panels are NOT interchangeable.

Front of Wiring Panel Back of Wiring Panel

The field wiring panel connects to the 62 pin connector on the side of the logger and is held in place by the ground nut
and a mounting screw. If you haven't done so already, connect the logger ground wire to earth ground.

Connect the logger ground wire to the earth ground rod before connecting any sensors!

To install the field wiring panel, remove the warning label from the logger’s ground stud. Then touch the ground wire to
the wiring panel’s ground lug and the logger’s ground stud. This will safely discharge any electrostatic build-up that could
damage your logger. Slide the ground wire over the logger’s ground stud. Connect the wiring panel by gently pushing it
securely onto the logger’s 62-pin connector. Finally, secure the ground wire with the washer and nut on the ground stud
(as shown below) and tightening the wiring panel’s mounting screw until the wiring panel and ground wire are secure.
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Note that the field wiring panel mounts over the grund/ng stud and can be removed from the logger without having to
disconnect the sensor wires. This is particularly useful in the event a logger needs to be swapped out for service.

Sensor Connection
Make sure that the logger ground wire is connected to the earth ground rod before connecting sensor wires!

Pass sensor wires into the shelter box, either through the lower wire slot or through one of the upper wire knockouts.

All wires coming down the tower and into the shelter box should be secured to the tower below the shelter-box
and then brought back up, to form a drip-loop, before entering the shelter-box.

Sensor wires should be stripped to expose only 5 mm (1/4 inch) of bare wire. Stripping off more insulation
could allow the wires to touch and cause an electrical short. If using standard Renewable NRG Systems sensor
cables, you may need to trim off some of the exposed wire.

NOTE . The nuts on the wiring terminals of the #200P and #40C sensors should only be tightened until secure.
Over tightening will snap the terminals off of the sensors and will not be covered under warranty.

Wiring Sequence
Make sure that the logger ground wire is connected to the earth ground rod before connecting sensor wires!

NOTE: Connecting sensors to the back terminals first may be easier in terms of installation. Sequence: (9-12, 7-8, 15, 4-
6, 1-3, 13-14).

Connect sensor wires to the field wiring panel according to the Sensor Connections diagram (see below) using the
following sequence:

Touch the shield wire to the ground stud, and then connect it to the SHD (shield) terminal.
Connect the black wire of the sensor to the “GND” terminal of the appropriate channel’s input.
Connect the signal (white or clear) wire to the “SIG” (signal input) terminal.

SIS

For three terminal devices ONLY (such as vanes or anemometers requiring 12 V power), connect the red wire
(excitation/power) to the “EXC” terminal.
5. Confirm correct wiring by reviewing each sensor channel on the logger’s display.
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Coat the wiring panel’s terminal screws with an anti-corrosive product (such as PreservelT P100L from Caig Labs
or Vaseline petroleum jelly).

Systems that include an iPack will be on as soon as the iPack is connected and supplying power to the logger. For
systems without an iPack, install the D-cells now as described in the Logger Setup section of this manual.
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Sensor Connections

NRG #40C / NRG Class 1 Anemometer NRG #200P Wind Direction Vane Model 110S Temperature Sensor BP-20 Barometric Pressure Sensor
(Digital Only) (Analog Ch. 7 & 8 only) (Analog only) (Analog or Flex)

Sensor Logger Sensor Logger Sensor Logger Sensor Logger
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Antenna Connection

After connecting sensors to the field wiring panel, connect the iPack antenna and GPS antenna (for iPackGPS). Mount the
GPS antenna to the top of the shelter box (outside).

Satellite iPacks S/N: 35333300 and above have an SMA type antenna connector; older satellite iPacks have a TNC type
antenna connector, so if you need to replace the older antenna or iPack, you will need an adapter.

Be sure to form a drip-loop with the antenna cables to protect the iPack from water that may get inside the cable jacket.

You may now proceed to the next chapter, SymphoniePLUS3 Start-up, to complete the installation process.
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SymphoniePLUS3 Start-up

At this point, you should have already completed the tasks described in the Pre-Installation Setup: Logger Configuration
chapter (all users). If using an iPack, you will also need to have completed the tasks in Pre-Installation Setup. iPack
Accounts and Pre-Installation Setup.: iPack Configuration.

Pressing any key will activate the logger display.

NRG Systems, Inc.
SymphoniePLUS3
SN: 00000

Press [HOME]

Pressing the [Home] key at any time will always bring you back to the home menu of SymphoniePLUS3.

Measurements
Status
Utilities
Settings

el NS>

It is recommended that the user check the logger functions in the order presented in this section.

Checking logger status (battery, date and time, internal temperature, revision)
[Home][2] = Status Menu

Logger Status
Mem Card Status
iPack Status
Event Log

PONPE

The Status menu allows the user to check current operating status of the SymphoniePLUS3 data logger system.

[Home][2][1] = Logger Status Screen

14 Apr 2002 14:02:50

Batt 1.19V REPLACE
Site:0150 Temp -10C
Revision: 26, 27, 53

The message Waiting for update should display for a few seconds. The logger status screen displays current date and time
in Standard Time (remember that this may appear one hour off during daylight savings time). It also displays current
logger battery voltage and condition (Good, Fair, or Replace) as well as the firmware revision levels of the logger and
iPack.
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Checking logger measurements (all 15 channels)

Press [Home][1], then scroll using [Down] to see each sensor’s current readings. Readings that vary widely with
expected norms may indicate a sensor malfunction, incorrect channel configuration, or incorrect wiring. If a channel
number displays no information, it means there is no SCM currently installed for that channel and it is therefore inactive.

Installing the SD Card

Place a new SD card in the SD card slot with the beveled front corner down. Note that the card cannot be inserted
backwards. If the SD was not the last SD formatted by this logger the following message will display:

Initializing SD Card
Please wait...

Formatting the SD Card

Formatting the SD card may take up to 60 seconds and will beep every few seconds, after which a Format complete
message will briefly display before changing to the Home menu.

If an SD does not format after the first attempt, it could indicate a damaged or corrupted SD card. Always have spare
cards available.

When the logger writes data to the SD card, it beeps to warn you that the card is active.

7o be sure that all the data files have been transferred, do not remove the card until five seconds have passed
since the last beep.

Since the logger is always storing data to its internal non-volatile memory, there will be several data files created during
installation. These files will be written to the card as soon as formatting is complete. The logger’s internal memory stores
the most recent 1.5 days.

The data files created during installation may have incorrect readings because sensors were being connected
during these intervals. As part of your site data, note the date and time of the start of logging with your
completed connections and settings.

[Home][3][1] = Erase RWD Files, are you sure?

All RWD Data Files will be erased!
Are you sure ??
Press [9] to Erase

[Home] aborts the formatting function and returns home. Data will not be recorded onto an unformatted SD.

Checking SD status (logging, files stored, days left)
[Home][2][2] = Memory Card Status Screen

Card In, or Card Out
Card Inserted Please Insert
Logging another card

3 Files Stored
665 Days Left

Memory card status displays the number of files stored on the SD card, as well as the number of days remaining until the
card is full. The Symphonie PLUS3 data logger emits a beep when it writes to the SD card. 7he process of writing to the
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card takes about two seconds, so should the unit beep just as the card is about to be changed, wait until five seconds
have passed before pulling the card.
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Checking iPack status (if present)
[Home][2][3] = iPack Status Screen

Call Now

Modem Status
GPS Status

iPack Event Log *

b

If an iPack is attached to the Symphonie PLUS3, the status screen will display the above menu.

If an iPackGPS is not connected, then “No iPack present” will be displayed. The + symbol will alternate with the * symbol
during an antenna test to indicate the iPackGPS is on. [Home][3][4][2] will show the iPackGPS’s live Modem Status page
which displays the model of iPack in use, the revision level, the next scheduled call, and the status of the last operation
performed.

iPackGPS v50 GSM
Registered Roaming
Sched: 8 Feb 15:15
Batt: 12.8 Ant: 79% +

Checking iPack Battery Voltage from the logger

You can check the voltage of the iPack internal 12 V battery from the logger. Go to [Home][3][4][2] for iPackGPS or
[Home][3][4] for older iPacks. If you want to continuously monitor iPack voltage, there is an SCM available (Item
#3585) specifically for this purpose. When installed in one of the logger’s analog or flex channels, the iPack voltage SCM
will provide an iPack voltage reading for each 10-minute averaging interval.

Verifying Signal Strength and Connection Status
A connection status function has been built in to determine received signal strength and connection quality while on site.

Alternatively, the signal strength can be performed by directly connecting the iPack to a computer and running the
“Antenna Test” from the SDR software. Older GSM iPack antenna tests using SDR will give a Signal Strength value
between 0 and 31, followed by a Bit Error Rate value between 0 and 7. GSM iPackGPS, CDMA iPacks and satellite iPacks
will all display Signal Strength as a percentage.

Note that signal strength found on a fair weather day is optimistic, and local conditions can dramatically affect connection
reliability. Cell radio signals are weakened by local cellular traffic, rain, and even high humidity in the signal path.

To check signal and connection status, press [Home][3][4]. Wait for the menu to change while the iPack powers up.
Then press [2]. A message will tell you if service is available and will display the strength of the signal as a percentage.
In this screen, additional detail such as cellular band and carrier are also available.

To view:

IP address, press [1]
DNS1, press [2]

DNS2, press [3]

Cellular Band, press [7]
Cellular Carrier, press [8]

For example, pressing [Home][3][4], wait, [2], [8] on an iPackGPS will bring up the screen:
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iPackGPS v60 3G
Registered Roaming
AT&T

Batt: 12.8 Ant: 75% +

Older iPacks (pre-GPS model) do not have the additional detail available and will display:

iPack/GSM Cellular
Rev 9

RSSI: 24 BER: 2
REGISTERED (HOME)

GSM iPacks (s/n 38607905 and earlier):

RSSI (RECEIVED SIGNAL STRENGTH Status

INDICATOR):

24t031  (75% to 100%) Good (31 is best).

9to 23 (30% to 75%) On the edge. It may miss calls, especially on foul weather
days.

0to8 (less than 30%) May not even get service.

99 0% No signal.

BER (BIT ERROR RATE): Status

Oto2 Good (0 is best).

3to7 May not even get service.

99 No signal.

Not searching Not registered and not searching

Registered (Home) Registered on the home network

Searching Not registered, searching

Registration denied Recognized but service denied — call provider.

Unknown Call provider.

Registered (Roaming) Registered on different provider’s network.

Satellite iPack:

The satellite iPack antenna test will provide results ranging from 0 to 100% in increments of 20%. A result of 100%
indicates optimal signal strength, and a result of 50% indicates only fair signal strength.

An antenna mounting boom is included with each satellite iPack. However, the satellite antenna easily mounts to any
boom with a terminal end of 34” IPT. The threaded 34" IPT socket of the antenna will screw onto the end of the boom.
Installation considerations include:
e The antenna MUST have a clear view to the satellite at ALL TIMES.
e Any obstructions can cause an interruption between the communications of the iPack and the satellite and could
cause the data call to be terminated before complete.
e The antenna must be upright/facing the sky to ensure maximum exposure.
The antenna must be located so that it has a good view of the sky, ideally horizon-to-horizon coverage.
The antenna should be mounted so that it is away from structures by a distance of at least 0.5 meters. The
Renewable NRG Systems mounting boom meets this requirement.
e The satellites fly in a South-to-North orbit; the antenna must be mounted such that no obstructions occur in this
plane. We suggest orienting the antenna South in the northern hemisphere, and North in the southern
hemisphere.
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An antenna test should be performed on the satellite iPack once it is attached to the logger. Go to iPack Utilities from the
Symphonie PLUS3 logger main menu to perform this function (iPackGPS users will choose [2] Modem Status to perform an
antenna test). Signal strength is reported from 0% to 100% and may fluctuate depending on site conditions. If a value
other than 0% is returned, the user can try to establish a call. A value of 0% indicates that no direct connection has been
established between the antenna and the satellite. Try mounting the antenna in a different location.

CDMA iPack:

The CDMA iPack antenna test will provide results ranging from 0 to 100%. A result of 100% indicates optimal signal
strength, and a result of 50% indicates only fair signal strength. Powering up phone is displayed briefly, followed by
Contacting Carrier, and then a screen similar to this appears:

iPack/CDMA

rv21d 10-26

Signal Strength: 45%
Carrier: B SID: 300

The screen below shows the same results when the antenna test is done using SDR software (from the Modify iPack
Settings screen, choose Options, and then Set Up Phone).

Set Up Phone

X|
Connection Type———————————
’1‘ Dialip  © AMPS  © GSM Gz || Eand

" DoCoMo @ CDMA  © Satellite

— COMA Phone Parametear

ESN Mumber Click 'Get'

Registration String: *22899
Eenjster Phane

{ Stop Antenna Test I [Signal Strength: 46%

© |Reg\stered on network B

|Cnnneded

Verifying iPack data transfer to ISP (Call Now)

Once you have verified that the logger is functioning and that the iPack is present by pressing [Home][2][3], you will
want to perform a Call Now to verify communications with your ISP. During a call, the Call Now and Antenna Test
features are unavailable, but all other logger programming functions are available. The iPackGPS’s Call Now screen
displays the antenna signal strength and allows the user to navigate other menus while a Call Now is in progress.

Press [Home][3][4] or [Home][2][3], and wait for the menu to change while the iPack powers up. Then press [1] to
initiate a “Call Now”. The logger will display the series of messages shown below as it performs the call. Please note that
loggers with an iPackGPS will display slightly different progress messages as follows: Checking for file, getting next file,
starting modem, detecting modem, detecting GSM band (GSM iPackGPS only), registering modem, initializing modem,
connecting modem, connecting Internet, Internet connected, getting time info., starting email send, starting email recv,
email in progress, disconnecting, checking GPS.
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Call Now Requested
iPack displays this message when a Call Now is requested.

Battery OK for Call
iPack checks internal gel cell battery voltage and displays this message if it is above 10.5 V.

Initializing
iPack retrieves necessary settings from non-volatile memory.

Detecting GSM band
(GSM Only) iPack automatically detects bandwidth of cellular network.

Programming Modem
iPack loads retrieved settings into the Internet processor, modem, and cellular transceiver (GSM iPacks).

Getting SD File or Retrying Last File

iPack retrieves a copy of the file from the SD and loads the entire file into a non-volatile memory location (or if a file is
already loaded in the iPack’s non-volatile memory, it will retry to send that file). Retries can occur if data transmission is
interrupted during a call.

Emailing Data
iPack begins to move data from non-volatile memory to the Internet processor.

Waiting for Internet

This message is displayed while the phone is powered, dials the ISP, and the iPack logs onto the Internet. The message
could be displayed up to 3 minutes. If the logger can't log on to the Internet within 3 minutes, a retry will occur
automatically in 10 minutes.

While logging onto the Internet, the iPack checks for successful completion of the authentication process, confirms
availability of DNS service, locates the SMTP server, and confirms that service is available. During communications, the
iPack status screen [Home] [2] [3] will indicate that a call is being made (“iPack busy or not present” or a series of
status messages for iPackGPS).

Percent Sent %
iPack data transfer progress of the file currently being sent is displayed as a percentage.

File was Sent

A file was successfully transferred to the ISP, and the iPack checks the SD for another unsent file. If another unsent file is
found, the logger returns to the step of the process where the SD file is retrieved. The logger will keep returning to that
step in the process in a loop type fashion until all files have been sent, data transmission has been cut off, or the iPack
times out after a 20 minute on-air period.

Note: Under normal use, an iPack should never need to exceed 20 minutes of on-air time. In fact, each daily call should
take under 2 minutes to transfer data. The 20 minute on-air time out protects both your battery from running down and
your phone account bill from running up should something go wrong.

Getting Time

Once all the files from the SD have been sent, the iPack gets the time from the defined time server. Note that the iPack is
compliant with RFC 868 time servers which respond to requests on port 37. Your ISP can recommend a time server that
is RFC 868 compliant.

Checking Mail
The iPack logs onto the POP3 server (with the proper Mailbox Name and Mailbox Password settings) and searches each
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email header for a patch file that is addressed to the logger. If the logger finds a patch email, it downloads it and updates
the iPack programming parameters or sensor configuration settings in non-volatile memory based on the patch file.

Tip: Keep the mailbox clean and regularly delete SPAM to reduce air time and save money on phone bills. Also, any
changes in your account status may result in the ISP sending an email to this mailbox. It is a good idea to log on
(through a web-mail type interface such as mail2web.com) and check for important mail from your ISP regarding your
account status.

Patch Applied
If the iPack finds a patch file, the logger will briefly display this message.

Shutting Down
This is always the last message of the series after checking mail or patch applied.

Success or Internet Error XXX

This is the same message as would be found in the iPack status screen. The call is properly terminated by the iPack with
all data transfer a success, or an error has occurred. Note the error code number and look up the error on the iPack Error
Code Chart in the Troubleshooting chapter of this manual or in the Tech Support area of the Renewable NRG Systems
website.

Checking the iPack’s Modem Status — Modem Status Screen (iPackGPS only)

The Modem Status screen [Home][3]1[41[ 2] displays the iPack firmware version battery voltage along with the
registration state (Home, Roaming, Searching, Not Registered), the next scheduled call time, and the antenna signal
strength. From this menu, the back arrow button can be used to return to the iPack menu.

Checking the iPack’s GPS Status — GPS Status Screen (iPackGPS only)

The GPS Status screen [Home][3][4][3] displays the iPackGPS's version number and type (CDMA, GPS, or Satellite),
along with the latitude, longitude, altitude, and number of acquired GPS satellites. The latitude and longitude are shown
in degrees and decimal minutes (rather than in degrees, minutes, and seconds).

Checking the iPack Event Log — iPack Event Log Screen (iPackGPS only)

The iPack Event Log [Home][3][4]1[4] allows the user to scroll through humbered events by pressing the up and down
arrow keys. The most recent events are displayed first. Using the numeric keypad, the user can enter a nhumber jump to a
particular event.

Using the Manual Dial feature — Manual Dial Screen (iPackGPS only)

The Manual Dial feature [Home][3][4][5] allows a CDMA iPackGPS to be switched from Verizon to WindLinx or from
WindLinx to Verizon through use of an initialization string (*22899;). Sending this initialization string updates the
iPackGPS modem’s PRL (Preferred Roaming List).

When entering *22899; in the Manual Dial screen, use the up arrow to enter a *, use the right arrow key to enter a semi-
colon, and then press the “"SET"” button on the logger’s keypad. If you are unsure about how to use this feature, please
contact Renewable NRG Systems Technical Support for assistance.

Verifying iPack settings with your computer at the site using the iPack Access Port

Sometimes it is necessary to check the current iPack ISP and phone settings while on site. The programming adapter
along with the DB9 field programming cable will allow you to do this by connecting a portable computer equipped with a
COM port to the logger’s iPack access port (see Symphonie PLUS3 Logger Components Map).

The front panel iPack access port works exactly the same way as the DB25 port but allows the user to access the iPack
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while the logger is connected to the iPack. Note that if the logger is controlling the iPack at the moment you plug it in,
the computer will not be able to communicate with the iPack until the logger commands are finished. The iPack can only
communicate with one device (logger or computer) at a time.

With the iPack connected to the computer through the access port, you may perform all the same functions as found in
the Pre-Installation Setup: iPack Configuration section.

Installing the programming adapter

On one side of the adapter you should see symbols for a headphone and microphone. Renewable NRG Systems supplies
the DB9 cable with the adapter. Plug the DB9 cable into the adapter. To install the adapter, remove the logger battery
cover and very carefully insert the programming adapter with the 1/8 inch phone jacks pointing down.

Be careful not to bump the SCMs! Electrical damage could result! Do not force the adapter! Make sure you are inserting
the adapter into the correct port!

Once installed, the headset and microphone symbols should be on the right side of the adapter.

Before Leaving the Site

1. Check sensor readings to assess sensor condition. Readings that vary widely with expected norms may indicate a
faulty connection. Press [Home][1], then [Up] or [Down] to scroll through the sensors.

Check all sensor cables, making sure they are firmly attached to the tower.

Check the batteries and clock. Note battery condition. Press [Home][2][1].

Confirm that the SD has been installed and formatted.

Review the time and date settings, and the next call scheduled (remember the clock is set to Standard time).
Remove the desiccant pack from its plastic bag, and clip it under the gray clip in the logger’s door.

Install the battery cover to securely hold the D-cells and the SCMs. Tighten the thumbscrews by hand only (do not
over-tighten or use tools).

8. Close the logger’s door, and secure both latches.

9. Check that the wiring panel is secured to the logger.

10. Close, latch and lock the shelter box.

Nouhwn
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Site Visits

Recommended Tools and Supplies

diagonal wire cutters to trim sensor wire leads

wire strippers to strip sensor cables if hecessary

7/16 inch nut driver or wrench for installing yagi antenna

5/16 inch nut driver for hose clamps, mounting screws (PV and logger)
2 inch crescent wrench to tighten ground acorn nut

Y4 inch nut driver for sensor terminals

3/8 inch nut driver or wrench for ground stud nut

electrical tape

small flat blade RNRG screwdriver (included with logger) for sensor wires
Phillips head screw driver for PV terminals & attaching iPack to logger
drill to tighten hose clamps - optional

tin snips to cut excess hose clamp — optional

extra desiccant pack

Changing SD and Routine Site Visit Check List

A routine site visit should include the following activities:
Check sensor readings to assess sensor condition. Readings that vary widely with expected norms may indicate a
sensor malfunction. Press [Home][1], then [Up] or [Down] to scroll through the sensors.

1.

PN hAWN

Check the batteries and clock. Note battery condition. Press [Home][2][1].
Pull SD and label it with the date and site number. The SD can be pulled at any time.

Symphonie PLUS3 Start-up

If battery status was “Replace”, replace batteries now, one at a time. Use only alkaline D-cells, IEC type LR20.

Correct the clock, if needed (remember the clock is set to Standard time).

Insert and format a new SD card.
Check SD status.

If any condensation is noticed inside the enclosure, replace the desiccant pack with a fresh one from a sealed

package.

Cleaning

If it should become necessary to clean the Symphonie PLUS3 data logger, use a cloth slightly dampened with water and
wipe clean. Do not use solvents. Never submerge the unit.
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Symphonie Data Retriever Software: Data Processing

Backing up data files

It is very important that your data is backed up at regular intervals. It is a good idea to back up and archive all your raw
data files (.rwd) as well as the SDR site database (.nsd). A simple backup method is to copy/burn your entire Renewable
NRG Systems directory to an external drive or CD after every successful data processing session. Always consult with your
IT professional if unsure how to copy or back up files.

Make sure to back up your data!
Transferring Raw Data Files onto your computer hard drive

Using an SD Reader and Windows Explorer to copy Raw Data Files to your Raw Files working directory

Once you have successfully installed the SD Reader and have a drive mapped to it, you may use standard commands in
Windows Explorer to copy the raw files from the SD to the Raw Files working directory (see Options) on your computer
system. Many computers have a built-in SD card reader. It is important to remember that when viewing the raw data files
(*.rwd) on the SD Reader, they only exist in the SD Card and do not exist on your computer until you copy them to your
system hard disk. It is very important that the drive to which the raw data files are copied is backed up at regular
intervals. Consult with your IT professional if unsure how to copy or backup files.

Saving Raw Data Files received as email attachments from your email program to your Raw Files working
directory (iPack users only)

Once you have successfully received a raw data file as an email attachment, use standard commands in your email
program to save the raw data files (*.rwd) to the Raw Files working directory (see Options under SDR’s File menu). It is
very important that the drive to which the raw data files are copied is backed up at regular intervals. Ask your IT
professional if unsure how to save or backup files.

Data Processing Utilities

SDR installs utilities on your computer that assist in data handling. PopAuto.exe can be used to automate the extraction
of SymphoniePLUS3 data from emails. Application notes that explain how to use PopAuto.exe can be found in the Tech
Support section of the Renewable NRG Systems web site.

Opening the SDR software

From the Windows Start menu, go to Programs>NRG>Symphonie Data Retriever. The SDR main window will
open.
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Erle_ Site  Help
— Site:

BN oo | |
[ratabaze | EciiII E\'en-‘zl _Ii
[ Mardweare . |

Description:

[ tetade | s
—l Load Header Fead Data
_l Scale using o

settings from; & Ste € Looger

Checking what version of SDR is installed

From time to time it is necessary to check which version of SDR is installed on your computer so you may check for an
update or submit a technical support inquiry. Go to the Help>About menu to check the version number. Be sure to
check the Renewable NRG Systems website for updates!

[ About Symphonie Dota Retriever 1 i

Syerphonie Data Retieves
RENEWABLE Version 7.00.01

NRG

Copyright ©2000-2011 NRG Syleens, Inc [ e |

Viewing Data Header

The data header contains basic site and logger information such as site number, site description, latitude, longitude,
altitude, time zone, logger serial number, model number, hardware revision, iPack, and logger time stamp for the data
file. This information should always be checked before reading a data file. If anything is corrupt in the header
information, take note and proceed with caution.

Press the “Load Header” button to view the header information.
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x| eEckEr

2

#loL 207 RWD
] 0125200206 1308.RWD
] 0125200206 1409.RWD
] 0125200206 15 10.RWD
=] 0125200206 16 11LRWD
012520020617 12RWD
0125200206 18 13.RWD
012520020620 15.RWD
012520020621 16 WD
= 012520020622 17 RWD
012520020623 18.RWD
012520020624 19.RWD

=] 01252002062502 LRWD
0125200206 25022 RWD
[]01252002062520 RWD

] 0125200206 26009, RWD
[#]0125200206270 10.AWD
[#]0125200206280 11L.RWD
0125200206290 12 RWD
0125200206300 13.RWD
0125200207010 14.RWD
[#]012520020719040.AWD
[#]01252002072004 LAWD
#]012520020721042 RWD

]012520020722043 WD

=] 0125200208 26006 WD
] 012520020826007 RWD
] 012520020826008.R WD
] 01252002082 7009.RWD
[#]0125200208280 10.RWD
[#]01252002101706 2 WD
0125200210 1806 3.RWD
0125200210 19064.RWD
] 012520021020065.RWD
[#]012520021021066.RWD
[#]01252002102206 7. RWD

File name:

|E|1252E|E|2E|6E|91 7 RwWD

Files of type:

IRaW wind data (*.rwd)

|
|

Open |
Cancel /él

Select a file and press "Open.” If files are not *.rwd, choose the correct type of file from the “Files of type” drop-down

menu at the bottom of the window. If a site for this file does not exist, you should see the following message:

Warning!
Mo local site corresponds to the one referenced in this data file!
Create a new site with the data fle parameters?

Note that if a site file does not exist, SDR will prompt you to create one at this point. See the section called “Creating a
New Site” found in the chapter called “Data Retriever Site Information” if you choose to create a site file at this point. You
will want to have the site commissioning data at this point to be able to successfully create the site.

To view the file header without creating the site, choose No. You should see the following window with the file header
information:

= — . F
w5 Symphonie Data Retriever - 008020070709482.Rwp = || 0|3 -0 EE R S SR G 0GR (TS T U R C=REET
File 5Site Help Special File Site Help
Site: Logger: — Site: ~ Lagager:
Site umber [ 0080 | SenmE [ g7 [ ‘Site Number ' 0102 i Serial # S
Databaze | Edit | Events | | Model 2 | Z000 Database J Edit ] EventsJ [ “Model l 3080
Description: Description: —— —
- | Hardware Rev. | 003-009-030 - . [umm l 009-009-050
Burke hMountain New Site |
iPack GEM i ‘ iPack l GSM
1363 13.84V I
| Latitude | N D00® 00 000" D'ata File: [ Latitude l N 044" 20317 i Encrypted Data File: — A
Logger 07/09/2007 — [ _ Logge I 021472011
| Longitude |wnnn-nn.nnn- Timestamp 00:00:02 [ Longitude "lwa?!f 06676 Timestamp 00:00:02 |
| Altitude | 3260 Load Header t [ Altitude l 000116 Load Header Read Data
; i  Time Zone 5 Scale uzing o e
| Time Zone | -5 g;ﬂlr?gzsf':;%_l: @ Site " Logger | [ l settings from: # &g © Logger | |f

iPackGPS users can click on the iPack link shown above to access more detailed iPackGI;S information such as iPackGPS
serial number, modem identifier, battery voltage, and antenna signal strength at the time of the call:
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Extended iPack information @

b oder bype: 5k
Firrsare werzion: 50

B attery voltage: 13.84
Serial nurmber: a9
Signal strength: a0k I

Framing error rate: 3

b oderm identifier: I
0119930000035490

Copy POk

Reading Data to the Data Viewer with settings from data file

Once you have loaded the header of a raw data file, you may “Read” the data into the graphical data viewer. If you wish
to use the settings that are included in the data file (the settings that were programmed into the logger), select “Scale
using settings from: Logger.” The interpreted data in the data viewer will be based on the logger settings as they
were configured by field personnel.

Interpreted Data - C:\NRG'RawData',012520021230136.R! ) —|O ll
File  Wiew
108 108
945 ’ 945
8.1 l 8.1
L 673 l 6.75
2 54 A5
E 4 A i ,l\ I 408
27 & 27
AR A O Y LW T AR A 12,
‘ N | — o] s K b4
0 a
Averages 12/30/2002) 12/30/2002( 12/30/2002| 12/30/2002| 12/30/2002( 12/30/2002| 12/30/2002
00:00:00 00:10:00 00:20:00 00:30:00 00:40:00 00:50:00 01:00:00
MRG #40 Anemometer
HNRG #40 Anemometer 4.8 349 40 38 z2h 10 13
MNRG #40 Anemometer 41 3n 32 31 18 0.8 0.8
NRG #40 Anemometer 21 17 18 17 11 1 06
NRG #40 Anemometer 41 an 32 3l 18 0.8 0.8
Mowvalynx Rainguage n.oo 0.00 0.00 0.00 0.00 0.00 0.00
#200P Wind Vane 16 4 33 a 53 98 166
#200P ‘Wind Vane 16 4 33 a1 53 98 166
#1108 Temp Sens (F) 21.7 216 208 206 201 195 186
BP-20 Barometer 304 304 304 304 304 304 304
RH-5 Relative Humid. 723 74.0 751 76.3 778 741 81.0
Licor Pyranometer o.n o.n o.n o.n o.n o.n 0.0

Reading Data to the Data Viewer with settings from site file

Once you have loaded the header of a raw data file, you may “"Read” the data into the graphical data viewer. If you wish
to use the settings that are included in the Site Information Editor window, select “scale using settings from: Site.”

The interpreted data in the data viewer will be based on the site information as it was configured with the SDR software.
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Interpreted Data - C:\NRG"RawData"012520021230136.R! _ |0 il
File  iew
10.8 0.8
945 945
8.1 ’ 8.1
L 673 { 6.75
g— 54 AT 54
408 A 405
2.7 A s ’ 27
Ty A T YR T AR 2
o= — = a b
il 0
Averages 12/30/2002| 12/30/2002| 12/30/2002| 12/30/2002| 12/30/2002| 12/30/2002| 12/30/2002
00:00:00 00:10:00 00:20:00 00:30:00 00:40:00 00:50:00 01:00:00
ARG #40 Anemometer
ARG #40 Anemometer 48 38 4.0 38 25 10 1.3
HRG #40 Anemaometer 41 30 3.2 31 18 0.8 0.8
HRG #40 Anemaometer 21 17 1.8 17 11 05 0.6
MNRG #40 Anemometer 41 30 32 3l 18 08 0.8
MNovalynx Rainguage 0.00 o.no 0.00 0.00 0.00 o.no 0.00
#200P Wind Wane 16 4 33 a 53 98 166
#200P Wind Wane 16 4 33 a1 53 98 166
#1105 Temp Sens (F) 217 218 20.8 206 201 135 18.8
BP-20 Barometer 304 30.4 30.4 304 304 30.4 30.4
RH-5 Relative Humid, 723 74.0 751 763 77h 79.1 81.0
Licor Pyranometer 0.0 0.0 0.0 0.0 0.0 0.0 0.0

Logger Channels and Graph

The data viewer allows users to graphically view each channel or even multiple adjacent channels simultaneously in the
graph located at the top of the screen. The channel descriptions run down the left side of the screen.

Choosing logger channel to view in graph

To select a channel to view in the graph, click on the channel with your mouse. You may select multiple adjacent
channels simultaneously by holding down the shift key and clicking on the channels with your mouse. Each channel will
be represented by a different color on the graph, and a key is included to the right.

Choosing parameters from selected logger channel to view in graph

Once you have selected channels to view in the graph, you may change the parameter you are viewing for the channel by
selecting from the View menu. For example, to view the standard deviation instead of 10 minute averages, select
View>Standard Deviation.

Interpreted Data - C:\NRG\RawData'012520021230136.R! ‘. o [m] il
Ele  View
38 38

3325 l 3328

2.85 { 285

= 2375 1 M— 2375 |

SR - 19

SRPLEN 'I‘A 1" 1425 |

0.95 035
e I Y] [ A s
g [ [ [V [ 1 g
T I B v e v B
NRG #40 Anemormeter

NRG #40 Anemometer 20 13 14 14 14 0.6 07
NRG #40 Anemometer 23 14 20 16 12 0.2 0.0
NRG #40 Anemometer 0.9 0.6 0.8 06 06 0.2 0.3
NRG #40 Anemometer 23 14 20 16 12 0z 0.0
Movalynx R 0.00 0.00 0.00 0.00 0.00 0.00 0.00
#200P Wind Vane 18 17 20 15 18 22 12
#200P Wind Vane 18 17 20 15 18 22 12
#1105 Temp Sens (F) 0o 0o 01 0o 0o 0o 0.0
BP-20 Barometer 0o 0o oo 0o 0o 0o 0.0
RH-5 Relative Humid. 04 03 06 03 05 02 10
Licor Pyranometer 0.0 0.0 0.0 0.0 0.0 0.0 0.0

»

Saving Data from the Data Viewer to a TXT file

Once you have viewed the data and wish to create an ASCII (.txt) file for further data processing, choose File>Save
TXT File. SDR will save a tab delimited ASCII file with the .txt extension into the scaled data working directory (see
Options under SDR’s File menu).
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x|

Wrote:
Ci\MRGYScaledDatayd12520021230136 18, £t

Note: When creating an ASCII file from data scaled from settings from the logger, scale factors from the logger will
applied rather than scale factors from the Site Information Editor window.

Importing the data into the site database (when viewing with settings from Site only)

Once you have viewed the data using the settings from the site and wish to import the data into the SDR site database,
choose File>Import to database. SDR will import the data into the corresponding site database file (.nsd) where the
data can be accumulated over time.

Closing the Data Viewer

Select File>Close from the Interpreted Data Window to close the Data Viewer. The SDR Main menu will appear once the
Data Viewer has been closed.

Batch Processing data files (Converting a group of raw data files to .txt files and importing into
the database)

If you wish to convert many raw data files into scaled ASCII data files and/or import many raw files into the database
together in a single process, you may do so using the batch processing feature. Select File>Batch Process. SDR allows
you to choose if the scaling information will come from the site file and if this data will also be imported into the database
with or without generating corresponding daily .txt files. SDR also allows import using the settings from each raw file — in
this case the data cannot be imported into the site database. If selected, text files will be written to your scaled data
folder. If a file cannot be processed, filename.log will be written in the scaled data folder.

Batch Processing... il

 Use predefined site paramsters I Import data to site database

1 Use each datafile’'s sensor parameters ¥ Do not output texd files

Events / Errors

Options

Disabling Descriptive Headers from Output Files

Certain data processing tasks require that the header information is not included in each saved ASCII (.txt) file. Go to
File>Options and check the “skip descriptive headers” box if descriptive headers are unwanted in the file output.
Additionally, if the “skip descriptive headers” box is checked, the option to skip column headers is also available by
checking the “skip column headers” box.
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Output Hourly Averages

Check the “"Output Hourly Averages” box if you wish the daily .txt file format to contain data with hourly averages
instead of 10 minute averages.

Delimit with commas instead of tabs

Check the “Delimit with commas instead of tabs” box if you wish the daily .txt file format to use commas as a
delimiter instead of tabs. 74is is not recommended for users outside of the USA!

Setting the working directory for Raw files (where Raw files from the SD or email program should be saved
so SDR can find them)

Go to the File>Options menu to change the working directory for raw data files. This is the directory that SDR will point
to for reading raw data files. You will see the working directory path and can either edit the path or browse to a new
location by clicking on the box with three dots to the right of the Raw Data path.

Setting the working directory for Saved TXT files (where scaled data files are stored)

Go to the File>Options menu to change this working directory. This is the directory that SDR will point to for saving
scaled data files. You will see the working directory path and can either edit the path or browse to a new location by
clicking on the box with three dots to the right of the Scaled Data path.

Setting the working directory for Site files (where site information used to scale data is stored)

Go to the File>Options menu to change this working directory. This is the directory that SDR will point to for saving site
files. It is also the directory that SDR will point to when utilizing a site file to process raw data. You will see the working
directory path and can either edit the path or browse to a new location by clicking on the box with three dots to the right
of the Site Files path.

Setting the working directory for Reports (.wmf file format)

Go to the File>Options menu to change this working directory. This is the directory that SDR will point to for saving
reports. Each time you run reports in SDR, they will be saved to this directory. The .wmf report files easily import into
MicroSoft office documents and can be easily exchanged through email. You will see the working directory path and can
either edit the path or browse to a new location by clicking on the box with three dots to the right of the Site Files path.
X|

—Warking Folders
Raw Data:

IIC:\NRG\RawData

0K

Cancel

Scaled Data:
IC:\NRG\Sca\edData

Site Files:
|c.\NRG\S\teF|IES

Reports:
|C.\NRG\RepUns

1T ET

— Output Files
[~ Skip descriptive headers

T Skip column hieaders

™ Output Hourly Averages

™ Delimitwith commas instead of takhs

SDR Event Log

The SymphoniePLUS3 logger stores internal events into a log viewable from the logger display. The event log is
transferred into the Data File header whenever a new file is created for any reason. The SDR software imports these
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events into the SDR “Event Log” which is viewable from SDR (from SDR’s main menu, choose Site>View Event Log,
choose the site number from the list, and click OK).

A typical Event Log looks like this:

124820011244 PM
12482010 1:15:53 PM
12/8/201010:02:14 P
1248/201010:05:02 P
12/9/201010:03:14 P
12/9/201010:05:07 P
12AM10/201010:03:32 PM
1241042010 10:05:03 PM
12/11/201010:03:44 PM
12/11/201010:05:03 PM
1222025 Ph

Internet Time Adjust
Internet Time Adjust
Intermnet Time Adjust
Intermnet Time Adjust
Internet Time Adjust
Internet Time Adjust
Internet Time Adjust
Intemet Time Adjust
Intemet Time Adjust
Internet Time ddjust
Internet Tire Adinst

[F] Event Log Viewer - 0001.nsd .l
MNews Site Save TXT File
Timestamp | Ewent | Data ﬂ

11/29/20010 10:05:04 PR | Internet Clock, Set
113020010 10:05:07 PR | Internet Clock, Set J
1212010100505 P | Intemet Clock Set
1222010 10:0%:06 P | Intemet Clock Set
1232010 10:0%:05 P | Inkemet Clock, Set
12/4/2010 100505 PM | Intemet Clack Set
12/5/2010 10:05:06 P | Intemet Clack Set
12/6/2010 10:05:06 P | Intemet Clack Set
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In addition to logger events, iPackGPS users can also view events generated by the iPackGPS. If an iPackGPS is
connected to the logger, you will see iPack events like these:

e

A7 3:15:04 AM
1/28/20171 1:01:36 AM
1/28/2011 1:05:05 AM
1/28/2011 5:00:07 AM
1/28/2011 5:00:52 AM
1/28/2011 5:05:03 AM
1/28/2011 3:00:07 AM
1/28/2011 3:00:54 AM
1/28/2011 3:05:03 AM
1/28/2011 1:00:07 PM
17282011 1:01:07 PM
17282011 1:05:02 PM
17282011 4:28:34 PM
12312011 12:00:08 P
1231/2011 12:01:12 P
24242011 1:05:04 Ak

24242011 5:05:04 Ak

24242011 3:05:03 Ak

2020271 1-N5 N4 PR

F - - . - T
Event Log W - 0102.nsd = ,
@ vent Log |Ewer_ - ﬁ
MNew Site Save THT File
Timestamp Data -

Internet C Set
iPackGPS Event
Internet Clock, Set
iPackGPS Event
iPackGPS Event
Internet Clock, Set
iPackGPS Event
iPackGPS Event
Internet Clock, Set
iPackGFS Event
iPackGPS Event
Internet Clock Set
Clock Set
iPackGPS Event
iPackGPS Event
Internet Clock, Set
Internet Clock, Set
Internet Clock, Set
Internet Clork Set

CALL_SUCCESS_EYWT [25108)

CALL_SCHED_ENT [25113]
CALL_SUCCESS_EWT [25108)

CALL_SCHED_ENT [25113]
CALL_SUCCESS_EWT [25108)

CaLL_SCHED_EVT (25113)
CaLL_SUCCESS_EVT [25108)

CALL_BOOT_EWT [25114]
PATCH_DOWNLOAD_EWT [25051)

-
(£ Event Log Viewer - 0901nsd

Mew Site
Timestamp | Event | Data
11/30/2000 8:35:02 AW | Internet Time Adjust
1241/2000 8:31:52 AM iPackGPS Event CALL_SUUCCESS_EWT [25108)
127272000 8:30:07 Ak iPackGPS Event CALL_SCHED_EWT [25113)

2410420171 8:30:44 AM
2410/20171 8:35:02 AM
2M1/2011 8:30:42 AM
2M1/2011 8:31:54 AM
2M1/2011 8:35:02 AM
2M2/20171 8:30:06 AM
2M2/2011 8:30:58 AM
2M2/2011 8:35:02 AM
21372011 8:31:52 AM
2132011 8:31:53 AM
22142011 B:30:07 AM
22142011 B:30:44 AM
22142011 B:31:65 AM

Internet Time Adjust
Internet Time Adjust
Internet Time Adjust
iPackGPS Event
Internet Time Adjust
iPackGPS Event
Internet Time Adjust
Internet Time Adjust
iPackGPS Event
iPackGPS Event
iPackGFS Event
Internet Time Adjust
iPackGPS Event
Internet Time Adjust

CALL_SUCCESS_EYWT [25108)
CALL_SCHED_ENT [25113]
CALL_SUCCESS_EWT [25108)
GPS_SET_EWT 25110

CaLL_SCHED_EVT (25113)

CaLL_SUCCESS_EWT [25108)

! 2114/20171 8:35:02 AM |
2M52017 8:30; iPackGPS Ewvent CALL SCHED_EWT [25113)
L -
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The screen below shows events generated by a failed call:

ﬁ Event Log Viewer - 0102.nsd

Ji g

fleplic Save THT File
Timestamp | Event | Data
1312011 12012 P iPackGPS Event PaTCH_DOWMLOAD _EWT [25051)

27202011 1:05:04 AM Intemet Clock Set
24252011 50504 AM Internet Clack, Set
202020171 3:05:03 A Internet Clock Set
24242011 1:05:04 P Intemet Clock Set
2/2/2011 50502 PM Internet Clock, Set
24202011 3:05:04 P Internet Clock Set

24372011 1:01:38 AM iPackGPS Event CALL_SUCCESS_EVT [25108]

24372011 5:00:07 AM iPackGPS Event CALL_SCHED_EWT [25113]

24372011 5:00:54 AM iPackGPS Event CALL_SUCCESS_EVT [25108]

243720171 3:00:08 AM iPackGPS Event CALL_SCHED_EWT [25113]

24372011 3.00:58 AM iPackGPS Event CALL_SUCCESS_EVT [25108] J
27372011 11:36:59 AM iPackGPS Event CALL_MOWwW_EWT [25112)

2437201 11:37:17 AM iPackGPS Event CONTACT_MNRG_ERR [10045)

27372011 11:37:23 AM iPackGPS Event CALL_FAILED_EWT [25109]

2432011 11:37:38 AM iPackGPS Event CALL_NOW_EVT [25112)

248720171 1:05:05 Ak Intemet Clock Set
27872011 5:05:02 A Intemet Clock Set
AR J0RN2 AR Intarnet Clark Set j

A comprehensive list of Symphonie logger events and iPackGPS events and their definitions can be found in the
Troubleshooting section of this manual.

SDR Troubleshooting Wizard

The troubleshooting wizard can assist in solving problems with data files in the unlikely event data corruption has
occurred. The wizard will step you through the process by first asking “What is the problem?” To open the
troubleshooting wizard, select File>Troubleshooting from the Interpreted Data window.

Troubleshooting wizard x|

What is the problem?

& The timestamps on this file are incorrect

¢ Cne or mora channels contain no data,

Orne ar more channels contain inconsistent or incorrectly
scaled data

Cancel < Back Mext > Einish

Fixing Timestamps

Selecting this wizard makes it possible to fix timestamps (see Time Offset History Window). More details on fixing
timestamp issues can be found in the Renewable NRG Systems Technical Support Forum at
www.renewablenrgsystems.com.
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Sensor Connections
Selecting this wizard makes it possible to see if sensors are disconnected or have no SCM installed.

Sensor History
Selecting this wizard makes it possible to see if an incorrect sensor history entry is skewing data.
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SDR Database and Reporting Functions

SDR includes a self-contained MicroSoft Access compatible database to store imported Symphonie PLUS3 data.
SymphoniePLUS3 raw files (.rwd) and ASCII files (.txt) can be imported, and all data are stored, after scale factors from
the site information settings have been applied for each sensor. This section will provide an overview of the most useful
features of the database.

Selecting a site to open (View database)
Go to Site>View Database, and you will see the following window:

Select a Site - :'\NRGYSiteFiles

Site: Description:
003e ]
0125 bt Ferrara

QK

Cancel

Choose the site you wish to work with and click OK.

Database main window displayed settings:

Site Number - based on Site Information window

Site Description - based on Site Information window

Location - based on Site Information window

Elevation - based on Site Information window

Data Range — shows date range of data files that have been imported into the selected database
Reports —shows the reports that have been configured for the selected database

Importing Data from the Database main window
You should see the Main Database window with the information from the selected site database you have opened.
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T c1'NRG" SiteFiles\0125.nsd X|
~Repo
Site 0125
Mt Ferrara
Project NRG Test Site
Location:
Elewvation: 350
Data Range:
12302002 t 0141342003
D Create New Fun Checked |
mzsn RWD I T flae —Currently Highlighterd Repor
No report highlighted
Export | Fitter | Bur | Exdit | Delete

Importing raw (.rwd) files
To import raw SymphoniePLUS3 data files (.rwd), click on “Import RWD Files.” A Windows “File Open” box should appear
pointing to the raw files directory you have previously configured under the File>Options menu.

2lx]
Look in |ﬁ RawData j = & cf B
2101252002 1230 136, AWD, [#]01252007062419RWD  #]012520020722045.R W0
2]01252002060217RWD [#]012520020625021RWD  [#]012520020826006,RWD
£101252002061207RWD  [#]012520020625022 RWE  [#1012520020826007.RWD
2]01252002061308RWD  [#]01252002062520RWD  [£]012520020826008.R WD
2|01252002061409 RWD  [#]012520020626002 AWD  [#]012520020827009.R WD
=101252002061510RWD  [#]012520020627010RWD  [#]0125200208280 10.RWD
1012520020616 11LRWD  [#]012520020628011RWD  [#]012520021017062R WD
2012520020617 12ZRWD  [#]012520020623012RWD  [#]01252002101806 3R WD
2]01252002061813RWD  [#]012520020630013RWD [£]012520021019064,R WD
2]01252002062015RWD  [#]012520020701014RWD  [#]012520021020065.R WD
=101252002062116 RWD  [=]012520020719040RWD  [£]012520021021066.R W0
2]01252002062217RWD  [#]012520020720041RWD []012520021022067.RWD
2012520020623 18RWD  [#]012520020721042 RWD
File name: [nr2520021230138 FavD =l Open |
Filas of type [ wind data. (0125 rwd) | Cancel
2

Select the files you wish to import, and click "Open.” Notice the “Files of type” entry contains a filter for only the site with
which you are currently working.

The “Batch Processing” window should appear. Uncheck the “Do not output text files” box only if you want daily text files
to be placed into the “scaled data” folder. Most users prefer to use SDR’s export function rather than scaling individual
daily text files. The “scaled data” folder has previously been configured under the File>Options menu. Press “"Go” to
import the data into the database. Note that this is the exact same function as choosing “batch processing” mentioned
earlier in the “Data Processing” section.
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Batch Processing... il
* Use predefined site parameaters ¥ Import dele to site daabase
! Use each data file's sensor parameters ™ Do not output text files
Gal
0%
Events [ Errors
The Events / Errors viewer will display the status of the process.
Batch Processing... ll
& Use predefined site parameters ¥ Import datato site datahase
 Use each data file's sensor paramelers I© Do notoutputtextfiles
Donel

Events / Errors

012520021017062 Wrote: CANRG\ScaledData\012520021017062 bt ;I
0112520021018063 Wrote: CANRGYS caledData\11 2520021018063 bt

0125200210719064 Wrote: CAMRG\S caledData\012520021019064 et

012520021020065 Wrote: CA\NRG\ScaledData\012520021020065 bt

0112520021021066 Wrote: CANRGYS caledData\11 2520021021066 tet

012520021022067 Wrote: CANRG\S caledData\012520021022067 tet

38 files processed and imported

‘Mrote oo to batch |o

Click “Done.” Once data files are imported, you may export or create and generate reports.

Importing scaled ASCII (.txt) files
Symphonie Data Retriever Software provides an ASCII import feature for use in the unfortunate event that the original
raw files have been lost. To import Symphonie PLUS3 scaled ASCII data files (.txt), click on “Import .TXT Files.” A

Windows "“File Open” box should appear pointing to the scaled files directory you have previously configured under the
File>Options menu.

2]

= € ®mckEr

5] 01252002060917.txt 01252002062502 1.kt 012520020626008. tt
2] 0125200206.1207 txt 01252002062520.txt 012520020827009. %t
5] 0125200206 1308.t<t 012520020626009.txt 0125200206280 10,0t
=] 01252002061409. tet 012520020627010.txt 012520021017062. 0t
2] 0125200206.1510. bt 01252002062801 1.t 012520021018063. %t
=] 012520020616 11.txt 012520020629012.txt 012520021019064. &t
=] 012520020617 12.txt 012520020630013.txt 012520021020065. %t
5] 0125200206 1813.0et 012520020701014. bt 012520021021066. 0t
=] 012520020620 15.txt 0125200207 19040, txt 012520021022067 &t
2] 012520020621 16, bt 01252002072004 1.txt 012520021230136. ¢t
=] 01252002062217.txt 012520020721042.txt 0125200212301361. 0t

a 01252002062318.txt
£] 012520020624 19.txt

012520020722043.txt
012520020826007. bt

012520021230136-1.txt
01252002123013610.bt

1]
File hame: I ﬂ Open I
Files of type: ISympthe Scaled Data (0725% ) LI Cancel

7/

Select the files you wish to import and click "Open.” Notice the “Files of type” entry contains a filter for only the site with
which you are currently working.

A standard status bar will appear showing the progress of the .txt import.

Warning.: Import .txt files only if they are standard SymphoniePLUS3 converted ASCII files. Files converted with header
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modifications or alternate delimiters will not import correctly. This feature should only be used when the original raw files
have been lost.

Exporting Data as 10 minute, 60 minute or WAsP

SDR'’s export feature allows you to export data for a particular month or date range for use with a spreadsheet or other
software program that accepts .txt format. Click “Export.” The “Select Span for Report” window should appear. You may
select a monthly or comprehensive date range for the data export. Also, if you wish to export only data that has had bad
data removed, select the “Export data with filters applied” check box. See the section on removing data if you are
interested in filtering the data for export.

Select Span for Report ﬂ

 Date Range: |n5/n912nn2 j 1o |mmfznma j

Export data with filters applied r

0K | Cancel |

Select a range and click "OK.” A standard Windows “File Save” box should appear pointing to the scaled data folder.
Enter a file name for the exported file and choose the file Save as type; here is where you may choose 10 minute, 60
minute or WAsP data.

Click “Save.”

sve As x|
Sovein [ Scoledotn 5] ~mom-

Epprr— 1 [==1]

A standard status bar will appear showing the progress of the export.

Database Export File Formats

Data can be exported from the database in the following formats:
e tab delimited 10 minute data (.txt)
e tab delimited 60 minute data (.txt)
e WASP data

Remember that the exported data has been scaled according to the site information stored in the transferable user
defined site file (.nsd).
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Data Filtering

SDR has the ability to filter data through user-configurable filters. Data filters can be created and saved for each site.
Saved filters can then be run on each site periodically.

Creating a Data Filter

Go to Site>View Database and select the site database for which you wish to create filters. From the Site Database
window, click “Filter.”

AT DO Gt ailac b of N o
%3 C:\NRG\SiteFilessites0000-05004,0125.nsd il Saved Data Filters il
- gite — Filters
. es Graph Ch 1
S |te 01 25 ¥ Hourly Averages Graph Ch 10 Data (filtered & unfiltered):
a Haourly Averages Graph Ch 8
errara
[ Hourly &verages Takle Chil
_ Ve 061742002
Project Mew Praject RHS Hourly Averages Graph Ch 11
v Surnmary Report
Location [v]'%ind Rose Ch1, 7 to
Elevation 350 06/02/2004 6:50:00 A
Data Range:
06/17/2002 to 06/02/2004
Creata New Fun Checked
_Data Create New Bun Checked é
e R s Import TXT files i Cunently Highlighted Report———————— - Currently Highlighted Filter:
Hourly Averages Graph Ch 1 No Filter Highlighted
B (5= Fun Edit | Delate |
Blanket Filter Fun Edlit Delete
|

This brings up the “Saved Data Filters” Window. Click “Create New” which brings up the “Create New Filter” window.

Create New Filter il
Filter Name: ||C‘"G Filter
\Where Channel [7-#200P Wind vane | Cae |- 4] |D 21 deg
& 8D =
And YWhere Channsl |1.NRG#4UAnemUmeler LI :A\:g |< LI I1 ﬂ mph
sD z

And Where Channel:

Cam [ =] e I =
r 5D =

Mark
cn.ann?.?s; 1 Ce2 s [4 Cs Ce 7 C8 Ca o Cnn raz

Mark data as: @ |ce Data

-
Bad Sensor oK Cancel

 Invalid Data

¢ Good Data.

Here you can assign your filter a name and choose the logical definition for your filter based on the data of up to 3
different channels. The “Mark Channels” checkboxes allow you to identify which channels to mark if the filter conditions
are all found to apply. The “Mark Data as Type” boxes allow you select the code with which the data will be marked in
the SDR database. Click “OK” to save your filter.
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Note: Data marked by a filter are not deleted from the database. However, SDR will know to not include those records in
report calculations. When exporting, you will have the option to export the data with or without applying filters.

Running a Data Filter

From the “Saved Data Filter” window, check the filters you want to run and select the time span for the filter.

Select Span for Filter |

= hdanthly:

[Mey ~]

C Date Range:  |06/17/2002 j to Iuﬁfuzfzum j

Symphonie Data Ret il
@ Filters applied

0K Cancel |

Click “OK" to run the filter. SDR will return the “Filters applied” message when done.

Blanket Filtering / Unmarking all data in database
From the “Saved Data Filters” window, click on “Blanket Filter.” You should see the “Data Filtering” window.

x|
Iﬁﬂ 7/2002 j IDG,"DZ,."ZDDAI j
to
12.00:00 8M =] 6 50:00AM =l
| = | =

Fange encompasses 100966 data points

All Channels IGood Data. vl

1 IGDDdDaIa ﬂ 2 IGDDd Data LI 3 IGDDdData j 4 IGDDdData LI

—Flag as:

5 IGoodData ﬂ 53 IGDDd Diata. LI 7 IGoodData ﬂ g IGDDdData LI

4 IGood Data LI 10 IGDDd Data LI 11 IGood Data LI 12 IGDDd Data LI

(0] ¢ Cancel

This window allows you to filter based on time range and channel and is handy when you may want to remove all marked
data from the database.

Data Flag types

You can choose from the following flags to mark data:
e Good Data — applies no filter
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e Ice Data — marks data so it can be filtered
e Bad Sensor — marks data so it can be filtered
e Invalid Data — marks data so it can be filtered

The flags “Ice Data”, "Bad Sensor”, and “Invalid Data” all exclude the data selected from calculations and graphs. SDR
does not identify the data flag types on the reports.

If you wish to include all data, make sure that the "Good Data” flag is selected for all 12 channels for the entire time
range.

Filtering all channels

Select the desired data range and make your flag selection from the “All Channels” drop down box. You should see the 12
channel flags change when doing this. Click “"OK.”

Symphonie Data Re il

100956 data points were filtered

Filtering any channel individually

Select a date range and adjust the flags for each channel. Note that only the “Good Data” flag being selected for a
channel for a given time range will be included in reports or exports (exports have a checkbox option to include filtered
data or not).

Unfiltering (Unmarking) all data for all channels

Select the entire date range. Select "Good Data” from the “All Channels” drop down box. You should see the 12 channel
flags change to “Good Data” when doing this. Click “OK.”

Creating (Configuring) Reports

From the Main database window, click “Create New” in the Reports section. You should see the “Create New Report”
window.

Create New Report

Report Type:

0K Cancel

Report Marme:

Windd Rose Ch 1,7

—Wind Rose Options:

Anemometer ‘ane:

MNEG #40 Anemometer 7 #200P Wind Vane
NRG #40 Anemometer [ #200P Wind Vane
MNRG #40 Anemometer
MNRG #40 Anemometer
NRG #40 Anemometer

ol = oo

inirmurm wind speed for Tls Murmber of cormpass subdivisions

| 16
10 mh |
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Selecting the report type

Select the desired report from the “Report Type” pull down menu
Report types include the following:
e Wind Rose
Frequency Distribution
Hourly Averages Table
Hourly Averages Graph
Summary Report

Note that certain options will appear based on the report type selected. You may create as many report types as you
want for each site.

Selecting the sensors to be included in the report (Configuring your report)

Click on the sensors you wish to include in the report. The report name will be generated from these selections. A good
example is choosing the top level and top level vane to generate the Wind Rose as shown above.

Saving the configured report type for this site
Click "OK.” You will now see the report you created in the “reports” section of the Main database window.

5 ¢1\NRG\SiteFiles,0125.nsd - x|
—Site — Repart
Site 0125
Mt Ferrara
Praoject: MNRG Test Site
Location
Elewation, 350
Diata Range:
06/09/2002 to 01/13/2003
D ‘ Create MNew | Run Checked |
—Data H
":‘Szﬁ RWD Impart TXT files  Currently Highlighted Repart
Wind Rose Ch 5. 7
(B [FliEw Run Edit | Delete

Generating (Running) Reports

Each time you run reports in SDR, they will be saved to the “Reports” directory previously configured under the
File>Options menu of SDR. The .wmf report files can be imported into MicroSoft Office documents and can be easily
exchanged through email. You can also print these reports directly from SDR.

Selecting reports to be generated from the list
Click on the checkbox to the left of each report you wish to run.
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& c:\NRG\SiteFiles0125.nsd X|
i Site —Feports
. v Frequency Distribution Ch 1
Slte 01 25 ¥/ Hourly Awerages Graph Ch 1
Hourly Awerages Table Ch1
Mt Ferrara ¥ Summary Report
Project WRG Test Site yyind Fose Ch 1, 7

Locatian:

Elewvation: 350

Data Range:

06/09/2002 ta 0141 3/2003

Create Mew | Run Checked |
—Data
:g?lgzn RwD Import TXT files — Currently Highlighted Report

Wind Rose Ch 1.7

Export Filter Eum

Edlit | Delete |

Editing and Deleting selected reports

If you wish to edit a report before running, highlight the report by clicking on it, and then click the “Edit” button. You
should see an “Editing report...” window. Make your changes and click “"OK."”

Editing Wind Rose Ch 1, 7 il

Feport Type:

0K Cancel

|Wmd Finse LI

Feport Name:

|Wmd RoseCh1,7

—Wind Rose Options:

Anemometer Wane:
MNMEG #40 An

MNRG #40 Anermometer
NRG #40 Anermometer
MNRG #40 Anemameter

1
2
3
4
5

Minimum wind speed for Tls: MNumber of compass subdivisions:

|l 16
10 mph )

Running and printing the selected reports

Once you have selected all the reports you wish to run in the Main database window, click on “Run Checked.” You should
see the “Select Span for Report” window. Select the desired month or date range, check the “preview before printing”
box, and then click "OK.” SDR will then show standard status bars as each report is generated.

Click “Print Setup” and make sure your printer selection is correct. Exit the print setup, and click “Print and Next” to print
the currently displayed report and then display the next report that has been generated. Note that all these reports also
now exist on your computer’s hard drive in the “Reports” folder that SDR has set up.

Always make sure your site’s sensor scale factors are correct before generating reports!
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Data Retriever Software: Site Information & Site History

Creating a New Site

The Site File

A site file contains all the information necessary to successfully process raw data files from each individual site. The site
file also contains all the scaled data that has been imported into the SDR database. The site files are of the format:

SSSS.nsd
where SSSS = the site number.
For example, 0125.nsd is the site file for site 0125.

Remember, the site file contains scaled data, so if you change the scale factors for old data, you will need to re-import
that old data to apply the new scale factors.

When you create a new site, a new site file is created and stored in the SDR subdirectory (as set in the SDR Main Window
File>Options menu). The site file contains information about the site location, description, what sensors are connected,
and how SDR will scale the data from each of the 12 logger channels. It is very important to get the site file set up
correctly. You will want to have the site data sheet when creating a new site. All of the specific parameters that are
included in each site file are described in this section.

Creating a Site File From Data File (Recommended)

The recommended way to create a new site file is to load the header for a data file from a new site. At that point, a
warning message will appear on your screen informing you that “No local site corresponds to the one referenced in this
data file! Create a new site with the data file parameters?”

E— X

Warning!
Mo local site corresponds ta the one referenced in this data file!
Create a new site with the data file parameters?

Click Yes when prompted at the warning message.

This will bring you into the Site Information Editor window. The site fields will be populated with the information passed
from the logger as programmed by the field personnel. At this point, you will be able to edit all the fields and then save
the site file. You will want to have the site data sheet when creating the new site. The site data sheet will include the
information you need to enter into the site editor if field personnel did not program the logger completely. Once the site
file is saved, any raw data files (.rwd) from the corresponding site that are converted based on this site file will use the
settings stored in the site file to create the ASCII (.txt) file. For this reason, it is essential that the information in the site
file is correct.
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]
File:
Site #1234 Channel #I 1 jj Load Defaults |
Site Desc |Anple Tree Ridgs 49 Baseline
Froject Cade [ATRO0T Deseription [MRG #40 Anem, mph
Froject Dese | Small-scale burbing grid Details
Site Location Hinesburg, YT Serial Mumber Ispeed j
Site Elevation (150 Heighit
Base Time Zen=([GMT-05:00) Eastern Time (US & Cz 7 | e 1.711
Latitude [44 334521 Offeet |0 7
Longitude | 73 097955 Frirt Frecision | 4 j
~ Enciyption
Serial Number 5575 Code: Units | mph Maotes |
[4-digit suffix]
Hard Rew. 008 |1234
areiare Rew. |003-008-014 History | Delete | Make Mew Change |

Creating a Site File Manually

To manually create a site, select Site>New Site from the SDR main window. This will bring you into the Site
Information Editor Window. The site fields will appear empty. At this point, you will be able to populate all the fields and
then save the site file. You will want to have the site data sheet when creating the new site. The site data sheet will
include the information you need to enter into the site editor if the field personnel did not program the logger completely.
Once the site file is saved, any raw data files from the corresponding site that are converted based on this site file will use
the settings stored in the site file to create the ASCII (.txt) file.

Note that you cannot return to the SDR main window until you close the Site Information Editor window. Subsequent

changes to the site can be made by choosing Edit Site from the Site menu. This will bring you into the Site Information
Editor window. You cannot return to SDR’s main window until you close the Site Information Editor window.

Site Information Editor - Site Information Parameters

These parameters are found on the left side of the Site Information Editor window.

Site #
The site number is reported as a four-digit number.

Site Desc (Site Description)
A site description of up to 80 characters can be entered here.

Project Code
A six-character parameter used to code sites within a project can be entered here.

Project Desc (Project Description)
An 80-character project description can be entered here.

Site Location
An 80-character site location can be entered here.
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Site Elevation (Altitude)

A six-character field reporting the Site Elevation as referenced from sea level can be entered here. Units are not stored.
For site elevations below sea level, include a “-" sign before the number.

Base Time Zone (the time zone the logger is located in)

A pull down menu that determines how your data’s timestamps (in UTC) are adjusted to match the local time. Make sure
it is set to the logger local time zone. Time settings should always be in Standard Time (NOT Daylight Savings Time).

Latitude

Enter latitude data in this field. Note that WAsP export only allows the latitude degrees, minutes, and seconds (North or
South) or decimal formats to be exported.

Longitude

Enter longitude data in this field. Note that WAsP export only allows the longitude degrees, minutes, and seconds (East or
West) or decimal formats to be exported.

Logger Serial Number (5-digit suffix)
The logger serial number appearing in this field should be the last five digits of the logger serial number.

Hardware Rev. (Logger Hardware Revision)

The hardware revision is reported as a masked three number sequence signifying the current revisions of the logger core,
logger SD controller, and the iPack firmware revision number.

Site Information Editor - Baseline Sensor Information Parameters

These parameters are found on the right side of the Site Information Editor window.

Channel

Reports the logger channel for which the sensor information is being displayed. Use the up and down arrows to scroll to
the desired channel.

Load Defaults

To the right of the Channel # field, the Load Defaults button can be used to load a default scale factor and offset for
the type of sensor shown in the Sensor Type field (see below). Note that you will see transfer functions (scale factors) in
both SI and Imperial units, allowing the user to specify which units are used for individual channels.

Description

Enter up to a 20-character sensor description. For Renewable NRG Systems sensors, this is the same as the sensor
model.

Details
Enter up to 80 characters in this field for reporting any sensor details.

Serial Number
A sensor serial number of up to 8 characters can be entered here.

Sensor Type

The sensor type and therefore the logging mode of the logger for this channel can be chosen using a pull-down menu to
the right of the Serial Number field. For a counter channel, the sensor type can be either frequency (Speed), totalizer
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(Total), or Unknown. For flex channels, the sensor type can be defined as either Unknown, Speed, Total, Vane, or Analog.
For analog channels, the sensor type can be defined as either Unknown, Vane, or Analog.

Height
Enter the sensor height in this field.

Scale Factor
A numerical sensor scale factor up to 8 characters is entered here.

Offset
A numerical sensor offset up to 8 characters is entered here.

Print Precision

The Print Precision field has a pull down menu that reports how many decimals and leading zeros the scaled data will
have.

Units (Imperial or SI)

This five-character field reports appropriate SI or Imperial units for the sensor selected. Note that you may choose SI
units for some sensors and Imperial units for others (wind speeds in m/s but barometric pressure in inches of Hg, for
example).

Notes

Clicking the Notes button opens a text field in which site notes can be entered. The Notes button will be in bold if any
notes are contained. The notes are not output in the ASCII (.txt) files.

Saving the Site File

When all the site information is entered and has been confirmed as correct, it is time to save the site file. From the Site
Information Editor window, select File>Save Site.

Site History Entries

The Site Information Editor contains a powerful site history tool that can be used when a sensor at a particular site is
changed. History entries will mark the point in time the change is made and then patch in the new sensor information
from that point forward. Since many projects last several years, it is not uncommon to have sensor changes. For
example, you may want to replace an unheated anemometer with a heated anemometer and document this change in
your database.

Selecting the Site and Sensor

Select Site>Edit Site from SDR’s main screen. Choose the site from the “Select a Site” screen and click "OK.”

In the Site Information Editor screen, click the “History” button to display the sensor history table. The table displayed
will show the history for the sensor channel selected under “Sensor Information.” If you scroll through the sensor
channels, you will see the history for each channel.

Make New Change

To make a sensor history change, click the *“Make New Change” button. The sensor information fields are now “live”
and will be applied to this entry when the site file is saved.
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Site History Concepts

There are several important concepts to understand regarding the history editor. First, whatever row in the history table
is selected will be affected by whatever changes are made in the “Sensor Information” fields. For example, in the screen
shown below, changing the height from 5 m to 50 m would change the row highlighted in the table. To change the
height, put your cursor in the field to the right of “Height,” type in the new height, and press Tab. In the table below, you
would see the new height displayed in the highlighted row.

& gite Information Editor - 0125.nsd il
File
Site #1125 |Symph0nie | Channci| 3 jﬂ Load Defaults |
Site Dt Lt Ferriera. As of & 1252002 j |3 00:00 P j‘
Project Code || zyy Desgceription |NRG #1105 Temp
Project Desc |\t Fariera Test Site Details
Site Location [R5 Serial Humber |5p- IAnang j
Site Elevation |35 Height |F 1y
Base Time Zone |(Gh{T-05:00) Indiana (East) LI Seale Factor | 133
Latitude || 44° 20.000' Offset| -8 383
Longitude |\+/ 073° 07.000" Print Precision | 1 ;I
Encryption
Serial Humber |1011 I o Units |
(4-digit suffix) Codle: Naotes
Hardware Rev. 0B |2255
007-008-014 History | Delsete | hake New Change |
|Timestamp |Descripti0n |Serial MNurnber |Height |Scale Factor |Offset ‘Units
Baseline #1105 Temp Sens (F) | SN ft 0.244 -1235  F
8/26/2002 3.0 / NRG #1105 Temp lsv: 5 m C
8/28/2002 1:1 #1105 Temp Sens (F) | SM: ft -1238  F

The next important concept to understand is that the “"Make New Change” button adds a row to the history table. The
new row can then be edited by entering new values in the Sensor Information fields above.

Once the entries look good on the screen, the site file must be saved. Don't forget to save your changes! Select
File>Save Site.

The most important concept is that whatever information appears in each row of the history table is applied until the date
of the next entry. For example, if a logger was originally installed with an RNRG Class 1 Anemometer which was replaced
3 months later with an IceFree anemometer, the Baseline entry would show a description and scaling information for the
RNRG Class 1 Anemometer for the first 3 months, and then the next history entry would show the time and date the
IceFree anemometer was installed and its scaling information.

If you are making a change in your database, you will typically need to re-import any files from the time period after the
change occurred. For example, if your field crew installed a new sensor in August, and it's now October, and you have
just made a history entry that shows the new sensor, you will need to re-import all raw data from August through
October.
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Data Retriever Software: Changing iPack and Sensor Settings
from a Remote Location by Creating a Patch File

Cautions

Extreme care must be taken when patching ISP parameters. If you make a mistake (specifying the wrong ISP phone
number, for example), you risk cutting communication with the logger, and a site visit will be required.

Creating the Patch File

A “patch” is a change to the iPack or logger configuration information. Patch files are generated by SDR and manually
sent to the iPack’s mailbox by the user. The iPackGPS event log will show “PATCH_DOWNLOAD_EVT” and
“PATCH_APPLY_EVT" to help track the installation of the patch.

Sensor Patch

If you need to add or change a sensor, go to the “Site Information Editor” window. Select the sensor entry that you wish
to change, make changes, and then select File>Save Site to save changes (or create a new entry by following
instructions in "Creating a New Site History Entry”). Close the Site Editor window and go to Site>Create Sensor Patch.
Select the site, and click "OK.” In the “Create Patch File” window, enter the time and date at which the change occurred,
and check the boxes corresponding to the sensor channels affected by the change.

Create Patch File - 0007.nsd x|

Generate patch with sensor history settings as of.

|;5,rznns j |1 57.00 PM =
[~ Altitude

¥ Sensor 1 info ¥ Sensor 7 info

¥ Sensor 2 info v Sensor 8 info

¥ Sensor 3 info [~ Sensor 3 info

I Sensor 4 info ™ Sensor 10 info

™ Sensor§ info [~ Sensor 11 info

I Sensorb info ™ Sensor 12 info

Patch password |12345573
Save Patch |

Then enter your patch password, click “Save Patch,” and then “"Save"” in the Windows dialog box.

The Patch Viewer will then show the entry for each field as it will be patched to the logger. Check the changes you made
to be sure they are correct. Confirm that the logger serial number and logger hardware revision number are correct.
These numbers must be correct for the patch to be applied.
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x|

Fatch applies to logger with Serial Mumber: 0760 and Hardware Few: 005-007-012

Memory Location  |Address  |Farameter Yalue -

kil S iption NRG #40 Anem. mfs

Logger 56 51 Serial Murnber Sh:13240

Logger 50 51 Height 50 m

Logger 44 51 Scale Factor 0.762

Looger 4D 51 Offset 0.375

Logger 45 51 Units mis

Logger &1 52 Description MRG #40 Anem. mfs

Logger a6 52 Serial Murnber ShT3241

Logger a0 52 Height 50 m

Logger A 52 Scale Factor 0.78

Logger D 52 Offset 0.467

Logger 75 52 Units mis

Logger 91 53 Description MRG #40 Anem. mfs

Logger Bh 53 Senal Numhber SMN13242

Looger B0 53 Height 30 m

Logger A 53 Scale Factor 0.765

Logger AD 53 Offset 0.432

Logger Ah 53 Units mis

Logger 151 57 Description #200P Wind Wane

Looger 176 57 Serial Number SM/03 LI

When you are satisfied that the patch information is correct, click the X in the upper right corner of the window to exit
the Patch Viewer window. SDR will now display a message notifying you that the Patch File has been written and the file
name has been copied to your Windows clipboard:

I x|

Wrote!

094 1843354l0g. ptc
The number 0941843354 has been copied to your clipboard
Faste it into the subject line and the message body of the e-mail you send containing the patch file.

The file name will be used as the subject line of the outgoing email to which the Patch File will be attached.

Open your email program, and address an email message to the iPack (usually addressed to the email address in the
Mailbox Name field of the *.ipk file). Paste the Patch File name from your Windows clipboard into the subject field of your
email and into the body of the email message.

Failure to paste the patch file name into the body of the email message may cause some email clients (such as Outlook,
Pegasus, Eudora, etc.) to incorrectly attach the patch file. Also note that patch emails need to be in Plain Text format, not
HTML. In Outlook, you can switch your outgoing message to Plain Text format in the Options menu.

Attach the Patch File and send the message.

Configuration Patch

From the SDR Main Window, select Site>Modify iPack Settings. This will bring up the Modify iPack Settings window.
From here, select File>Open iPack File. Browse and select the iPack file you wish to modify. Once you have selected

the file, you will notice check boxes on the right side of the window. Be sure to uncheck any parameter that you wish to
keep the same. Parameters you wish to edit should remain checked.
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'] iPackGPSBETAGSM.ipk - Medify iPack Settings [ﬂh ‘] iPackGPSBETAGSM.ipk - Modify iPack Settings lihj
Eile Options File Options
] Call Schedule | Extended | 15F Information | Call Sehedule | Extended |
ISP Access lMaiI .i'«cu:es&] Email Infu] ISP Access  Mail Access ]Email Inh:u]
: SMTP S i
Fiimary ISP Phane Number — [+gg=+1# v i |smtp. packet-mail et =
ty SMTF Server requires authentication & Yez Mo W
| | | |
_ SMTP Login |025641 85555 v
Prirmary DM S Mumber ||:|_|:|_|:|_|:| [ SMTP Password | xxxxxx v
Secondarny DMS Mumber 0o >
l Authentication Method PAR = > l POP3 Server |pop3. packet-mail.net v
Mailbox M
| et web v | ailbo Mame |02584185555 v
Ilzer Pazzword e v I Mailbox Password | xxxxxx v
I APN Mame [GPRS Only] |internet v I Internet Time Server |time.packet-mail.net v
| |

Review the Pre-Installation Set-up: iPack Configuration section of this manual for an explanation of all parameters. Enter
new parameter information in checked boxes. Once you've confirmed the settings are correct, it is time to save the Patch
File.

Saving the Patch File

Select File>Save To Patch File. This will bring up the Select A Site window. With your mouse, select the site you wish
to patch, and then click OK.

This will bring up the Save As dialog box. SDR will generate an appropriate file name under which this patch file will be
saved. Do not change it. Select Save.

This will bring up the Patch Viewer window. Confirm that the logger serial number and logger hardware revision number
are correct. These numbers must be correct (match the hardware revision number of the equipment in the field) for the
patch to be applied. Click the X in the upper right corner of the window to exit the Patch Viewer window.

SDR will now display a message notifying you that the Patch File has been written and the file name has been copied to
your Windows clipboard. The file name will be used as the subject line of the outgoing email to which the Patch File will
be attached.

Sending the Patch File to the iPack via email

Open your email program, and address an email message to the iPack (usually addressed to the email address in the
Mailbox Name field of the *.ipk file). The address you choose must be one that will get the mail delivered into the mailbox
on the pop3 server that the iPack will check for email.

This is typically of the format: mailboxname@myisp.com.

Do not send the patch email as a response to a logger emaill The “from” field from incoming data emails is user
configurable; be sure to use the email address assigned to your account by your ISP.
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Paste the Patch File name from your Windows clipboard into the subject field of your email and into the body of the email
message. Attach the Patch File and send the message.

Failure to paste the patch file name into the body of the email message may cause some email clients (such as Outlook,
Pegasus, Eudora, etc.) to incorrectly attach the patch file. Also note that patch emails need to be in Plain Text format, not
HTML. In Outlook, you can switch your outgoing message to Plain Text format in the Options menu.

Confirming the change

Depending on when the Patch File is delivered and the iPack’s call interval, changes may not be immediately visible in the
next received data file. Subsequent files, however, should reflect the changes. The iPackGPS event log will show
“PATCH_DOWNLOAD_EVT” and “PATCH_APPLY_EVT" to help track the installation of the patch. If the patch file is
successfully retrieved, the email will be deleted from the Internet server by the iPack. If the email is not deleted from the
Internet server, the patch was unsuccessful and must be tried again after identifying the problem.

Once the logger has received a new patch, if it is unable to download data or connect with a POP3 server within 12
attempts (within 2 scheduled calls), the iPack will revert to the previous configuration. This ensures that communication
can be restored if faulty patch information is uploaded and disrupts the logger’s ability to successfully download data (a
patch with an incorrect ISP phone number, for example). Communication will eventually resume on the third scheduled
call. An incorrect entry in any parameter field can result in a bad patch. The only exception to this is the time server field
— an incorrect entry in this field alone will not prevent the iPack from calling.
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Data Retriever Software: iPackGPS Features

The “iPackGPS” tab’s Settings and Actions screens provide access to new features of the iPackGPS unavailable in previous
iPack versions.

Settings

In the Settings window, the “"Download partial files” and “Check POP mailbox” features can be turned on and off here
once the boxes to the right are checked. Like all other screens in the Modify iPack Settings window, once you have made
a change, you must go to File and choose Save to iPack.

¢ The “"Download partial files” setting allows the user to toggle on and off downloading of partial files.

e Disabling the downloading of partial files and checking of POP3 can reduce air time. However, this is generally
not recommended for remote sites.

e If POP3 checking is disabled, the iPack will not be able to receive patches or firmware updates until the setting is
changed via a direct connection to SDR.

I Modify iPack Settings I -S|

File Options

15F'|nf|:urmati|:|n] Call Schedule  iPackiGPS ]

Settings l Actions ]

Dowrload partial files f* Yez {7 Mo v

i|  Check POP maibox " Yes & g v

Thesge zettingz can be zaved to ary ipk file, but will anly take effect
when downloaded into an iPackGPS unit. Earlier units will be

unaffected.
I Warning: turning off POF checking will present the iPack from being
I able to receive configuration patches or remote firmware upgrades!

35k 50 iPack detected
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Actions

The iPackGPS can have its firmware upgraded via email using the link in the Actions window seen below or on site using
SDR’s Firmware upload button and the iPack programming cable.

e iPack battery voltage and voltages from various locations on the iPack’s circuit board are displayed here when
the Get Voltages button is clicked.

e iPackGPS firmware version can be updated via SDR and the iPack programming cable using the Firmware

upload button.

A link to the site used for remote firmware updates is also displayed on this screen.

Remote firmware updates for some iPackGPS types (satellite) will be completed over the course of several calls.

Firmware updates via SDR and the iPack programming cable are completed in a few seconds.

The iPackGPS event log will show “"UPDATE_DOWNLOAD_EVT” and “"UPDATE_APPLY_EVT" to help track the

installation of the new firmware.

- -
"]’ defaultGSM.ipk - Modify iPack Settings X
Eile Options

15F Information] LCall Schedule  iPackGPSAACC ]Modbus]

Settings
" 2% ol Supply:
Get Woltages
3.3Vl Supply:
L
5%olt Supply:
Extract Event Lag
I 12 Vol Battery:

Firmware upload [

These features will only work on an iPackGPSAACCESS unit!

To perform remote firmware updates, go to:
http: /e renevablenr gsystemns. comdtechnical-supportys oftware

iPackGPS GSM-3G vBO detected

e ———
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Data Retriever Software: Processing Data from 9200-PLUS, Wind
Explorer and 9300 Loggers

In addition to processing data from Symphonie PLUS3 loggers, Symphonie Data Retriever can import and process data
from Symphonie, 9200-PLUS, Wind Explorer, and 9300 loggers. This provides users with older Renewable NRG Systems
loggers an upgrade path to Symphonie PLUS3. Each Renewable NRG Systems logger had some different features, and to
maintain uniformity in the database, there are a few things to pay attention to when using SDR to process data from
these loggers.

Leave Time Zone set to 0

The 9200-PLUS, Wind Explorer and 9300 logger systems all record data in “logger local time.” This is different from the
Symphonie, SymphoniePLUS, and Symphonie PLUS3 loggers, which record data with time and date stamps relative to
UTC. Because of this difference in time zone configuration, leave the time zone setting at “*0 UTC" for all loggers except
Symphonie PLUS3, SymphoniePLUS, or Symphonie Renewable NRG Systems loggers.

Importing and Processing Data

Importing and processing data should otherwise be the same for these loggers as for Symphonie PLUS3; please refer to
the sections on processing Symphonie PLUS3 raw data files in this manual.

Introduction to SDR ChipReader

Versions 5 and higher of the SDR software includes a built in “Chip Reader” utility that is capable of reading 9200-PLUS
DataChips and WindExplorer DataPlugs. SDR is not compatible with the TermReader and will not read 9300 DataCards.

In order to read a DataPlug you will need a DataPlug Reader complete with the supplied null modem cable. To read a
DataChip, you will need an EEReader complete with the phone cable and its RS-232 connector. Your computer will need a
serial COM port or a USB port with a reliable USB to serial converter. The EEReader should be installed on COM 1 or COM
2.

Reading a DataPlug from a WindExplorer
Connect the DataPlug Reader to your computer with the null-modem cable and place the DataPlug into the Reader.

Go to File>Chip Reader (WE/9200+). You should see the following screen:
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windExplorer / 9200+ Chip Reader

Options

Wind Explarer loggers: Insent DataPlug into DataPlug Reader
9200+ loggers: Insert DataChip into EE Reacder Il

Cancel Get Raw File [

|DataPIug Feader detected

Press the "Get Raw File” button and SDR will read the DataPlug. When done you will see the following message:
x|

Wrote: CANRG\RawData\0 12608 13.b04

You may press OK. The reading process is done; a raw file now exists in the specified directory and this data can be
imported and processed with SDR.

Reading a DataChip from a 9200-Plus

Connect the EE Reader to your computer with the phone cable and RS232 connector and place a DataChip into the EE
Reader. Please remember that the EE Reader can only read one DataChip at a time.

Go to File>Chip Reader (WE/9200+). You should see the following screen:

windExplorer / 9200+ Chip Reader

Options

Wind Explorer loggers: Insert DataFlug into DataPlug Reader
9200+ loggers: Insert DataChip into EE Reader |l

Cancel Get Raw File [

|EEReaderdeteded

Press the "Get Raw File” button, and SDR will read the DataChip and display the following:
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Edit Raw Header

Original:  Edited:

Chip Socket et m
Original:  Edited: Leishee G2kChip  [32kchip  »

Site Number IW IW Right Socket Mo Chip NoChip =
Serial Number IW IF Chip ID 0o 0o

todel Mumber IW IBZWD— # ot Sensors - El :['
Firmware Wersian lnq— |U4— Interval (min} 60 60 =

Cancel | Save

— Data Start: Data Stop:
|3;22,vzuus |1:44:uu P |4;5fzuus |2 50:00 Pi
3222008 = 14400FM =] 445 f2008 = 2ED00PM =]
[3zeeos ] = 45005 | ] =

—Data Range Information:

The stop time appears to be correct.

Confirm everything looks Ok and press the “Save” button. You will see the following:
x|

Wrote: CANRGYRawData\ 0000032 2,205

You may press OK. The reading process is done; a raw file now exists in the specified directory and this data can be
imported and processed with SDR.

If you receive an error message that the EEReader is not found, click the right mouse button, choose "Options” and then
set the COM port to 1 or 2.
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Troubleshooting Guide

Be sure to visit the support section of the Renewable NRG Systems website at:
http://www.renewablenrgsystems.com/TechSupport.aspx for the most up to date troubleshooting information.

Communication Problems

Although the SymphoniePLUS3 system was designed to be as robust and simple as possible, it relies on phone service
and the Internet to perform its functions. From time to time, things do not go as smoothly as anticipated. If you have
stopped receiving or have never received emails from your Symphonie PLUS3 logger and iPack, check the following before
visiting the site:

GSM jPacks

Phone Service

e Request a copy of the installation crew field notes.

¢ What did the antenna test results show?

e What error message appeared when a “Call Now” was attempted? iPackGPS users can use the Event Log Viewer
[Home][3]1[4]1[4] to see all errors that occurred during the call.

¢ Did you remember to send an APN to the phone modem?

e Obtain a copy of the .ipk file that was programmed into the iPack.

e Call your GSM cell provider and make sure that the account is active. Is the SIM active? Have you tried the SIM in
another phone or in another iPack?

¢ Has the SIM been properly activated for data transfer, and has the SIM been installed into the iPack?

e Get the cell account records and check the duration and frequency of the activity. Do you see cellular activity around
the time a scheduled call is supposed to occur? Do you see re-tries every 10 minutes (up to six total)?

¢ Give the cell provider the exact coordinates of where the logger is installed AND the ISP phone number it is dialing.

e Ask them if the number is being dialed correctly. Most GSM iPacks should dial *99***1#.

e To check signal and connection status, press [Home][3][4]. Wait for the menu to change while the iPack powers up.
Then press [2]. A message will tell you if service is available and will display the strength of the signal as a percentage.
In this screen, additional detail such as cellular band and carrier are also available.

To view:

IP address, press [1]
DNS1, press [2]

DNS2, press [3]

Cellular Band, press [7]
Cellular Carrier, press [8]

ISP Service
e Get the ISP account records and check the duration and frequency of the activity. Do you see activity around the time
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a scheduled call is supposed to occur? Do you see re-tries every 10 minutes (up to six total)?

¢ Use www.mail2web.com or a similar website used to check email remotely, and try to log in to the account using ISP
settings that are in the .ipk file. If you are unable to login to the ISP from a computer, you will need to review all the ISP
settings with your provider. Renewable NRG Systems has seen ISPs that have unexpectedly changed the user name on
an account. If you are having a particularly difficult time, you may send the .ipk file to Renewable NRG Systems as an
email attachment. We may be able to check (but not necessarily test) the settings for you.

At the site

¢ Perform an antenna test and record the result.

e Try dialing the ISP phone number from a personal handheld cell phone at the site. You should hear modem tones on
the other end. If you hear a "fast busy," there may be compatibility issues between the cell system and the ISP modem
bank it is dialing into. Contact your ISP provider and ask if there are any restrictions or problems associated with cellular
phones calling into the modem bank.

¢ Perform the "Call Now" function on the logger and note the resulting message. If the message "Internet error"
appears, record the error number (and text decription if using iPackGPS). iPackGPS users can use the Event Log Viewer
[Home][3]1[4]1[4] to see all errors that occurred during the call.

e Is the SIM active? Have you tried the SIM in another phone?

¢ Has the SIM been properly activated for data transfer, and has the SIM been installed into the iPack? Be sure that the
SIM card is activated for transparent data mode.

General GSM System Information

When a GSM phone is powered, it registers with the cellular system, and when it powers down, it de-registers with the
system. The GSM iPack follows this protocol closely.

Using GSM in marginal signal areas can cause registration problems. The iPack de-registers when powering down.
However, if signal is lost, the de-registration is never seen by the cell. The next time the GSM phone in the iPack is
powered up, it will try to register with the system and will be blocked out because the system thinks it is already
registered.

The only solution is to have the central GSM office perform a de-registration and then bring the account back up. We
learned this information by talking with Vodafone and a customer in Europe who encountered this issue.

CDMA iPacks

Phone Service

e Request a copy of the installation crew field notes.

e What did the antenna test results show?

e What error message appeared when a “Call Now” was attempted? iPackGPS users can use the Event Log Viewer to
see all errors that occurred during the call.

¢ What were the results of the phone initialization process?

e Verizon users only: Are you certain that you were in a home area during the phone initialization process?

e Obtain a copy of the .ipk file that was programmed into the iPack.

e Call your CDMA service provider and make sure that the MIN and ESN pair are active on your account.

e Get the cell account records and check the duration and frequency of the activity. Do you see activity around the time
a scheduled call is supposed to occur? Do you see re-tries every 10 minutes (up to six total)?

¢ Give the CDMA provider the exact coordinates of where the logger is installed AND the ISP phone number it is dialing.
Most CDMA users will use #777 as the Primary ISP Phone Number. Renewable NRG Systems has already seen situations
where the provider unexpectedly changed the dialing requirements for a given area as well as a provider accidentally
shutting off a customer's account ESN.
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ISP Service

e Get the ISP account records and check the duration and frequency of the activity. Do you see activity around the time
a scheduled call is supposed to occur? Do you see re-tries every 10 minutes (up to six total)?

¢ Use www.mail2web.com or a similar website used to check email remotely, and try to log in to the account using ISP
settings that are in the .ipk file. If you are unable to login to the ISP from a computer, you will need to review all the ISP
settings with your provider. Renewable NRG Systems has seen ISPs that have unexpectedly changed the user name on
an account. If you are having a particularly difficult time, you may send the .ipk file to Renewable NRG Systems as an
email attachment. We may be able to check (but not necessarily test) the settings for you.

At the site

¢ Perform an antenna test and record the result.

e Verizon users only: Try dialing *228 from a handheld CDMA cell phone at the site. Do you receive a “welcome to
Verizon” message or a message from another carrier?

e Try dialing the ISP phone number (usually #777) from a personal handheld CDMA cell phone at the site. You should
hear modem tones on the other end. If you hear a "fast busy," there may be compatibility issues between the cell system
and the ISP modem bank it is dialing into. Contact your ISP and ask if there are any restrictions or problems associated
with cellular phones calling into the modem bank.

¢ Perform the "Call Now" function on the logger and note the resulting message. If the message "Internet error"
appears, record the error number. iPackGPS users can use the Event Log Viewer [Home][3][4][4] to see all errors that
occurred during the call.

e Re-register the phone in home area.

Satellite iPacks

Phone Service

Instructions are included with each Satellite iPack to turn on the phone service. This includes a registration form that
needs to be filled out and faxed to the provider.

Satellite System

The Satellite iPacks use Wireless Innovation as the satellite service provider. The Iridium satellites circle the earth once
every100 minutes traveling in a roughly South to North direction and depend on "line of sight" signals from the iPack
transceiver. Every region on the globe is covered by at least one satellite at all times.

Each (daily) call should take around 3 minutes per day and probably not more than 4 minutes. This may be slightly longer
than other iPacks. The variables in the call length are login, UTC timeserver check, and POP mail check. These events
happen each call regardless of the number of files sent and can be considered "overhead.” Using Wireless Innovation’s
email service (which is included with air time minutes) can reduce connection times.

Installation

Obstructions such as a tower or trees can cause an interruption between the communications of the modem to the
Iridium satellite and therefore can cause untimely termination of the data call.

Installations must therefore take into account the following:
e The antenna must be upright/facing the sky to ensure maximum exposure for the satellite.
¢ The antenna must be located so that it has a good view of the sky, ideally horizon to horizon coverage.

e The antenna should be mounted offset from the mast by a distance of at least 0.5 meters, with no other obstructions
in the line of sight view.
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e The satellites fly in a South-North orbit so the antenna must be mounted such that no obstructions will occur in this
plane. In the northern hemisphere, the antenna mast should point south, and in the southern hemisphere, the
antenna should point north.

At the site

e Perform an antenna test and record the result.

¢ Perform the "Call Now" function on the logger and note the resulting message. If the message "Internet error"
appears, record the error number. iPackGPS users can use the Event Log Viewer [Home][3][4]1[4] to see all errors that

occurred during the call.

Internet Error Codes as Displayed by SymphoniePLUS3 Logger

Rev 009 iPacks and higher are capable of reporting numeric Internet error codes on the logger display. The iPackGPS
offers enhanced descriptive text error codes as shown in the table below.

The error code is the last message displayed if data transmission is unsuccessful. The user can also review the iPack
status screen to see the error code. The error codes are useful tools in determining the source of a transmission problem.
These error codes are trapped by the Internet processor inside the iPack. The error codes do not necessarily give a
specific resolution to a particular issue. However, they will point you to the set of settings most likely causing the problem
and give you an indication of the phase of the calling process in which the problem was encountered. If you receive an
error code not listed below, please contact Renewable NRG Systems for assistance.

iPackGPS Event Codes
DISPLAYED MESSAGE DISPLAYED RECOMMENDED ACTION/EVENT DETAILS
NUMBER
CONTACT_NRG_ERR Contact Renewable NRG Systems for assistance.
DNS_ERR 2102 DNS server not responding.
INVALID_IPSTRING_ERR 2103 Incorrect format of server name.
SNTP_ERR 2104 Incorrect Time Server Name or Time Server not responding.
PPP_ERR 2105 Incorrect User Name or User Password.
MODEM_ACTIVE_ERR 2106 Internet service is active and modem already in use.
PPP_OPEN_ERR 2108 Unable to open PPP session; bad or missing APN, User Name, or User Password.
PPP_CONNECT_ERR 2112 PPP connection lost, inadequate antenna signal strength or antenna unplugged.
PPP_AUTHFAIL_ERR 2113 Incorrect User Name and/or User Password.
PPP_PROTOCOL_ERR 2114 Bad or missing APN, User Name, or User Password.
PPP_CLOSED_ERR 2115 PPP session closed.
NOT_SUPPORTED_ERR 2116 No Ethernet connection available.
MAIL_IN_PROGRESS_ERR 2121 Email transmission already in progress.
KEY_MATCH_ERR 2122 Patch password email subject field incorrect.
SMTP_CONNECT_ERR 2123 iPack unable to establish connection with SMTP server.
SMTP_SERVER_ERR 2124 Mailbox Name or Mailbox Password incorrect; authentication setting is incorrect.
SMTP_TIMEOUT_ERR 2125 SMTP server not responding.
SMTP_CLOSED_ERR 2126 SMTP server shuts down prematurely. Try again.
SMTP_NO_NAME_ERR 2132 SMTP server name left blank.
SMTP_NO_CTX_ERR 2133 Inadequate memory to send email.
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SMTP_TCPCONN_ERR 2134 iPack is unable to connect to the SMTP server. Could be invalid SMTP name or mail
server is down.

POP3_CONNECT_ERR 2138 iPack unable to establish connection with POP3 server. Server could be down.

POP3_SERVER_ERR 2139 Mailbox Name or Mailbox Password incorrect.

POP3_TIMEOUT_ERR 2140 POP3 server not responding.

POP3_CLOSED_ERR 2141 POP3 server shuts down prematurely. Try again.

IPACK_ERR 2142 POP3 header bigger than 2 KB; send patch file or firmware patch in plain text format
instead of HTML.

POP3_NO_USER_ERR 2147 Mailbox name is missing.

POP3_NO_PASS_ERR 2148 Mailbox password is missing.

POP3_NO_NAME_ERR 2150 POP3 server name left blank.

POP3_TCTCONN_ERR 2151 iPack is unable to connect to the POP3 server. Could be invalid POP3 name or mail server
is down.

SYNC_FAILED_ERR 10047 Modem failure. Contact Renewable NRG Systems for assistance.

UNKNOWN_MODEM_ERR 10048 Modem failure. Contact Renewable NRG Systems for assistance.

UNKNOWN_RSSI_ERR 10049 No antenna connected or damaged antenna or antenna cable.

NOT_DIRECT_ERR 10051 Modem not found by iPack.

IPACK_ERR 10052 Suspension not removed upon account activation by service provider and data function
blocked.

INVALID_APN_ERR 10055 Missing or invalid Access Point Name.

INVALID_PIN_ERR 10056 Assigned PIN is incorrect.

NO_SIM_ERR 10057 No SIM card installed in GSM modem.

NOT_REGISTERED_ERR 10059 Phone account not set up; CDMA phone not properly provisioned.

LOCKED_SIM_ERR 10060 Need to enter SIM PIN in SDR’s GSM Set Up Phone screen.

NO_SIGNAL_ERR 10061 No antenna signal strength. GSM phone configured on wrong band; damaged antenna
cable.

CONNECT_TIMEOUT_ERR 10063 Communication network (satellite, GSM, CDMA) connection failure.

REGISTRATION_RST_EVT 10069 Indicates a retry after failure of G2 modem registration.

NO_CARRIER_ERR 10112 When iPack modem can’t detect modem on the other end.

SOCKET_ERR 2401 MODBUS initialization failure.

INVALID_REG_ERR 2402 MODBUS register is invalid.

INVALID_FUNC_ERR 2403 Requested MODBUS function is not supported.

INVALID_BANK_ERR 2404 Indicates an attempt to access a register group that is out of range.

ACCEPT_SOCKET_ERR 2405 MODBUS socket connection error.

INDEX_RANGE_ERR 2406 Contact Renewable NRG Systems for assistance.

CLIENT_LIST_FULL_ERR 2407 Client list already has 4 (maximum) active MODBUS connections.

INVALID_CLIENT_ERR 2408 Client attempting to connect is not in secure IP list.

INVALID_NUM_REG_ERR 2409 More than the available registers has been requested.

SOCKET_CLOSE_ERR 2410 MODBUS disconnection error.

LOGR_IPACK_COMM_FAIL 25026 Logger is no longer communicating with the iPack.

LOGR_IPACK_CONN_FAIL 25028 Unable to establish communication with the logger due to bent pin or corrosion on
connector.

NO_RAWDATA_ERR 25030 Contact Renewable NRG Systems for assistance.

INVALID_STRING_ERR 25041 Invalid field in *.IPK file.
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PRIMARY_ISP_ERR 25042 Primary ISP phone number missing or incorrect.

TIME_SERVER_ERR 25043 Internet Time Server name is missing or incorrect.

SMTP_SERVER_NAME_ERR 25044 SMTP Server name is missing or incorrect.

SENDER_EMAIL_ADD_ERR 24045 Sender’s Email Address is missing or incorrect.

RECIP_EMAIL_ADD_ERR 25046 Recipient Email address is missing or incorrect.

POP3_SERV_NAME_ERR 25047 POP3 Server name is missing or incorrect.

MAILBOX_NAME_ERR 25048 Mailbox Name is missing or incorrect.

MAILBOX_PASS_ERR 25049 Mailbox Password is missing or incorrect.

PATCH_DOWNLOAD_EVT 25051 iPack has initiated patch file download from the POP3 server.

UPDATE_DOWNLOAD_EVT 25052 iPack has initiated firmware download from the POP3 server.

CALL_ACTIVE_ERR 25101 Call in progress while “Call Now” is requested.

DIAL_FAILED_ERR 25102 Modem can’t connect to network. Satellite down and therefore unavailable; incorrect ISP
phone number programmed into iPack; inadequate antenna signal strength.

PATCH_NOT_APPL_ERR 25103 Data in patch file could not be validated and therefore patch was not applied.

IPACK_LOW_BAT_ERR 25104 iPack 12V batteries below 10.5 volts; iPack will not attempt call under this condition.

PATCH_APPLY_EVT 25105 iPack has successfully applied a sensor patch or iPack configuration patch at indicated
date and time.

UPDATE_APPLY_EVT 25106 iPack has successfully applied a firmware update at indicated date and time.

START_CALL_EVT 25107 iPack has initiated a call.

CALL_SUCCESS_EVT 25108 Normal successful call (you will see one of these events per day on daily call schedule).

CALL_FAILED_EVT 25109 Call failed due to lack of antenna signal strength, proper phone account setup, modem
registration problem, etc. Other event(s) in Event Log just prior to this message will
indicate failure source.

GPS_SET_EVT 25110 Adequate satellites acquired to update GPS coordinates in the logger (you will see one of
these events per day on daily call schedule).

IPACK_DEAD_BAT_ERR 25111 iPack 12V batteries below 9.6 volts; iPack will not power up modem or attempt call under
this condition. “IPack busy or not present” message will be displayed soon after this event
is logged.

CALL_NOW_EVT 25112 Operator initiated a “Call Now” from the logger’s keypad.

CALL_SCHED_EVT 25113 Normal scheduled call (you will see one of these events per day on daily call schedule).

CALL_BOOT_EVT 25114 Call was initiated following a complete power loss by the logger.

PATCH_NOT_APPL_ERR 25115 Patch file contents (attachment) do not appear to be a patch file.

BOOT_EVT 25117 iPackACCESS rebooted.

NO_LINK_ERR 25118 iPackACCESS Ethernet cable unplugged.

Other iPack Error Codes

Problem: Internet error 001: iPack timeout error

This message is received when the iPack processor sends a command to the iPack’s Internet processor to initiate data
transfer and does not receive any message from the iPack’s Internet processor for three minutes.

Possible cause(s): No cellular service; interference, or poor signal strength.

Possible solution: Perform antenna test to confirm signal strength and check for service. Contact your service provider
and make sure the account is active.
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Problem: at + ixfh error:

The "at+ixfh error" comes up when the Internet processor is busy trying to talk to the cellular modem and cannot process
commands from the iPack’s main microprocessor.

Possible cause(s): Bad iPack phone; cellular account is improperly configured and confusing the modem.

Possible solution: Disassemble the iPack and remove the iPack battery for several minutes to re-boot; contact Renewable
NRG Systems for return authorization number and return iPack for repair.

Problem: Internet errors 41 —52:
Error messages 41 through 52 indicate an incorrect format was entered in an iPack programming field in SDR.

Possible cause(s): Typographical error; incorrect format (for example, the DNS field must contain only numbers).
Possible solution: Check the format of each entry; consult ISP for assistance.

Problem: Internet error 57: Error when trying to establish PPP
This error indicates a problem with an ISP setting.

Possible cause(s): Incorrect DNS, username, password, or authentication method.
Possible solution: Check all ISP settings; consult ISP for assistance.

Problem: Internet error 58: Error when trying to establish SMTP

This error is received when SMTP authorization (authentication) is required by the ISP but the iPack’s SMTP
authentication setting is “"No.”

Possible cause(s): SMTP authentication setting is incorrect; SMTP authorization username (SMPT login) or password
(SMTP password) is incorrect.

Possible solution: Change iPack’s SMTP authentication setting to “Yes” and enter the correct username and password
(usually the same as the Mailbox Name and Mailbox Password); consult ISP for assistance.

Problem: Internet error 59: Error when trying to establish POP3
This error indicates a problem with the POP3 setting.

Possible cause(s): Incorrect POP3 server name.
Possible solution: Check POP3 setting; consult ISP for assistance.

Problem: Internet error 60: Single session body for MIME exceeds the maximum allowed
This error indicates that the file size exceeds that allowed by the ISP.

Possible cause(s): The ISP has limited the size of email messages to less than 20 KB.
Possible solution: Contact ISP for assistance.

Problem: Internet error 61: Internal memory failure
Contact Renewable NRG Systems for assistance.
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Problem: Internet error 69: Timeout on host communication

iPack timeout error similar to Internet error 001. This message is received when the iPack processor sends a command to
the ISP to initiate data transfer and does not receive any message from the ISP for three minutes.

Possible cause(s): Lost Internet connection due to lack of cellular service, interference, or poor signal strength.
Possible solution: Perform antenna test to confirm signal strength and check for service.

Problem: Internet error 70: Modem failed to respond

The iPack’s Internet processor sent ATDT (dial) command to cellular modem and did not receive a response before
timeout (about 2 minutes).

Possible cause(s): Bad iPack phone; inactive account (wrong ESN or ESN not active) in an area where service is
available. The phone dials but at that point, an operator voice message or special series of tones comes on the line from
the service provider with instructions.

Possible solution: Confirm that ESN is active; contact Renewable NRG Systems for assistance.

Problem: Internet error 71: No dial tone response.
This error message indicates a problem with the cellular service.

Possible cause(s): No cellular service; incorrect system setting; interference or poor signal strength.

Possible solution: Perform antenna test to confirm signal strength and check for service; change system setting and try
again; contact cellular service provider for assistance.

Problem: Internet error 72: No carrier modem response

This error message is received when the phone dials a phone number that does not have a modem answer (may not be
an ISP phone number).

Possible cause(s): Incorrect ISP phone number; ISP has changed their phone number or the area code has changed. For
satellite iPacks, a missing or incorrect Sender’s Email Address. For CDMA iPacks, a wrong ESN or incorrect MIN
configuration by Verizon can also produce this error message; CDMA network incompatible with CDMA iPack.

Possible solution: Correct ISP phone number, enter correct Sender’s Email Address (satellite iPacks); initialize CDMA
iPack in Verizon Home area, see information below.

The cellular provider that Verizon is partnering with in the "extended coverage area" must support the CDMA IS95 call
protocol and also provide a "modem pool" for the CDMA iPack. To insure a successful installation, we recommend that
you determine who the Verizon partner is in the extended coverage area and contact them to see if they support 1S95
and have a modem pool available. As a result, placing a call from a Verizon handheld phone is not a complete test of a
site's compatibility with a CDMA iPack.

Note that you ALWAYS need to activate the CDMA iPack in a Verizon "home" area network and then bring the unit to the
site. When setting up service with Verizon, find out which system (A or B) the phone will register on for your intended
installation site. When performing an antenna test, if your iPack accesses the other system, your site is likely in an
“extended coverage area.” A manual initialization process may sometimes resolve the issue (contact Renewable NRG
Systems for assistance).

Problem: Internet error 73: Dial failed
Similar to Internet error 71; indicates a problem with the cellular service.

SymphoniePLUS3_Data_Logger_Manual | Rev 16 19 November 2015 | support@renewablenrgsystems.com || 132



mailto:support@renewablenrgsystems.com

Troubleshooting Guide

Possible cause(s): No cellular service; incorrect system setting; interference or poor signal strength

Possible solution: Perform antenna test to confirm signal strength and check for service; change system setting and try
again; contact cellular service provider for assistance.

Problem: Internet error 74: Connection with ISP lost
Possible cause(s): Poor audio quality on phone line / weak cell signal.

Possible solution: Perform antenna test to confirm signal strength and check for service.

Problem: Internet error 75: Access denied to ISP server

Possible cause(s): Wrong ISP phone number; incorrect authentication method, incorrect username and/or user
password; missing APN (GSM iPacks); Modem is locked to incorrect frequency band (GSM iPacks).

Possible solution: Confirm that entries for ISP phone number, authentication method, username, and password are
correct. Confirm that APN was sent to GSM iPack’s modem (Set Up Phone screen in SDR).

Problem: Internet error 76: Unable to locate POP3 server
Possible cause(s): Wrong POP3 server name.

Possible solution: Confirm that POP3 server name is correct.

Problem: Internet error 77: POP3 server timed out.
Possible cause: POP3 server is down.

Possible solution: Try again later; contact your ISP.

Problem: Internet error 78: Access denied to POP3 server.
Possible cause(s): Password is wrong; mailbox name is wrong or needs to be changed to include ISP name.

Possible solution: Correct password; try changing mailbox name to mailboxname@myisp.com

Problem: Internet error 79: POP3 failed
Possible cause(s): Wrong POP3 server name.

Possible solution: Confirm that POP3 server name is correct; confirm that the POP3 server is your ISP’s POP3 server (i.e.
don't try to use another ISP’s POP3 server).

Problem: Internet error 81: Unable to locate SMTP Server
Possible cause(s): Wrong SMTP server name, SMTP server temporarily down.

Possible solution: Confirm SMTP server nhame is correct (not entered as “STMP”, for example), contact ISP and check that
SMTP server is up and running.

Problem: Internet error 82: SMTP server timed out

This message is received when the iPack sends a command to the SMTP server to initiate mail transfer and does not
receive any message from the SMTP server for three minutes.

Possible cause(s): Unavailable for overloaded SMTP server; cellular signal drop; SMTP server hame programmed into
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iPack does not connect over the defined port (for example 25, 587, 465).

Possible solution: Perform antenna test to confirm signal strength and check for service; try different SMTP server;
contact ISP for assistance.

Problem: Internet error 83: SMTP failed

Possible cause(s): SMTP server is down or overloaded; GSM units need to have “data mode” enabled on SIM; no cellular
service; interference or poor signal strength.

Possible solution: Try again later; confirm that GSM iPack SIM has “data mode” enabled; perform antenna test to confirm
signal strength and check for service.

Problem: Internet errors 101 through 109: Parameter not defined
Possible cause: An iPack setting has been left blank.

Possible solution: Enter all required iPack settings in SDR.

Problem: Internet error 110: No SMTP defined.

Possible cause: SMTP server field left empty.
Possible solution: Add SMTP server name to field.

SymphoniePLUS3 Data Retriever and iPack Programming

Problem: "iPack communication failed"

When opening the "Modify iPack Settings" window, the message: "Verifying iPack connection" appears in the lower status
bar, but then the message "iPack communication failed" appears.

Possible causes(s): The iPack utilizes a sense line on the COM port in order to initiate communications and expects
standardized states for the COM port on and off conditions. On certain models of computer and operating system
combinations, the COM port default off state does not return to the expected off state, and the iPack gets "hung" in a
state where handshaking cannot take place.

Solution:

e unplug the DB25 cable from the iPack.
¢ close the "Modify iPack" window.

e reconnect the DB25 cable to the iPack.
¢ reopen the "Modify iPack" window.

You should now be connected to the iPack and be able to load a file from the iPack.

Note: When the "Modify iPack Settings" window is opened, a request is made by SDR to open the configured COM port.
Conversely, when the "Modify iPack Settings" window is closed, a request to close the COM port is made.

A dead iPack battery can also produce this error message, so if the above solution doesn't resolve the problem, try
replacing the iPack’s battery.

SDR installation

Problem: SDR software can’t find serial port.
Possible cause(s): Computer hardware compatibility problem.
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Solution: Use USB to serial converter, install manually to COM2.
SymphoniePLUS3 Logger Problems

Problem: SD is blank but should contain data.

Possible cause: SD was never formatted (can't save data); while attempting to read the SD, data files were cut and
pasted instead of copied and pasted. SD was formatted after it was read, and files are present but hidden.

Solution: Format SD. Contact Renewable NRG Systems.

Problem: Received error message “"One or more CRCs do not match: possible bad data” when trying to
read data file in SDR software

Possible cause(s): Data encryption PIN number in Symphonie PLUS3 logger settings doesn’t match PIN number enabled
in Symphonie Data Retriever Software’s Site Information Editor window.

Solution: Change data encryption PIN number in Symphonie Data Retriever Software’s Site Information Editor window to
match PIN number in Symphonie PLUS3 logger settings.

Problem: Receiving message “iPack Not Present.”
Possible cause(s): iPack battery is dead; iPack is plugged into SDR; iPack is busy trying to make a call.

Solution: Recharge iPack battery; wait for iPack to stop its communication with SDR software; wait for iPack to complete
call. As a failsafe, the logger will check at noon every day to see if an iPack has been connected. To force detection of the
iPack, remove the logger’s D-cell batteries and then connect the iPack.

Data / SD

Problem: SD Card does not format correctly first time.
Possible cause(s): SD card has damaged memory locations.

Solution: Identify SD markings and notify Renewable NRG Systems with all details. Renewable NRG Systems runs
qualification tests on SD Cards we ship. Obtain SD Card from Renewable NRG Systems.

Logger Error Log / SDR Event Log

The Symphonie PLUS3 logger stores internal events into a log viewable from the logger display. The event log is
transferred into the Data File header whenever a new file is created for any reason. The SDR software imports these
events into the SDR “Event Log"” which is viewable from SDR (from SDR’s main menu, choose Site>View Event Log,
choose the site number from the list, and click OK). iPackGPS users will also be able to view events generated by the
iPackGPS.

Event/Error Meaning
0 Internet Time Adjust. Time of event is the new time after adjustment has been applied. Clock
was adjusted by less than 2 minutes by an Internet time update from the iPack. Note: a < 2
minute time correction will not cause a new file. The clock correction will be applied in the middle
of the first interval after the call completes. Loggers with firmware version 10 or lower will
automatically begin a new file if a correction of more than 2 minutes is required, but nothing will
be noted in the Event Log.

1 EEPROM initialized. This event is recorded when the logger is restarted and the internal non-
volatile memory was reset.
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Reboot. This event is recorded when the logger is restarted following a power loss or
electrostatic event.

Reserved for future use

Clock set. This event is recorded when the keys of the logger’s keypad are pressed (for updating
the logger clock, for example). Note: In loggers with firmware rev 10 and older, event 4 is logged
for any completed request from the user. These include manual clock set, a manual call ("call
now"), or entering the Utilities, iPack menu [Home][3][4].

Reserved for future use
I2C error. This event is recorded if the logger encounters an internal data transfer error.

SD Failure. This event is recorded if the logger could not write to SD card due to a damaged SD
microprocessor, damaged SD, or bad sector on the SD. Try a different SD card.

Reserved for future use
Reserved for future use
Reserved for future use
Bad Command. Invalid command request to logger from user or iPack.

Internet clock set. For loggers with firmware revision 11 and higher, this event is recorded each
time the iPack successfully accesses an Internet time server and adjusts the time by more than
two minutes. Time of event is the new time after adjustment has been applied. This time change
will cause a new file, with this event, right after call ends. Since there was more than 2 minutes
time discrepancy, this event usually implies that there was a real time clock problem, or it has
been a long time since the last successful Internet time update. Internet Clock Set in the event
log for loggers with firmware revision 10 or lower indicates that the iPack successfully accessed
the Internet time server and adjusted the logger’s clock by less than 2 minutes.

User Activated iPack. Logged whenever a manual call ("Call Now") is requested, or when
entering the Utilities, iPack menu [Home][3][4].

Note that when an iPack is connected to the logger the logger is powered from the iPack 2 volt regulator. Fresh D Cell
batteries can output a voltage as high as 1.6 volts. Always use high quality Alkaline D-Cell batteries in your loggers!
Lithium D-Cells should be used when the logger will be left unattended for an extended period of time extreme in cold

environments.

Logger Only (no iPack)

1.25 V or better
1.15Vto 1.25V
below 1.15V

Good
Fair
Replace
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Logger with iPack Connected

1.90 V or higher Good
1.15Vto 1.89 V Danger! Logger is not being powered by the iPack battery. iPack battery is likely depleted and

logger is being powered by D-Cells only.

If the battery needs to be changed, refer to instructions for “Opening & Closing the iPack” and change the battery as
follows:

e Pull the battery loose from the Velcro and gently unclip the battery.

e Clip on the new battery. Be sure the clip fully engages the locking tab.
e Install the new battery into the iPack by fixing it to the Velcro. Use a slight “rubbing” motion to make sure the

Velcro sticks.

Carefully close the iPack according to instructions.

SymphoniePLUS3_Data_Logger_Manual | Rev16 19 November 2015 | support@renewablenrgsystems.com || 137



mailto:support@renewablenrgsystems.com




Appendices

Appendices

Opening & Closing the iPack

Installing or changing a GSM SIM card or iPack battery requires opening the iPack. It is important that this is done
carefully to avoid damaging internal wiring or the iPack’s weatherproof seal.

Opening the iPack

Be sure to touch the metal shell of the DB25 connector on the iPack before opening the enclosure in order to safely
discharge any static electricity.

The iPack enclosure consists of two halves secured together by four recessed screws, two from each side of the
enclosure. A gasket in between the two halves and 8 o-rings provide an environmental seal for the iPack and protect the
internal electronics from the elements.

Remove the four recessed screws, and the iPack will separate into two halves connected by a short cable. One half
contains the iPack electronics and the other half contains the rectangular battery, which is secured by Velcro. Try not to
lose any of the o-rings, and be careful not to rip or tear the gasket if it should come loose.

Closing the iPack

Insert the (4) 2-'2 inch mounting screws up through the half of the enclosure that contains the iPack electronics.
Slide the (4) o-rings over the screws.

Set the gasket into the groove of the shell.

Slide the cover (the half with the battery) over screws, being careful not to pinch the battery cable.

Make sure the gasket is not pinched and then install the screws. It is a good idea to make sure the screws fall
back into the existing threads in the iPack enclosure. An easy way to do this is to gently turn the screw
counterclockwise one turn — it will fall into the existing threads in the iPack enclosure.
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Technical Specifications

Technical Specifications

Instrument type

15 channel Internet-enabled micropower wind energy
data logger

Applications

e Wind resource assessment
o Turbine power performance verification

Sensor compatibility - counter
channels
Description

RNRG 40C anemometer or compatible
RNRG Class 1 anemometer

Opto anemometer

Reed switch anemometer

Sensor compatibility - analog
channels

RNRG 200P direction vane

RNRG 110S temperature sensor

o Li-Cor 200SZ pyranometer

¢ RNRG BP-20 absolute pressure (requires optional
iPack power)

e NRG RH-5X relative humidity (requires optional iPack
power)

Counter channels

Channels 1-3 and 13-15 are always counter inputs
supporting:

¢ RNRG 40C anemometer or compatible

e RNRG Class 1 anemometer

e Opto anemometer

e Reed switch anemometer

Maximum counter input frequency is 2500 Hz

Analog channels

Channels 7-12 are always analog inputs:

e Channels 7 and 8 dedicated RNRG 200P direction
vane

e Channels 9-12 use analog Signal Conditioning
Modules (SCMs) to configure each channel for a
particular sensor

Flex channels
Data Collection

Channels 4-6 are 'Flex' Channels

¢ Analog or Counter

e Accept Signal Conditioning Modules (SCMs) to
configure the channel for a particular sensor type

Sampling interval

1 second

Averaging interval

10 minute fixed

Real time clock

Internal battery-backed with leap year correction, 2000
to 2099

Storage medium

128MB Renewable NRG Systems formatted SD Card,
non-volatile FLASH

Maximum data storage

672 files

Parameters recorded for each channel

e Each data interval is time-stamped
¢ Average

e Standard deviation

e Min*

o Max*

* Min and Max not used for wind direction vanes

File format

e Windows compatible
e One (1) 14KB binary file per day
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Technical Specifications

e Header includes site, serial number, and sensor
information

Symphonie Data Retriever (SDR) for Windows
e Scales raw data
¢ Creates measurement database for each site

Software o Creates basic reports
e Maintains site and sensor information
o Configures iPacks
Reader Windows compatible SD Card reader
e SD Cards
Data delivery ¢ Internet email via GSM, CDMA, or Iridium Satellite

with optional iPack

Resolution

Analog measurement resolution

0.1% of full scale (1024 counts)

Counter average stored resolution

0.1% of the value stored

Analog average stored resolution

0.1% of the value stored

Min / Max stored resolution

0.4% of the value stored

Standard deviation stored resolution

4% of the value stored

Configuration

User interface

e Liquid Crystal Display (LCD) 4 x 20 characters
e 16 key pad (6 navigation keys plus numeric/phone
pad) with audible feedback

Configurable parameters

o Clock

o Time zone

o Site number

o Display scaling (defaults are provided for each
channel based on the channel type)

iPack options

o iPack configured via serial port connection to your PC
e Serial connection direct to iPack or through logger's
iPack access port

e Symphonie Data Retriever for Windows integrates
iPack settings

Connections

Sensor wiring

e Sensors connected to field wiring panel

o Field wiring panel plugs into logger

e Ground stud connects to earth ground with included
ground cable

Expansion slots

e Three (3) SCM slots accept analog or counter SCMs
e Four (4) SCM slots accept only analog SCMs

Communication ports

e Male DB25 interfaces to one optional iPack
communications module

o iPack access port provides a connection to the iPack
programming port without dismounting the iPack or
logger

Power requirements

Batteries

Two (2) 1.5 Volt D-Cell Batteries (included)

¢ Nominal voltage: 1.5 Volts

e Minimum voltage: 0.9 Volts

o Battery life approximately one year, depending on
configuration

External power input

Provided by any iPack

External solar input

Provided by any iPack

Other

Optional iPacks provide 12V power required by some
sensors. The Symphonie iPack | Power Only kit provides
power to sensors and logger for stand alone
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Technical Specifications

configurations.

Mounting

e Mounts with 4 bolts (included) to keyed slots inside
of metal shelter box
e Shelter box attaches to tower with hose clamps

Installation e Screwdriver for input terminals (included)
Tools required e 8 mm (5/16 inch) wrench or nut driver for logger
mounting screws and logger ground nuts
-40 °C to 65 °C (-40 °F to 149 °F)
Operating temperature range Note: display readable -30 °C to 55 °C (-22 °F to 130
Environmental °F)
Operating humidity range 0 to 100% RH non-condensing
Lifespan 10 years +
Weight 1.3 kg (2.6 pounds), including batteries
Physical Dimensions (Including Field Wiring Panel) 22.2 cm height, 18.8 cm
width, 7.7 cm depth (8.7 x 7.4 x 3.0in.)
Faceplate Injection molded black ABS
Buttons White elastomer dome keypad
Materials Wiring panel F!bergllass—epoxy terminal board, §ealed gold plated
pins, zinc plated screws and terminals
E Weatherproof polycarbonate
nclosure

SymphoniePLUS3_Data_Logger_Manual | Rev 16

19 November 2015 | support@renewablenrgsystems.com || 143



mailto:support@renewablenrgsystems.com




Glossary
“A carrier”

alphanumeric

analog channel

AMPS cellular

anemometer

ASCII file format

averaging interval

“B" carrier

cellular carrier

counter channel

GSM cellular

GPS

non-volatile

Glossary

A non-wireline or “cellular only” phone company.

Any string of characters that contains letters and numbers in
combination. The SymphoniePLUS3 display is capable of
alphanumeric strings.

An input channel that accepts a voltage or current type sensor
such as a 200P Wind Direction Vane, 110S Temperature Sensor,
Relative Humidity Sensor, or Pyranometer.

Advanced Mobile Telephone System. AMPS is the cellular phone
system that was widely deployed in North America, parts of South
America, Australia, and New Zealand. It is now often referred to as
“analog” cellular to distinguish it from the various digital systems
that use the same channels.

A sensing device that is used to measure wind velocity. The
Symphonie PLUS3 logger collects data from anemometers and other
measurement sensors. The RNRG Class 1 Anemometer and RNRG
40C Anemometer are 3-cup anemometers.

American Standard code for Computer Information Interchange.
ASCII files are “common currency” in the computer world. The
code contains characters including numbers, letters, and standard
punctuation. Symphonie PLUS3 converts raw binary data to ASCII
format files.

The time period over which the logger collects data for averaging.
The averaging interval for the Symphonie PLUS3 Logger is fixed at
10 minutes.

A wireline or “regular” telephone company that also provides
cellular service.

A cellular phone company.

An input channel that is designed to accept frequency or totalizer
type sensors such as anemometers and rain gauges.

Global System for Mobile telecommunications. GSM is the digital
cellular phone system widely deployed in Europe and elsewhere to
replace the various analog systems that were in use before GSM
was adopted.

Global Positioning System

Computer storage that is not affected by a loss of power. The
Symphonie PLUS3 logger uses non-volatile data storage and
therefore does not require a battery to retain information in its
memory.
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offset

POP3

print precision

PV panel

pyranometer

roaming

RS-232 serial port

sampling interval

scale factor

shelter box

Glossary

Also known as intercept. The offset is the measured value for zero
output from a sensor. Symphonie PLUS3 includes an offset field
that can be used for sensors that have non-zero offsets or to
correct for wind direction sensors that are referenced to directions
other than true north. The number that you enter in the offset field
is added to the value that is recorded by SymphoniePLUS3. For
example, the RNRG 110S Temperature Sensor outputs 0 volts at -
86.39 °C. The offset you would enter for the 110S sensor is —
86.39.

Post Office Protocol is a protocol used to retrieve email from a
specified server. POP3 is a newer version of the POP protocol.

Print precision is the number of decimal places you specify in
scaled data numbers. For wind assessment studies, specifying two
decimal places is appropriate. For example, print precision of
(##+#.#4#) yields a number up to 999.99.

Photovoltaic panel. A 15 watt PV panel is an available option for
the Symphonie PLUS3 logger. The PV panel attaches to the outside
of the Symphonie PLUS3 shelter box and uses solar energy to
charge the logger’s batteries.

A sensor that is used to measure total solar radiation. The #LI-
200SA Li-Cor Pyranometer is a dependable and low-cost
pyranometer that can be used for energy studies, site evaluation,
passive solar system analysis, or irrigation scheduling.

Switching from your cellular carrier to another in order to transmit
a call. An example of when roaming is necessary is when a car
with a cellular phone travels beyond the area covered by the
primary cellular carrier.

A standard interface that allows communication between a
computer and other devices. On PC's, the port is often referred to
as a "Comm Port.” Serial ports typically use a 9-pin D shaped
connector.

The time period between samples of the input sensors. The
Symphonie PLUS3 logger samples data once every second. At the
end of the averaging interval, the Symphonie PLUS3 Logger
calculates and stores an average and standard deviation of these
samples.

A number that is used as a multiplier to convert raw data from the
Symphonie PLUS3 logger to useful units of measure (such as °F, or
m/s). The scale factor is often called the “slope” or “transfer
function”. For example, the scale factor for the RNRG 40C
Anemometer is 0.765 m/s per Hz.

The lockable steel enclosure that mounts to a tower or structure
and protects a logger from weather and vandalism.
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SCM

site

standard deviation

storage intervals

Symphonie PLUS3 Data
Retriever

TallTower

text editor
text file

time stamp

turbulence intensity (TI)

uTC
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Glossary

Signal Conditioning Module. An optional plug in module that
provides the electronics to configure the input on channels 4-6 and
9-12 on the Symphonie PLUS3 logger for a particular sensor. The
SCM also tells the logger whether the sensor is a counter
(frequency output), totalizer, vane or linear signal.

The installation location of the Symphonie PLUS3 logger, TallTower,
and sensors. A site is a unique and permanent location.

Symphonie PLUS3 loggers store a site number you assign to identify
the site.

A measure of the central tendency of a collection of data. A small
standard deviation means the data do not vary widely. A large
standard deviation means the data vary more widely. Standard
deviation is calculated as the square root of the variance, where
variance is the average of the squared deviations about the mean.

The period of time that data are gathered before being stored to
non-volatile memory. In SymphoniePLUS3 loggers, the storage
interval is always 10 minutes.

Software supplied by Renewable NRG Systems used to produce
versatile tab-delimited text Data Retriever files from raw data files
collected by the Symphonie PLUS3 logger. Text files can be used
with a wide range of data processing software, including SQL
databases, Microsoft Excel, Microsoft Access, and more. Supports
international numeric formats.

Renewable NRG Systems TallTowers are the original tilt-up tubular
steel meteorological tower. TallTowers are delivered in complete
kits, assembled on the ground and then tilted up and secured with
guy wires.

A simple utility program that can be used to view or edit text files.
A computer file containing only text in ASCIl format.

The time and date that identifies when a record was recorded. All
Symphonie PLUS3 logger data files are time stamped with the
beginning time of the interval.

A measure of the irregularity of air flow over a site. TI is related to
wind speed and terrain and is defined as the ratio of the standard
deviation of the wind speed to the mean of the wind speed.
Average turbulence intensity is the arithmetic mean of the valid TI
values for the reporting period.

Coordinated Universal Time (UTC) is the international time
standard. It is the current term for what was commonly referred to
as Greenwich Meridian Time (GMT). Zero (0) hours UTC is
midnight in Greenwich, England, which lies on the zero longitudinal
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Glossary

meridian. Universal time is based on a 24 hour clock. Afternoon
hours such as 5 pm UTC are expressed as 17:00 UTC (seventeen
hours, zero minutes).

wind direction The compass direction, as compass points (NE, NNE, etc.) or
degrees (0 to 360°) from which the wind is blowing.

wind shear The stress that occurs when adjacent wind layers move at different
speeds or in different directions. Wind shear is measured as the
change in wind speed from a measured anemometer to a
reference anemometer. The measured anemometer is normally the
anemometer at the top of the tower. The reference anemometer is
the lowest anemometer on the tower.
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Warranty

Two Year Limited Warranty

Renewable NRG Systems warrants its products for a period of two years from date of original purchase solely for the
benefit of the original consumer purchaser. If this Renewable NRG Systems product is determined to be defective in
materials or workmanship, Renewable NRG Systems will, at Renewable NRG Systems’ option, repair or replace this
product without charge. This warranty does not cover damage due to improper installation or use, accident or misuse,
lightning or damages due to any unauthorized service. This warranty also will not apply if any seal on any instrument or
sensor is broken, if any cable has been severed, or the equipment was not adequately grounded.

To return a defective product, call Renewable NRG Systems at the telephone number listed below for a RMA return
authorization number. You must also have available when you call the serial number of the item as well as date of
purchase. No products will be accepted for warranty work without a RMA number. The product must be returned,
postage prepaid, to RNRG with a brief description of the problem, RMA number and a return address with phone number.

The foregoing limited warranty is given in lieu of all other warranties, express or implied. Renewable NRG Systems
specifically disclaims all implied warranties including, but not limited to, any implied warranties of merchantability and
fitness for a particular purpose.

The above limited warranty expressly excludes, and RNRG shall not be liable for, any incidental or consequential damages
caused by or related to the use of, inability to use or malfunction of this product.

Prompt disposition: RNRG will make a good faith effort for prompt correction or other adjustment with respect to any
product which proves to be defective within the warranty period. First, contact RNRG or the representative from whom
the product was purchased and ask for a RMA number.

RNRG will also make a good faith effort for prompt service after the warranty period of a product has expired. Please
contact RNRG with the nature of the problem and serial number to obtain a RMA number.

Inspect your shipments for damage to packages or missing packages immediately upon receipt. Record any such
exceptions on the freight receipt of the delivery agent. If any contents are damaged or missing, report this in writing to
the freight carrier and send RNRG a copy of the damage report. If you insured the shipment yourself, report any
damages to your insurance carrier.
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Warranty

Sending Repair Items to Renewable NRG Systems

INTERNATIONAL CUSTOMERS

1. Contact Renewable NRG Systems to obtain an RMA number (Return Material Authorization). Write the RMA
number clearly on all shipping cartons.

2. Send your item to Renewable NRG Systems "Delivery Duty Paid" to the address below using a door-to-door
courier service such as UPS, FedEx, or DHL. If the repair is not urgent, please send your package by Airmail. (Courier
services deliver the package directly to us, customs cleared.)

= Renewable NRG Systems will not accept packages shipped Freight Collect or with Collect charges.
If Renewable NRG Systems refuses the shipment, the courfer service will charge your account return freight
charges.

= DO NOT send return items by direct or consolidated air freight service with an airline.
The cost for air freight may seem lower than the courier service, but air freight costs do not include customs
clearance, airport handling, break bulk fees, and inland delivery to Renewable NRG Systems.

3. Attach a Commercial Invoice to the carton. The Commercial Invoice should include the following information:
= Name and address of the shipper.

Renewable NRG Systems ' complete address and telephone number as the consignee.

Description of the items being returned.

Quantity of each item being returned.

Value for customs / insurance (purchase price or replacement cost).

Number of cartons with respective weights and dimensions.

Please include the following statement to avoid paying US import duties:

"These items are being returned to their U.S. manufacturer. Country of manufacture and origin is
USA,
HTS CODE 9801.00.1012."

4. Pack your repair item in a sturdy packing carton. Tag each item with a brief description of the problem.

5. Insure your shipment against damage or loss in transit. Be sure to check the appropriate box and enter a "Value for
Carriage" (insurance) on your air waybill. The value is the purchase price of the equipment or what it would cost to
replace the equipment if the shipment were lost. Keep a record of the tracking number.

Once your item arrives, we will assess the item and notify you of the repair cost. Any repair charges and freight costs, if
applicable, are payable before Renewable NRG Systems will return the repaired item to you via door-to-door courier
service. Renewable NRG Systems will send you a shipment advisement when the repaired item is shipped.

International Customers:

Before sending the repair item to Renewable NRG Systems, check with your local customs authorities about provisions in
your country for exporting and re-importing repair items. Some countries treat repair shipments like new shipments and

charge import duties and taxes again upon re-importation. Other countries have specific steps to follow or specific forms
to complete which help reduce the import duties upon re-import of the item.

US CUSTOMERS
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Warranty

Please see items 1, 4, and 5 above. Send your item(s) to Renewable NRG Systems “Freight Prepaid and Insured.”
Shipments sent freight collect will not be accepted by Renewable NRG Systems.

Renewable NRG Systems, Inc.

Attn: RMA-

110 Riggs Road
Hinesburg VT 05461 USA
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Configuration Sheet

GSM iPack Data Sheet

GSM Cellular Account Information:

PARAMETER ORIGIN

Found on inside front-cover of Symphonje

Symphonie Serial Number
logger

Name/of company providing GSM service

GSM Service Provider

PIN Rrovided by/user, found\on iPack label

Programming theiPack for internetconnection:

PARAMETER

ORIGIN

Internet Service Provider<iSP)

Name of company
providing internet
service

Earthlink.com

Primary ISP Phone Number Provided by ISP *99" " 1#

Primary DNS Number Provided by ISP, found 0.0.0.0.
on ISP’s web page

Secondary DNS Number Provided by ISP, found 0.0.0.0
on ISP’s web page

Authentication Method Provided by ISP PAT

User Name

Provided/approved by
ISP

ISP@CINGUEARGPRS.COM

User Password

Provided/approved by,
ISP

CINGULAR1

Internet Time Server Name

Provided by usgr

Time-a.nist.gov

Mailbox Name

Proyvided/approved by,
ISP

logger

Mailbox Password Proyidedfapproved by Boat6873
ISP
POP3 Server Name Provided by ISP Pop.myisp.com

SMTP Server Name

Provided/approved by
ISP

Cwmx.com

Patch Password Provided by user 8]5!"66
SMTP Login Provided by ISP logger@myisp.com
SMTP Password Provided by ISP Boat6873

Recipient’s E-mail Address

Provided by user

jsmith@mycompany.com

Recipient’s Name

Provided by user

John Smith

Sender’s E-mail Address

Provided/approved by
ISP

loggcr@myisp.com

E-mail Subject Line

Provided by user

Site 1234 — Derry Mountain

Next Call Time

Provided by user

20:45

Call Interval

Provided by user

1 day
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Configuration Sheet

iPack Data Sheet

Account Information:

PARAMETER ORIGIN
SymphoniePLUS3 Serial | Found on inside front cover of
Number Symphonie PLUS3 logger

Cellular / Satellite
Service Provider

Name of company providing wireless
service

PIN

Usually provided by wireless service
provider

Programming the iPack for Internet connection:

PARAMETER

ORIGIN

Internet Service Provider
(ISP)

Name of company
providing Internet
service

Primary ISP Phone Number

Provided by ISP

Primary DNS Number

Provided by ISP, found
on ISP’s web page

Secondary DNS Number

Provided by ISP, found
on ISP’s web page

Authentication Method

Provided by ISP

User Name

Provided/approved by
wireless service
provider

User Password

Provided/approved by
wireless service
provider

APN Name

Provided by GPRS
service provider (GSM
only)

SMTP Server Name

Provided/approved by
ISP or wireless service
provider

SMTP Login

Provided by ISP

SMTP Password

Provided by ISP

POP3 Server Name

Provided by ISP

Internet Time Server Name

Provided by user

Mailbox Name

Provided/approved by
ISP

Mailbox Password

Provided/approved by
ISP

Internet Time Server

Provided by user

Recipient’s E-mail Address

Provided by user

Recipient’s Name

Provided by user

CC Email Address

Provided by user

CC Email Address 2

Provided by user

Sender’s E-mail Address

Provided/approved by
ISP

E-mail Subject Line

Provided by user

Patch Password

Provided by user

Next Call Time

Provided by user

Call Interval

Provided by user
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Configuration Sheet

Site Data Sheet

Site Number Project Number

Site Name Project Name

Site Location

Latitude Time Zone

Longitude Magnetic Declination

Elevation Prevailing Winds

Installation Crew Phone Numbers:
(hotel, cell phone, etc.)

Site description (tree
types, hills, etc.)

Terrain Features
(obstructions, distances
from tower)

Soil Type

Installation Date

Removal Date

Field Contact Information

Company

Contact Person

Address

Phone Number

Fax Number

e-mail Address
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Sensors

Anemometers — Attach calibration sheets for any calibrated anemometers

Configuration Sheet

Anemometer 1

Anemometer 2

Anemometer 3

Anemometer 4

Anemometer 5

Anemometer 6

Monitoring
height

Serial Number

Primary or
Redundant?

Mounting
Orientation
(degrees —
magnetic)

Boom length

Calibration Date

Slope

Offset

Logger
Channel
Number:

Comments:

Anemometer 7

Anemometer 8

Anemometer 9

Monitoring
height

Serial Number

Primary or
Redundant?

Mounting
Orientation
(degrees —
magnetic)

Boom length

Calibration Date

Slope

Offset

Logger
Channel
Number:

Comments:
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Configuration Sheet

Wind Vanes

Wind Vanel Wind Vane 2 Wind Vane 3 Wind Vane 4 Wind Vane 5 Wind Vane 6

Monitoring
Height

Serial Number

Mounting
Orientation
(degrees —
magnetic)

Boom Length

Deadband
Orientation
(degrees)

Logger
Channel
Number

Comments

Other Sensors

Sensor 1 Sensor 2 Sensor 3 Sensor 4 Sensor 5 Sensor 6 Sensor 7

Sensor Type

Monitoring
Height

Serial Number

Mounting
Orientation
(degrees —
magnetic)

Slope

Offset

Logger
Channel
Number

Comment

Diameter

Comments

Site Photographs
Take pictures in 8 directions at tower base and several pictures showing the surrounding terrain.

North
Northeast
East
Southeast
South
Southwest
West
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Configuration Sheet

Northwest
Site & surrounding area
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Time Zones

Time Zones
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Declaration of Conformity

EU Declaration of Conformity

RENEWABLE

I a 110 Riggs Road 802 482-2255
Hinesburg, VT 05461 USA 802

Declaration of Conformity
(in accordance with ISO/IEC 17050-1:2004)

Supplier: Renewable NRG Systems

Supplier Address: 110 Riggs Road, Hinesburg, VT 05461, USA
Telephone: 802 482 2255, Fax: 802 482 2272
Email: sales@rnrgsystems.com

Declares that the Product: SymphoniePLUS3 Logger System, including:

Logger-SymphoniePLUS3, with accessories Item 4941

SCM Cards Items 3075, 3070, 3988, 3673, 3077, 3253, 3252,
3073, 3583, 3076, 3071, 3072, 3078, 3742, 3743,
3074, 6925, 6946, 6646 :

Symphonie iPacks Items 3860, 3533, 4222, 3531, 3146, 3861, 4620,
4621, 4622, 4623, 7169, 7984

is in conformity with the requirements of the following documents:

EN61326-1 Class A “Electrical Equipment for Measurement, Control, and Laboratory Use—EMC
Requirements”, in accordance with: CISPR 11; EN 61000-4-2; EN 61000-4-3; EN 61000-4-8; EN 61000-
4-4; EN 61000-4-20; 61000-4-6

IEC 61010-1 “Safety requirements for electrical equipment for measurement, control, and laboratory use”

Additional Information:

This product complies with the requirements of the applicable directives 2006/95/EC, 2004/108/EC; and
standard EN 61010-1 and therefore, the product is CE marked in accordance with 93/68/EEC.

FCC compliance is demonstrated with compliant CISPR data.

The design documentation, test reports, and assessment laboratory accreditation are under document
control in NRG Engineering.

7
Issued at Hinesburg, VT, USA J /l'w lﬂcm/{
30 Jul 2014 Phil Pouech
RA Engineering Manager

SEE THE POTENTIAL
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References

References

Some of our products incorporate software that is available in the open source community, including www.freertos.org
(version 6.00) and www.savannah.nongnu.org. The information that follows is provided to comply with the terms of use.

www.freertos.org
FreeRTOS is a real time operating system available in the open source community and utilized in the iPackGPS. Source

code is available from Renewable tems upon request.

www.savannah.nongnu.org
We are using the IwIP lightweight TCP/IP stack in the iPackGPS.

(Copyright (c) 2001-2004 Swedish Institute of Computer Science. All rights reserved.)

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following
conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR TAS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Index

(.wmf file format), 91

Analog channels, SCM slots, 26
Anemometer, 30

Antenna Connection, 72
antenna test, 76

antenna test from SDR software, 76
ASCII files (.txt), 89

ATModem cable, 41
Authentication Method, 49
Backing up data files, 85
Batch processing, 90

Batch Processing” window, 98
Batteries, 16, 25, 26, 27, 28, 59, 81, 83
battery messages, 134

battery, changing iPack, 135
BER. See Bit Error Rate

Bit error rate, 77

Cable, ATModem, 41

Call Interval, 54

Call Now function, 78

Call Schedule Programming, 53
Card Reader, MMC, 35

Card Reader, SD, 14, 85

Card slot, SD, 74

Cellular Signal Strength, 76
Changing iPack settings, 113
CHAP authentication method, 38
Checking iPack status, 76
Checking logger measurements, 74
Checking logger status, 73
Checking SD status, 74
Cleaning, 83

Clock, 25, 31

Clock battery, 25

Clock battery, longevity, 25
commas, 91

Configuration patch, 114
Configuration, iPack, 56
Connector, field wiring panel, 25
convert raw data files, 90
Counter channel, 26

Counter channels, SCM slots, 26
Creating a new site, 107
Creating a patch file, 113
Creating a site file manually, 108
Creating reports, 103

Data Encryption PIN Number, 32
Data Filtering window, 102
Data Flag types, 102

Data header, viewing, 86
Data Retriever software, 16, 19, 23
Data Viewer, SDR, 88, 89, 90

EU Declaration of Conformity

D-cells, 25, 28

Descriptive Headers, 90

Dial-Up iPacks, 38, 48

Disabling descriptive headers, 90

Display, 25, 28

DNS, primary, 49

DNS, secondary, 49

Domain Name Service (DNS), 38

Editing Height, 31, 110

Editing Offset, 31, 94, 110

Editing reports, 105

editing scale factor, 110

Editing Serial number, 11

Editing Units, 31, 109, 110

Electronic Serial Number (ESN), 38

Electrostatic discharge (ESD), 19, 27

Erase, 74

ESD, 19, 25, 26, 27

Export file formats, 100

Exporting data, 100

Field Installation, 61

Field wiring panel, 25

Field Wiring Panel, 68

File, iPack (.ipk), 114

File, text, 145

filename.log, 90

Filtering all channels, 103

filtering data for export, 100

Fixing timestamps, 94

Grounding, 19, 20, 25, 27, 41, 61

GSM iPack, 38, 43

GSM iPack Data Sheet, 38

Height, 31, 110

Hose Clamps, 67

Hourly averages, 91

Icing data, 103

Imperial units, 28, 29, 31, 32, 110

Importing data, 97

Importing raw (.rwd) files, 98

Importing scaled ASCII (.txt) files, 99

Input connector, 25

Installing a Stand Alone Symphonie Logger, 62

Installing SCMs, 27

Installing the iPack to the Logger, 59

Internet Service Provider (ISP), 38, 49

Invalid data, 103

IPack, 13, 14, 16, 26, 27, 35, 37, 38, 41, 42, 43, 45, 47,
48, 49, 50, 51, 53, 54, 56, 58, 59, 60, 62, 63, 64, 65,
73,76, 78, 79, 80, 85, 86, 109, 114

IPack access port, 25

iPack battery, changing, 135

iPack configuration, 56



iPack configuration, Symphonie Data Retriever software,
41

iPack file (.ipk), 114

iPack settings, changing, 113

iPack, checking status, 76

iPack, Dial-up, 38, 48

iPack, GSM, 38, 43

iPack, opening and closing, 137

ISP Programming, 47, 48, 50, 52, 54

Keypad, 24

Keypad Security, 32

Latitude & longitude, 32

Logger Status Screen, 73

Maintenance check list, 83

Measurement units, 31, 109, 110

MMC Card Reader, 35

Modify iPack Window, 48, 58

Mounting holes, 63

Mounting the Shelter Box, 66

Navigation keys, 25

Next Call Time, 54

Office Testing, 59

Offset, 31, 94, 110

on-air time, 79

opening and closing the iPack, 137

PAP authentication method, 38

Patch file, 113

Patch files, 113

Patch Password, 53

Personal Identification Number (PIN), 32, 38, 45

Phone number, secondary ISP, 49

Photovoltaic panel, 60, 64

POP3 server, 38, 51

Primary DNS, 49

programming adapter, 25

PV panel, 60, 64

raw data files (.rwd), 85

Raw Files working directory, 85

Reader, MMC Cards, 35

Reader, SD Cards, 14, 85

Received Signal Strength Indicator, 77

Report types, 104

Reports, 103

Reset Button, 25

RSSI, 77

Scale factor, 110

scaled data working directory, 89

SCM slots, analog channels, 26

SCM slots, counter channels, 26

SCMs, 16, 19, 25, 26, 27, 28, 95

SCMs, installing, 27

SD Card, 13, 14, 16, 19, 23, 26, 32, 35, 74, 83, 85, 91,

Index

109

SD card reader, 35

SD Card reader, 35

SD Card Reader, 14, 85

SD card slot, 74

SD, checking status, 74

SDR main window, 85

Secondary DNS, 49

Secondary ISP Phone Number, 49

security key, 33

Sending a patch file, 115

Sensor Connection, 69

Sensor connections, troubleshooting wizard, 94

Sensor history, troubleshooting wizard, 94

Sensor lists, 28

Sensor patch, 113

Sensor wires, 69

Serial number, 11

Serial number, electronic (ESN), 38

Setting & verifying, latitude & longitude, 31

Setting & verifying, logger clock, 31

Setting & verifying, site altitude (elevation), 31

Setting & verifying, site number, 31

Setting & verifying, time zone, 31

SI (metric) units, 28, 29, 31, 32, 110

Signal conditioning module (SCM), 16, 19, 25, 26, 27,
28, 95

SIM card, GSM, 38, 43, 45

site commissioning data, 87

Site file, 107

site files, 85

Site information editor, SDR, 108, 109, 110

Site information parameters, SDR, 108

Site information, SDR, 87, 107, 108, 109, 110

Site maintenance, 83

Site Visits, 83

SMTP Server Name, 50

Standard deviation, 145

Standard Time, 31, 73

Static, 19

Status menu, 73

Status, iPack, 76

Status, SD card, 74

Symphonie Data Retriever software, 16, 19, 23

Symphonie Data Retriever software, iPack configuration,
41

System requirements, Symphonie Data Retriever
software, 35

tabs, 91

TallTower, 61, 62

Technical support, 11, 35

Text file, 145
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time server, 79

Time zone, 109

Tools, field installation, 61, 83
Troubleshooting wizard, SDR, 94
Unfiltering all data, 103

Units, 31, 109, 110

Units, measurement, 31, 109, 110
USB port, 35

User name, 49

User password, 49

version number, SDR, 86

SymphoniePLUS3_Data_Logger_Manual

Rev 16

View database, 97

Viewing Data Header, 86
Warning LED, clock battery, 25
WASP data, 100

Wind shear, 146

WindLinx, 13, 14, 37, 38, 41, 42, 43, 47

Wiring, 69
working directory for raw files, 91
working directory for Reports, 91

working directory for saved TXT files, 91

working directory for Site files, 91
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NRG 40C Anemometer

NRG 40C ANEMOMETER

The 40C Anemometer offers field-proven measurement accuracy at an economical price.

DESCRIPTION
Sensor type

Applications

Sensor range

Instrument
compatibility

OUTPUT SIGNAL

Signal type

Anemometer
Transfer Function

Output voltage at
threshold

Output voltage at
60Hz

Calibration

Output signal range

Uncertainty

RESPONSE

CHARACTERISTICS

NRG 40C Anemometer | MEASNET Calibrated (#1900)

3 Cup Anemometer

« Wind resource assessment
« Meteorological studies
« Environmental monitoring

1m/s to 96 m/s (2.2 mph to 215 mph) (highest recorded)

AlL RNRG loggers

Low level AC sine wave, frequency linearly proportional to wind speed

Consensus Transfer Function:

Scale Factor (Slope): 0.765 m/s/Hz (1.711 mph/Hz)

Offset: 0.35 m/s (0.78 mph)

Refer to the white paper "The Maximum Type 40 Anemometer
Calibration Project" for more information on the consensus
transfer function

All RNRG 40C Anemometers are calibrated per IEC 61400-12-1,
Annex F

80 mV (peak-to-peak) minimum

« 12V (peak-to-peak) typical
« Output amplitude NOT proportional to wind speed

Each anemometer individually calibrated, calibration reports provided via
electronic download

0 Hz to 125 Hz (at 96m/s, highest recorded)

Accuwind (Riso-R-1556) Classification:

Class 2.4A

Class 7.7B

IEC 61400-12-1 operational standard uncertainty:

+0.14 m/s at 10 m/s for Class A

+ 0.45 m/s at 10 m/s for Class B

Refer to calibration sheet for information on calibration
uncertainty

Refer to application note "#40C Anemometer Uncertainty" for
definitions and more information

https://www.nrgsystems.com/products/met-sensors/anemometers/print/40c-anemometer

NRGSystems.

NRG 40C Anemometer | CPH MEASNET Calibrated
(#4350)

3 Cup Anemometer

« Wind resource assessment
« Meteorological studies
« Environmental monitoring

1 m/s to 96 m/s (2.2 mph to 215 mph) (highest
recorded)

AlLRNRG loggers

Low level AC sine wave, frequency linearly
proportional to wind speed

See individual calibration report

80 mV (peak to peak) minimum

« 12V (peak-to-peak) typical
« output amplitude NOT proportional to wind
speed

Each anemometer individually calibrated,
calibration reports provided via electronic
download

0 Hz to 125 Hz (at 96m/s, highest recorded)

Accuwind (Riso-R-1556) Classification:

Class 2.4A

Class 7.7B

IEC 61400-12-1 operational standard
uncertainty:

+0.14 m/s at 10 m/s for Class A

+0.45 m/s at 10 m/s for Class B

refer to calibration sheet for information on
calibration uncertainty

refer to application note "#40C Anemometer
Uncertainty" for definitions and more
information

12
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Distance constant
(63% recovery)

Moment of inertia

Swept diameter of
rotor

INSTALLATION

Mounting

Tools required
ENVIRONMENTAL

Operating
temperature range

Operating humidity
range

PHYSICAL
Connections
Weight

Dimensions

MATERIALS
Cups

Body

Shaft
Bearing

Magnet

Coil

Boot

Terminals

https://www.nrgsystems.com/products/met-sensors/anemometers/print/40c-anemometer

NRG 40C Anemometer

NRG 40C Anemometer | MEASNET Calibrated (#1900)

« 2.55m (8.37 feet) at 5m/s per ASTM D 5096-02
« 2.56 m (8.40 feet) at 10m/s per ASTM D 5096-02

« 1.01 x 10" kg-m?
. 74.5x10°8 S-ft?

190 mm (7.5 inches)

Onto a 13 mm (0.5") diameter mast with cotter pin and set screw

0.25 inch nut driver, petroleum jelly, electrical tape

-55°Cto 60 °C (-67 °F to 140 °F)

0t0100% RH

4-40 brass hex nut/post terminals

0.14 kg (0.3 lbs)

« 3 cups of conical cross-section, 51 mm (2") dia.
« 81 mm (3.2") overall assembly height

One piece injection-molded black polycarbonate

Housing is black ABS plastic

Beryllium copper, fully hardened

Modified Teflon, self-lubricating

Indox 1, 25 mm (1 inch) diameter, 13 mm (0.5 inch) long, 4 poles

Single coil, bobbin wound, 4100 turns of #40 wire, shielded for ESD

protection

Protective PVC sensor terminal boot included

Brass

NRG 40C Anemometer | CPH MEASNET Calibrated
(#4350)

« 2.55m (8.37 feet) at 5m/s per ASTM D 5096-02
« 2.56 m (8.40 feet) at 10m/s per ASTM D 5096-
02

« 1.01x107%kg-m?
. 745x10° 5-ft2

190 mm (7.5 inches)

Onto a 13 mm (0.5") diameter mast with cotter pin
and set screw

0.25 inch nut driver, petroleum jelly, electrical tape

-55°Cto 60 °C (-67 °F to 140 °F)

0t0100% RH

4-40 brass hex nut/post terminals
0.14 kg (0.3 lbs)

« 3 cups of conical cross-section, 51 mm (2") dia.
« 81 mm (3.2") overall assembly height

One piece injection-molded black polycarbonate
Housing is black ABS plastic

Beryllium copper, fully hardened

Modified Teflon, self-lubricating

Indox 1, 25 mm (1 inch) diameter, 13 mm (0.5 inch)
long, 4 poles

Single coil, bobbin wound, 4100 turns of #40 wire,
shielded for ESD protection

Protective PVC sensor terminal boot included

Brass

NRG Systems - 110 Riggs Road * Hinesburg, Vermont 05461 « +1 802-482-2255 « info@nrgsystems.com
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NRG 200P WIND VANE

The 200P Wind Vane is one of the most widely used wind direction sensors in wind, solar, and meteorological applications
worldwide.

NRGSystems.

DESCRIPTION
Sensor type

Applications

Sensor range
Instrument compatibility
OUTPUT SIGNAL

Signal type

Transfer function
Accuracy

Dead band

Output signal range

RESPONSE
CHARACTERISTICS

Threshold

POWER REQUIREMENTS

Supply voltage
INSTALLATION

Mounting

Tools required
ENVIRONMENTAL

Operating temperature
range

Operating humidity range
Lifespan

PHYSICAL

Connections

Weight

Dimensions

200P Wind Direction Vane (#1904)

Continuous rotation potentiometric wind direction vane

« Wind resource assessment
« Meteorological studies
« Environmental monitoring

360° mechanical, continuous rotation

All Symphonie Data Loggers

Analog DC voltage from conductive plastic potentiometer,
10K ohms

Output signal is a ratiometric voltage

Potentiometer linearity within 1%

8° Maximum, 4° Typical

0V to excitation voltage (excluding deadband)

1m/s (2.2 mph)

Regulated potentiometer excitation of 1V to 15V DC

Onto a 13 mm (0.5 inch) diameter mast with cotter pin and
set screw

0.25 inch nut driver, petroleum jelly, electrical tape

-55°C to 60 °C (-67 °F to 140 °F)

0to 100% RH

50 million revolutions (2 to 6 years normal operation)

4-40 brass hex nut/post terminals

0.14 kg (0.3 pounds)

« 21 cm (8.3 inches) length x 12 cm (4.3 inches) height
« 27 cm (10.5 inches) swept diameter

https://www.nrgsystems.com/products/met-sensors/wind-direction-vanes/print/200p-wind-vane

200P Wind Direction Vane | Calibrated (#2274)

Continuous rotation potentiometric wind direction vane

« Wind resource assessment
« Meteorological studies
« Environmental monitoring

360° mechanical, continuous rotation

All Symphonie Data Loggers

Analog DC voltage from conductive plastic potentiometer,
10K ohms

Output signal is a ratiometric voltage

Potentiometer linearity within 1%

8° Maximum, 4° Typical

0V to excitation voltage (excluding deadband)

1m/s (2.2 mph)

Regulated potentiometer excitation of 1V to 15V DC

Onto a 13 mm (0.5 inch) diameter mast with cotter pin and
set screw

0.25 inch nut driver, petroleum jelly, electrical tape

-55°C to 60 °C (-67 °F to 140 °F)

0to0100% RH

50 million revolutions (2 to 6 years normal operation)

4-40 brass hex nut/post terminals

0.14 kg (0.3 pounds)

« 21 cm (8.3 inches) length x 12 cm (4.3 inches) height
« 27 cm (10.5 inches) swept diameter

12
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MATERIALS
Wing

Body

Shaft
Bearing
Boot

Terminals

https://www.nrgsystems.com/products/met-sensors/wind-direction-vanes/print/200p-wind-vane

NRG 200P Wind Vane

200P Wind Direction Vane (#1904)

Black UV stabilized injection molded plastic

Black UV stabilized static-dissipating plastic

Stainless steel

Stainless steel

Protective PVC sensor terminal boot included

Brass

200P Wind Direction Vane | Calibrated (#2274)

Black UV stabilized injection molded plastic

Black UV stabilized static-dissipating plastic

Stainless steel

Stainless steel

Protective PVC sensor terminal boot included

Brass

NRG Systems - 110 Riggs Road * Hinesburg, Vermont 05461 » +1 802-482-2255 + info@nrgsystems.com
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Light
Vleasurement

| L1-COR: |

The Standard for over 40 Years




INntroduction

LI-COR radiation sensors measure the flux of radiant energy—the
energy that drives plant growth, warms the earth, and lights our
world. The properties of radiant flux depend on the wavelength of
the radiation. Pyranometers are sensitive to the broadest waveband.
Photometric sensors measure visible radiation (light). Quantum sen-
sors measure Photosynthetically Active Radiation (PAR)—the radiant
energy used in photosynthesis. These three sensor types cover a
wide range of applications:

& ecology

” meteorology

solar energy
plant research
indoor lighting
underwater

painseaw pueganep)

P EE A

Photometric Sensor
(Visible Light)

Quantum Sensor
(Photosynthetically Active Radiation)

Pyranometer
(Global Solar Radiation)




ToE Sersers

LI-COR sensors are weather resistant, low maintenance, and
cosine corrected. From the shape of the crown to the pho-
todiodes and optical filter glass, every aspect is the result
of scientific inquiry.

The sensor design features a large drain to shed water, and
a more robust housing to help prevent water ingress, increas-
ing the lifespan of the sensors and reducing measurement
drift. A detachable sensor head allows for replacement and
factory recalibration without removing the cable from the
mounting structure.

Water shedding design

Interchangeable heads

Detachable base

Multiple output signals




[-200
“vranometer

The LI-200R Pyranometer is meant to be used outdoors under unob-
structed natural daylight conditions. It measures global solar radia-
tion—the combination of direct and diffuse solar radiation—in the
400 to 1100 nm range. Measurement units are in watts per square
meter (W m2).

Ideal for agricultural, meteorological, solar energy, and environmental
research, the LI-200R is available with a variety of cable lengths and
output signals for compatibility with most data loggers.




Why choose the LI-200R?

Weather resistant and durable in long-term outdoor

deployments

Measures global solar radiation under unobstructed
natural daylight conditions

Uniform sensitivity up to 82° incident angle

Detachable sensor simplifies installation and removal,
making it ideal for platforms with complex cabling

How does it work?

The LI-200R measures global solar radiation with an unfil-
tered silicon photodiode. Its measurements correspond
closely to first-class thermopiles when used outdoors
under unobstructed natural daylight conditions.

The crown of the sensor rapidly sheds water, and also
physically blocks light from outside the hemisphere of
sensitivity, providing a precise cosine response.

400

500

600

700

1100

(wu) yr1Busjanepp
painseaw pueqanepn

LI-200R Specifications

Absolute Calibration: Calibrated
against an Eppley Precision Spectral
Pyranometer (PSP) under natural
daylight conditions. Calibration
uncertainty under these conditions
is estimated as + 3% typical, within
+ 60° angle of incidence.*
Sensitivity: Typically 75 pA per
1,000 W m??

Linearity: Maximum deviation of
1% up to 3,000 W m™?

Response Time: Less than 1 us
(2 m cable terminated into a 147
Ohm load)

Temperature Dependence: + 0.15%
per °C maximum

Cosine Correction: Cosine cor-
rected up to 82° angle of incidence

Azimuth: < + 1% error over 360°
at 45° elevation

e Tilt: No error induced from orientation

e Operating Temperature Range:
-40°Cto65°C

e Relative Humidity Range: 0% to
95% RH, Non-Condensing

e Detector: High stability silicon
photovoltaic detector (blue
enhanced)

e Sensor Housing: Weatherproof
anodized aluminum body with
acrylic diffuser and stainless steel
hardware; O-ring seal on the
sensor base

e Size: 2.36 cm diameter x 3.63 cm
(0.93" x 1.43")

e Weight: 24 g head; 60 g base and
cable (2 m) with screws

e Cable Length:2m,5m, 15 m,
50 m (6.5, 16.4', 49.2', 164")

Specifications subject to change without notice.
*Preliminary specification



I-190R measures Photosynthetically Active Radiation (PAR, in pmol
otons m? s). It provides accurate measurements—in the open, in
greenhouses, under plant canopies, or in growth chambers—for most
broad-spectrum light sources, including natural sunlight, artificial, or
mixed sources.

Plants use light in the wavelength range from about 400 to 700 nm to
drive photosynthesis. The efficiency with which plants use light varies
somewhat across this range, but McCree' showed that measuring PAR
provided a consistent way to predict plant photosynthetic response
regardless of the spectrum of the light source.?

1. McCree, K.J., 1972. The action spectrum, absorptance and quantum yield of photosynthesis in crop plants. Agric. Meteorol. 9: 191-216.
2. McCree, KiJ5 f current definitions of photosynthetically active radiation against leaf photosynthesis data. Agric. Meteoro

&



Why choose the LI-190R?

= Uniform sensitivity across the PAR waveband for
accurate measurements outdoors, under vegetation,
or in artificial lighting without changing the calibration

" Newly designed optical filter tailors the spectral
response to an unprecedented performance standard

= Weather resistant and durable in high-temperature,
high-humidity, long-term deployments

= Cosine correction is accurate even when the light
source is not directly overhead

= Sensor heads are detachable and interchangeable
for simplified installation, removal, and recalibration

How does it work?

A high-quality silicon photodiode is matched with a spe-
cially designed glass optical filter to create nearly uniform
sensitivity to all the wavelengths within the PAR wave-
band (400 to 700 nm). This ensures accurate
measurements irrespective of the light source. The glass
filter excludes light with wavelengths outside the PAR
waveband. Exclusion of wavelengths beyond 700 nm is
critical for measurements under vegetation.

400

LI-190R Specifications

e Absolute Calibration: + 5% trace-

500

Standards and Technology (NIST)

(wu) yrbusjonepp
painseaw pueqanepn

per 1,000 pmol s m

o e Linearity: Maximum deviation of

1% up to 10,000 pmol s m?
e Response Time: Less than 1 ps

(2 m cable terminated into a 604
Ohm load)

700

per °C maximum

e Cosine Correction: Cosine cor-

a 45° elevation

e Tilt: No error induced from
orientation

1100

able to the U.S. National Institute of

e Sensitivity: Typically 5 pA to 10 pA

e Temperature Dependence: + 0.15%

rected up to 82° angle of incidence
e Azimuth: < + 1% error over 360° at

Response (Arbitrary Units)
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Operating Temperature Range:
-40°Cto65°C

Relative Humidity Range: 0% to
95% RH, Non-Condensing

Detector: High stability silicon
photovoltaic detector (blue
enhanced)

Sensor Housing: Weatherproof
anodized aluminum body with
acrylic diffuser and stainless steel
hardware; O-ring seal on the
sensor base

Size: 2.36 cm diameter x 3.63 cm
(0.93" x 1.43")

Weight: 24 g head; 60 g base and
cable assembly (2 m) with screws

Cable Length: 2 m, 5 m, 15 m,
50 m (6.5, 16.4', 49.2', 164)

Specifications subject to change without notice

©
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Why choose the LI-210R?

= Spectral response closely matches the CIE Standard
Observer Curve

= Excellent cosine response—sensitive to light from all
directions up to an 82° angle of incidence

= Detachable sensor simplifies installation and removal,
making it ideal for platforms with complex cabling

How does it work?

The LI-210R measures light with a precision filtered sili-
con photodiode that is sensitive to light in the visible

spectrum.
0.25 \ Typical
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o -2 LI-210R Specifications
% § e Absolute Calibration: + 5% traceable °
28 to the U.S. National Institute of A
500 E S‘ Standards and Technology (NIST)
i § e Sensitivity: Typically 30 pA per 100 o
=
= klux
600 g . . . L
e Linearity: Maximum deviation of 1% .
up to 100 klux
o e Stability: < + 2% change over a 1 N
year period

e Response Time: Less than 1 ys
(2 m cable terminated into a 604

Ohm load) °
e Temperature Dependence: + 0.15%
per °C maximum o

e Cosine Correction: Cosine corrected
up to 82° angle of incidence °

e Azimuth: < + 1% error over 360° at
45° elevation

1100

spectral response of the
LI-210R Photometric Sensor.

Tilt: No error induced from orientation
Operating Temperature Range:
-40°Cto65°C

Relative Humidity Range: 0% to
95% RH, Non-Condensing
Detector: High stability silicon photo-
voltaic detector (blue enhanced)
Sensor Housing: Weatherproof anod-
ized aluminum housing with acrylic
diffuser and stainless steel hardware;
O-ring seal on the sensor base

Size: 2.36 cm diameter x 3.63 cm
(0.93"x 1.43")

Weight: 24 g head; 60 g base and
cable assembly (2 m) with screws
Cable Length: 2m, 5m, 15 m,

50 m (6.5, 16.4', 49.2', 164")

Specifications subject to change without notice



The LI-191R Line Quantum Sensor measures PAR integrated over its
1-meter length. It is used to measure sunlight under a plant canopy,
where the light field is non-uniform. The LI-191R makes it easy to
measure under—canopy light in many plots quickly and consistently.
- nlts of Photosynthetlc Photon Flux Density

sed as ymol s m=.




Why choose the LI-191R?

= Improved water resistance for long-term outdoor
deployment

® Integrated measurements using a single detector
prevents variance found in sensors that use multiple
detectors

= Selected by the National Ecological Observatory
Network (NEONP®) for integrated PAR measurements

How does it work?

The LI-191R uses a 1-meter long quartz rod under a dif-
fuser to direct light to a single filtered silicon photodiode.
The entire LI-191R diffuser is sensitive to light over its
1-meter length. Since the diffuser is one continuous piece,
the LI-191R essentially integrates an infinite number of
points over its surface into a single value that represents
light from the entire 1-meter length. Optical filters block
radiation with wavelengths beyond 700 nm, which is criti-
cal for under-canopy measurements, where the ratio of
infrared to visible light may be high. The unique design of
the LI-191R provides an excellent quantum response that
is close to the ideal quantum response.

e Absolute Calibration: + 10%
traceable to National Institute of
Science and Technology (NIST).
The LI-191R is calibrated via
transfer calibration using a refer-
ence LI-190R Quantum Sensor.
Transfer error is + 5% (included in
the = 10%)

e Sensitivity: Typically 7 yA per 1,000
pgmol s m

painseaw pueqenep)

e Linearity: Maximum deviation of
1% up to 10,000 pmol s m=

e Response Time: 10 us

e Temperature Dependence: = 0.15%
per °C maximum

e Cosine Correction: Acrylic diffuser

e Azimuth: < + 2% error over 360° at
45° elevation

e QOperating Temperature Range:
-40°Cto65°C

LI-191R Line Quantum Sensor Specifications

Relative Humidity Range: 0% to
95% RH, Non-Condensing

Sensitivity Variation over Length:
+ 7% maximum using a 2.54 cm
(1) wide beam from an incandes-
cent light source.

Sensing Area: T m x 12.7 mm
(39.4" x 0.50")

Detector: High stability silicon
photovoltaic detector (blue
enhanced)

Sensor Housing: Weatherproof
anodized aluminum housing with
acrylic diffuser and stainless steel
hardware.

Size: 121.3 L x 254 W x 2.54 cm D
(477" x1.0" x 1.0")

Weight: 1.4 kg (3.0 Ibs.)
Cable Length: 2 m, 5 m (6.5', 16.4")
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Why choose the LI-192?

Designed for immersion

Rugged, corrosion-resistant sensors for use in fresh
and saltwater environments

Ideal for oceanography, limnology, turbidity, and

vertical profiling

Suitable for submerged and out-of-water

measurements

How does it work?

The LI-192 uses a silicon photodiode and a glass optical
filter to create nearly uniform sensitivity to light between
400 and 700 nm, which closely corresponds to light used
by most terrestrial and aquatic plants and algae. A preci-
sion optical filter blocks light with wavelengths beyond 700
nm, which is critical for measurements in a water column,
where the ratio of infrared to visible light may be high.

400

500

600

700

1100

(wu) yrbusjonepp
painseaw pueqanepn

LI-192 Specifications

Absolute Calibration: = 5% in air
traceable to NIST

Sensitivity: Typically 4 pA per 1,000
pumol s m~2 in water

Linearity: Maximum deviation of
1% up to 10,000 pmol s m™
Response Time: 10 us
Temperature Dependence: + 0.15%
per °C maximum

Cosine Correction: Optimized for
underwater and atmospheric use
Azimuth: < = 1% error over 360° at
45° elevation

Operating Temperature Range:
-40°Cto65°C

Detector: High stability silicon
photovoltaic detector (blue
enhanced)

e Sensor Housing: Corrosion resis-
tant metal with acrylic diffuser for
both saltwater and freshwater
applications. Waterproof to
withstand approximately 5500 kPa
(800 psi), 560 meters.

e Size: 3.18 cm diameter x 4.62 cm
height (1.25" x 1.81")

e Weight: 227 g (0.5 Ibs.)

e Mounting: Three 6-32 holes are
tapped into the base for use with
the 2009S Lowering Frame or
other mounting devices

e Cable: Requires 2222UWB
Underwater Cable (available in 3,
10, 30, 50, 100 meter lengths)

Specifications subject to change without notice.
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The LI-193 Spherical Quantum Sensor
AR in air or underwater

ctions at depths up to 350

“his sensor is useful for stud-

ies of phytoplankton, which uses radia-
tion from all directions. The measure-
is referred to as Photosynthetic

- Photon Flux Fluence Rate (PPFFR) or

Quantum Scalar Irradiance.



Why choose the LI-193?

= Designed for immersion
" Measures PAR from all directions

= |deal for oceanography, limnology, turbidity, and
vertical profiling

How does it work?

The LI-193 uses a diffusive sphere to direct light through
glass optical filters to the silicon photodiode. The filters
create nearly uniform sensitivity to light between 400 and
700 nm, which closely corresponds to light used by most
terrestrial and aquatic plants and algae. The angular
response of a typical LI-193 is slightly lower in the direc-
tion of the cable connection. When mounted, the low
response is usually not significant due to the small pro-
portion of upwelling radiation compared to the total.

Typical angular response of the LI-193.

00 =z LI-193 Specifications
3 § e Absolute Calibration: + 5% in air e Sensor Housing: Corrosion resistant
é g traceable to NIST metal for both saltwater and fresh-
500 5 g' e Sensitivity: Typically 7 pA per 1,000 water applications with an injection
i § umol s m2 in water molded, impact resistant, acrylic
< e Linean WA ihd 0h AT diffuser. Units have been tested to
[ . .
400 kP .
600 o 1% up to 10,000 pmol s m- 3,. 00 kPa (500 psi), 350 meters
e Stability: < + 2% change over a 1 * Size:
year period Globe: 6.1 cm diameter (2.4")

700

1100

e Response Time: 10 ps
e Temperature Dependence: + 0.15%
per °C maximum

e Angular Response: < + 4% error up
to + 90° from normal axis (see
Angular Response chart)

e Azimuth: < + 3% error over 360° at
90° from normal axis

e QOperating Temperature Range:
-40°C to 65 °C

e Detector: High stability silicon
photovoltaic detector (blue enhanced)

Housing: 3.18 cm diameter (1.25")
Overall Height: 10.7 cm (4.2")

e Weight: 142 g (0.31 Ibs.)

e Mounting: Three 6-32 mounting
holes are tapped into the base for
use with the 2009S Lowering
Frame or other mounting devices.

e Cable: Requires 2222UWB
Underwater Cable (available in 3,
10, 30, 50, 100 meter lengths)

Specifications subject to change without notice
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Why choose the LI-1500?

= Large 1-GB memory for storing data and up to 100

sensor-specific multipliers

* Rugged, weather-resistant housing and optional GPS

for outdoor use or transect measurements

® Eight math functions, including integration, natural

logarithm, and underwater attenuation

LI-1500 Specifications

Current Inputs: 3 BNC connectors for LI-COR sensors
Output Channels:

e Light

e 8 Math Channels: addition, subtraction, multiplica-

tion, division, natural logarithm, integration, daily
integration, attenuation

e GPS (optional)

e Prompt

e Battery Voltage

Input Channel Specifications:

e Frequency Rejection: >70dB at 50 or 60 Hz (1 input
channel @ sampling rates of 1, 2, 5, 10, 20Hz)

e Current Accuracy: + 0.3% of full scale reading
@25 °C
e Signal Ranges:

Range # | Current Range Resolution (Typical)
1 0-0.250 pA 0.0305 nA

2 0-2.50pA 0.1525 nA

3 0-25pA 1.525 nA

4 0-250 pA 15.25 nA

e Raw Mode (1 - 500 Hz): Selectable Range
e Standard Modes (Continual, Manual, Daily, One
Time):
= Auto range for total sampling rate < 3 Hz (e.g.
1 Hz sampling on three input channels)

= Fixed range (selectable) for total sampling rates
> 3 Hz (e.g. 2 Hz sampling on two input channels)

Sampling Rates:
e Standard Modes: 0.01 Hz, 0.1 Hz, 1 Hz, 2 Hz, 5 Hz,
10 Hz, 20 Hz

e Raw Mode: 1 - 500 Hz (1 Hz through 500 Hz in
whole number increments)

Logging Rates:

e Standard Modes Sampling: Every Sample, 100 msec,
200 msec, 500 msec, 1 sec, 5 sec, 10 sec, 15 sec,
30 sec, 60 sec, 100 sec, 5 min, 15 min, 30 min, 1 hr,
2 hr,3hr, 6 hr, 12 hr, 24 hr

e Raw Mode Sampling: Every sample (1 — 500 Hz)

Averaging:

e Multiple averaging windows available with standard
mode sampling

Display: 128 x 64 graphics display

Real-Time Clock:

e Year, Month, Day, Hour, Minute, Seconds

e Accuracy of = 3 minutes per month

Data Storage Capacity: 1 GB (FAT16 file system)
Communications: USB (as mass storage device)

Global Positioning System (Option): GPS RADIONOVA®
RF Antenna Module

Power Supply Options:
e 4 "AA” size batteries
e USB, AC-DC power adapter

e USB, external battery power pack (customer
supplied)

Battery Life:

e 80 hours life (typical usage with 1 Hz sampling and
logging rate)

e 40 hours life (typical usage with GPS option on)
Environmental Conditions:
e QOperating Temperature Range: -20 to 50°C

e Humidity Range: 0 to 95% RH (non-condensing
conditions)

e Storage Temperature Range: -40 to 65°C
Size: 20.9x9.8x3.5cm (8.2" x 3.9" x 1.4")
Weight: 0.454 kg (1.0 Ib) with batteries

Specifications subject to change without notice.
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[ [-250A
Light Meter

The LI-250A Light Meter provides a direct
digital readout for any LI-COR radiation
sensor equipped with a BNC connector.
It displays instantaneous sensor output
or 15-second averages, along with mea-
surement units for any LI-COR sensor
(umol s m?2, lux, klux, or W m?).

LI-250A

Light Meter

Quantum/Radiometer/Photometer

L/ COR°

Biosciences



Why choose the LI-250A?

" Retains two sensor multipliers in memory to aid in
switching between sensors, or for storing in-air and
in-water multipliers when used with underwater
Sensors

= Automatic range selection for the best accuracy and
resolution in a wide variety of light environments

= Uses a high-gain amplifier for long-term stability,
automatic zeroing, and low input impedance, result-
ing in excellent linearity

LI-250A Light Meter Specifications

e Accuracy: e Operating Conditions: 0 to 55 °C, 0 to 95% RH
= 25 °C: Typically + 0.4% of reading + 3 counts (non-condensing).
on the least significant digit displayed (all e Storage Conditions: -55 to 60 °C, 0 to 95% RH
ranges). (non-condensing).
0 - 55 °C: Typically + 0.6% of reading + 3 e Size:14Lx77W x3.8cmD(55"x3"x 15",
counts on the least significant digit displayed e Waeight: 0.26 kg (0.57 Ibs).
(all ranges). .
e Range Selection: Autoranging (3 ranges). 200 DRSOl ution.
e Linearity: + 0.05%. Sensor Range Resolution
* Sensors: Designed for LI-COR sensors with Quantum 199 ymol s m? 0.01 pmol s m?
BNC-type connectors. 1999 0.1
. . . ; . 19999 1
e Sensor Calibration: Each sensor is supplied with
a calibration multiplier. Calibration multipliers for Pyranometer 19 W m? 0.001 W m?
two sensors can be stored in memory. 199 0.01
Calibration multipliers are entered from the 1999 0.1
keypad. Photometric | 199 lux 0.01 lux
e Signal Averaging: Sensor output can be col- 1999 0.1
lected and displayed as a 15-second average 19999 1

(approximately 60 readings). Averages are
retained on the display in HOLD mode.

e Display: 4 2" digit LCD display. Updated every
0.5 seconds in Instantaneous mode.

e Battery Life: 150 hours typical with continuous
operation.

e Power Requirement: One 9V Alkaline battery.




Sclence

LI-COR terrestrial light sensors are cosine-corrected, following
Lambert's cosine law. A cosine-corrected sensor provides the
most accurate measurements of radiation on a flat surface from
all angles. Cosine correction ensures accurate measurements
under various conditions such as low light levels and low solar
elevation angles.

The design of the sensor creates the proper cosine response
at angles of incidence up to 82°. Radiation is received by an
acrylic disc called a diffuser, or “eye”. When radiation strikes
with a greater angle of incidence, more is received by the edge
of the diffuser. This compensates for increasing reflection from
the top surface as the angle of incidence grows larger. Beyond
an angle of about 80°, the rim of the sensor begins to block
some light in order to maintain the correct response as more
radiation is received by the edge of the diffuser. At a 90° angle
of incidence, the rim completely blocks the diffuser, in keeping
with a proper cosine response.

LI-COR light sensors create the proper cosine response at
various angles of incidence.

1. 0°: Light is received only by the top surface of the sensor eye.

2. 60°: Light is received by the edge of the eye, compensat-
ing for increasing reflection from the top.

3. 80°: The rim of the sensor begins to block some light, pre-
venting too much from striking the edge.

4. 90°: The rim completely blocks the sensor eye, in keeping
with a proper cosine response.




LI-COR Calibration Standards

Calibration is an integral step in the manufac-
ture of all LI-COR optical radiation-measuring
instruments. Because of slight variation in
internal optical components, it is necessary to
characterize each individual sensor before it
leaves LI-COR. This calibration data is supplied
as a “calibration constant,” which indicates the
amount of sensor output for a given amount
of measurable energy input.

Calibration constants are used to convert the
raw signal into the appropriate units of solar
radiation. A readout device such as the LI-1500
Light Sensor Logger or LI-250A Light Meter
can store calibration multipliers to do this con-
version automatically. Other loggers and
meters must have their data scaled by a factor
determined from the calibration constant to
derive the appropriate units.

The characteristics of the optical components
may be affected by environmental conditions.
We recommend recalibration every two years
to ensure correct measurements.

Pyranometer Calibration

LI-200R Pyranometers are calibrated against
an Eppley® Precision Spectral Pyranometer
(PSP) under natural daylight conditions.
Calibration uncertainty under these conditions
is estimated as + 3% typical, within + 60°
angle of incidence.*

Quantum Sensor Calibration

Quantum sensors, including the LI-190R,
LI-191R, LI-192, and LI-193, are calibrated using
working standard quartz halogen lamps, which
have been calibrated against reference stan-
dard lamps traceable to the U.S. National
Institute of Standards and Technology (NIST).
The absolute calibration specification for quan-
tum sensors is = 5% (typically = 3%) traceable
to NIST.

Photometric Sensor Calibration

The LI-210R photometric sensors are calibrated
using 683 lumens per watt as a value of spec-
tral luminous efficiency at a wavelength of 555
nm. This value conforms to the recommenda-
tions of the International Committee for
Weights and Measures (CIPM). Calibration is
performed using working standard quartz hal-
ogen lamps, which have been calibrated
against reference standard lamps traceable to
the NIST.

*Preliminary specification



Ordering

'INnformation

Sensors

Terrestrial Sensors
Sensor: LI-190R Quantum Sensor, LI-200R
Pyranometer, or LI-210R Photometric Sensor

Cable length: 2 m, 5 m, 15 m, or 50 m

Termination type: BNC, bare leads, millivolt adapter,
or SMV (Standard Output Millivolt Adapter)

LI-191R Line Quantum Sensor

Each LI-191R includes a bubble level and carrying case.

Cable length: 2 mor5m

Termination type: BNC, Millivolt Adapter, or SMV
(Standard Output Millivolt Adapter)

Underwater Quantum Sensors
Sensor: LI-192 Underwater Quantum Sensor or LI-193
Spherical Underwater Quantum Sensor

Cable length: 3m, 10 m, 30 m, 50 m, or 100 m
Termination type: BNC or Millivolt Adapter

Logger and Meter

LI-1500 Light Sensor Logger

The LI-1500 connects up to three light sensors with
BNC terminals. Includes four AA batteries, USB cable,
AC power supply adapter, carabiner clip, carrying case,
Windows?® file viewer software. Sensors sold
separately.

LI-1500G Light Sensor Logger with GPS
GPS-enabled.

LI-1500G-UW Light Sensor Logger with
GPS - Underwater Package

GPS-enabled. Includes underwater lowering frame and
carrying case for underwater light sensors, lowering
frame, and cables.

LI-1500-UW Light Sensor Logger —

Underwater Package

LI-1500 without GPS. Includes underwater lowering
frame and carrying case for underwater light sensors,
lowering frame, and cables.

LI-250A Light Meter

Connects to any light sensor with a BNC terminal and
displays instantaneous or 15-second averaged
measurements.



Accessories

1500GPS Upgrade Kit

User-installable upgrade adds GPS functionality to any
LI-1500.

1500-01 Underwater Carrying Case

Case holds one LI-1500, underwater lowering frame,
two LI-192 Underwater Quantum Sensors, two LI-193
Spherical Underwater Quantum Sensors, one terrestrial
sensor (LI-190R, LI-200R, or LI-210R), and 3-meter or
10-meter underwater cable.

LI-250A Carrying Case

Fabric case for the LI-250A and one light sensor.

2001S Sensor Base Cover
Protects the base and cable when the sensor head is
removed.

2003S Mounting and Leveling Fixture

For the LI-190R, LI-200R, and LI-210R Sensors.
Anodized aluminum with stainless steel leveling screws
and a weatherproof spirit level. 7.6 cm diameter (3.0")
and 95 g (0.21 lbs.).

2009S Lowering Frame
Mounts one or two LI-192SA or LI-193SA sensors for
lowering into water.

2420 Light Sensor Amplifier

Amplifies signal from light sensors. For use with
logging devices that require an amplified voltage signal.
Provides 15 gain settings to accommodate a wide
variety of data loggers.

2420-BNC - For light sensors with BNC connectors.
2420-BL - For light sensors with bare leads.

Millivolt Adapters

Convert BNC connector to bare leads and the output
signal to millivolts (mV). For use with logging devices
that require a voltage signal. SMV-type adapters feature
a standard output (0 to 10 mV) so that multipliers do
not need to be changed when changing sensors.
SMV-type adapters are factory adjusted to match a
particular sensor’s output. Provide the sensor’s serial
number when ordering.

2220 Millivolt Adapter — For the LI-200R
Pyranometer.

2290 Millivolt Adapter — For the LI-T90R Quantum
Sensor, LI-210R Photometric Sensor, and LI-191R Line
Quantum Sensor.

2291 Millivolt Adapter — For the LI-192SA and
LI-193SA Underwater Sensors.

2320 (SMV) - For the LI-200R Pyranometer.

2319 (SMV) - For the LI-190R Quantum Sensor or
LI-191R Line Quantum Sensor.

2321 (SMV) - For the LI-210R Photometric Sensor.
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Global Headquarters

4647 Superior Street
Lincoln, Nebraska 68504

Phone: +1-402-467-3576
Toll free: 800-447-3576 (USA and Canada)
FAX: +1-402-467-2819

envsales@licor.com
envsupport@licor.com
www.licor.com/env

LI-COR Distributor Network
www.licor.com/env/distributors

Regional Offices

LI-COR GmbH, Germany
Serving Andorra, Albania, Cyprus, Estonia,
Germany, Iceland, Latvia, Lithuania, Liech-
tenstein, Malta, Moldova, Monaco, San
Marino, Ukraine, and Vatican City.

LI-COR Biosciences GmbH
Siemensstrale 25A
61352 Bad Homburg
Germany

Phone: +49 (0) 6172 1717 771
Fax: +49(0) 6172 17 17 799

envsales-gmbh@licor.com
envsupport-gmbh@licor.com

LI-COR Ltd., United Kingdom
Serving Denmark, Finland, Ireland, Norway,
Sweden, and UK.

LI-COR Biosciences UK Ltd.
St. John's Innovation Centre
Cowley Road

Cambridge

CB4 0WS

United Kingdom

Phone: +44 (0) 1223 422102
Fax: +44 (0) 1223 422105

envsales-UK@licor.com
envsupport-UK@licor.com

The LI-COR board of directors would like to take this
opportunity to return thanks to God for His merciful
providence in allowing LI-COR to develop and com-
mercialize products, through the collective effort of
dedicated employees, that enable the examination of
the wonders of His works.

“Trustin the LORD with all your heart and do
not lean on your own understanding. In all your
ways acknowledge Him, and He will make your
paths straight.”

— Proverbs 3:5,6

LI-COR is a registered trademark of LI-COR, Inc.
in the United States and other countries. All other
trademarks belong to their respective owners.

For patentinformation, visit
www.licor.com/patents.

©2015 LI-COR, Inc.




ANEXO E:

Hoja de datos del sensor AC CR3111-
3000
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Split Core Current Transformer

CR3100 Series The CR3100 Series Split Core Current Transformer is

designed fo provide a low cost method to monitoring electri-
cal current. A unique hinge and locking snap allows attach-
ment without interrupting the current-carrying wire. High
secondary turn will develop signals up to 10.0 VAC across a
burden resistor.

CR3109-1500 CR3110-3000

High Secondary Turns
Secure Locking Hinge
CR3111-3000 R3] 13-2000 sl’ed'ﬁ‘u'ions
Maximum Continuous Primary Current 4XIr
CR3Io9 1500 30 AMP Insulation Voltage 3500 Vac/1min
CR3110 - 3000 75 AMP Storage Temp. -45°C thru +85°C
CR3111 - 3000 100 AMP Operating Temp. -40°C thru +65 °C
CR3113 - 2000 150 AMP Reguluiory Agencies

Part Number Vmax RMS | Te (typ.) DR Q Frequency

R3T09-1500 ; 7510 T | 20-1KH CN us YT 4

(R3110-3000 15 3100 515 201 Kz s
RoHS

CR3111-3000 19 3150 30| 20-1KH: CR3110-3000 ONLY o=
(R3113-2000 T6 275 ) 20-1 KMz

Iy = Maximum Input Current to be linearly sensed ~ Vpperse = Maximum Voltage (Saturation) CT will develop T
T = Effective turns ratio induding losses  (All Specifications tested at 60 Hz) j

-—A—— . D —
ID(R
VL-Vmux- X ]v_ xR

G I

For best linearity, choose R such that V < 0.8 V|
C ]
F
[ N T
i — — AN

0.76 | 0.19 | 1.24 | 6.10 | 0.82 | 0.20 //
CR3109-1500 (19.2)|4.90) | 31.5)| 1.55) | (20.8) | 15.08) =
CR3110-3000 1.00 | 0.30 | 1.57 | 5.91 | 1.04 | 0.24 T

(25.5)|(10.2) | (40.0) | (150) | (26.5) |(6.10) %// I

1.24 | 0.62 | 1.77 | 6.10 | 1.22 | 0.20
CR3111-3000 (31.4)|(15.7) | (45.0) | (155) | (31.0)(5.08)

2.68 | 0.98 | 2.56 | 118 | 0.72 | 0.20
CR3113-2000 (68.7) [ (24.9) | (65.0)|(3000)| (18.4) | (5.08)

The Professional

comry 3500 Scarlet Ok Blvd. St Louis MO USA 63122 V: 636-343-8518 F: 636-343-5119
MAGNEFES e, http://www.crmagnetics.com 102 E-mail: sales@crmagnetics.com

1S0 9001:2008 Quality Management System



ANEXO F:

Hoja de datos del sensor DC
L01Z100S05



Issued by Module Components Div, TAMURA CORPORATION

Hall Effect Current Sensors L01Z***S05 Series
Features: Advantage:

e Open Loop type o Excellent accuracy

¢ Printed circuit board mounting e Very good linearity

e Unipolar power supply e Low temperature drift

o Aperture for cable or bus bar ¢ Wide frequency bandwidth

¢ Insulated plastic case according to e No insertion loss

uL94vo e High Immunity To External Interference
e Optimised response time
e Current overload capability
Specifications TA=25°C, Voo=+5V, Ri=10kQ
Parameters Symbol|L01Z050S05|L01Z100S05[L01Z150S05 [L01Z200S05 | L01Z300S05|L01Z400S05|L01Z500S05[L01Z600S05
Primary nominal current P 50AT 100AT 150AT 200AT 300AT 400AT 500AT 600AT
Saturation current ltmax > +kkx1.25
Vort1.5V
Rated output voltage (atIf) [ Vo | (2% Vor+1.5V + 0.035V
V 1

Offset voltage'(at If=0A) Vs iO.B%FSV Vrer' £ 0.030V
Saturation output voltage | Vo mins Vomin £ 0.5V, 4.5V < V;max
Output linearity?(0A~If) € <+1% (atlf)
Power supply voltage Vce 5V +2%
Consumption current Icc < 15mA
Response time® t, < 10ps (at di/dt = 100A / ps)
Thermal drift of gain* TcVo < +2mV/°C <+1.5mV/°C
Thermal drift of offset TcVof |< £ 2mV/°C <+ 1.0mV/°C
Hysteresis error
(at If=0A—If—0A) Vou <8mV <4mV <6mVv
Insulation voltage Vg AC2500V for 1minute (sensing current 0.5mA), inside of through hole < terminal
Insulation resistance Ris > 500MQ (at DC500V), inside of through hole <> terminal
Ambient operation tem- e
perature Ta -10°C~+80°C
Ambient storage tempera- -
ture Ts -15°C~+85°C

" Vger = Voo 2 (ratiometric). After removal of core hysteresis— 2 Without offset — ® Time between 90% input current full scale and 90% of sensor output full scale —
* Without Thermal drift of offset

Electrical Performances

Frequency characteristic(L01Z600S05) 5o Saturation characteristic(L01Z600S05)
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ANEXO G:

Disefio y Esquematico de Placa
Principal y de Periféricos



Placa Central
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Placa de Conexiones
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ANEXO H:

Disefio de chasis del dispositivo de
monitoreo
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ANEXO I:

Datos y calculos del sistema de
monitoreo



TENSION DC

DATOS CALCULOS
Valor Mediciones del Sistema Medicién de Precision Error de
Referencial | medida 1 medida 2 medida 3 promedio Fluke 175 medicion (%)
15 14.77 14.77 14.77 14.77 15.36 0.00 -3.84
30 29.65 29.65 29.65 29.65 30.33 0.00 -2.24
40 39.61 39.61 39.61 39.61 40.30 0.00 -1.71
50 49.69 49.69 49.69 49.69 50.30 0.00 -1.21
65 64.45 64.45 64.45 64.45 65.00 0.00 -0.85
73 72.42 72.42 72.42 72.42 73.00 0.00 -0.79
80 80.39 80.39 80.39 80.39 80.80 0.00 -0.51
87 87.07 87.07 87.07 87.07 87.40 0.00 -0.38
95 94.22 94.34 94.22 94.26 94.30 0.07 -0.04
100 100.46 100.46 100.46 100.46 100.60 0.00 -0.14
110 109.92 109.80 109.92 109.88 109.90 0.07 -0.02
PROMEDIO 0.01 -1.07
TENSION DC
120.00
100.00
80.00
60.00 ¢ TENSION DC
— Linealidad del sistema
40.00
y =1.0072x - 0.9079
20.00 ‘/
0.00 T T T T T 1
0.00 20.00 40.00 60.00 80.00 100.00 120.00




TENSION AC

DATOS CALCULOS
Valor Mediciones del Sistema Medicién de Precision Error de
Referencial | medidal  medida2  medida8 | promedio Fluke 175 medicion (%)
20 19.54 19.54 19.54 19.54 20.40 0.00 -4.22
40 39.69 39.69 39.77 39.72 40.15 0.05 -1.08
60 59.53 59.53 59.53 59.53 60.40 0.00 -1.44
80 81.20 80.90 80.90 81.00 81.60 0.17 -0.74
100 100.74 100.74 100.44 100.64 100.00 0.17 0.64
120 119.97 119.97 119.97 119.97 120.40 0.00 -0.36
140 140.43 141.65 141.65 141.24 140.50 0.70 0.53
160 161.80 161.49 161.18 161.49 161.00 0.31 0.30
180 181.64 180.72 181.33 181.23 180.70 0.47 0.29
200 202.40 203.01 202.70 202.70 202.00 0.31 0.35
220 227.43 226.21 224.64 226.09 223.60 1.40 1.12
PROMEDIO 0.33 -0.42
TENSION AC
250.00
200.00
¢ TENSION AC
150.00
—— Linealidad del
100.00 sistema
y=1.0125x - 1.2971
50.00 /
0.00 T T T T ]
0.00 50.00 100.00 150.00 200.00 250.00




FRECUENCIA (ANEMOMETRO)

DATOS CALCULOS
Valor Mediciones del Sistema Medicién de Osciloscopio Precision Error de
Referencial medida 1 medida 2 medida 8 promedio Tektronix medicion (%)
8.00 8.01 8.01 8.01 8.01 8.00 0.00 0.12
18.00 18.07 18.07 18.07 18.07 18.05 0.00 0.11
28.00 28.32 28.32 28.32 28.32 28.25 0.00 0.25
38.00 37.98 37.98 37.98 37.98 37.88 0.00 0.26
48.00 48.05 48.05 48.05 48.05 48.08 0.00 -0.06
58.00 57.91 57.91 57.91 57.91 58.47 0.00 -0.96
68.00 68.31 68.31 68.31 68.31 68.50 0.00 -0.28
78.00 77.96 77.96 77.96 77.96 77.88 0.00 0.10
88.00 87.44 87.44 87.44 87.44 87.41 0.00 0.03
98.00 96.73 96.73 96.73 96.73 96.71 0.00 0.02
108.00 106.44 106.44 106.44 106.44 106.40 0.00 0.04
118.00 119.14 119.14 119.12 119.13 119.10 0.01 0.03
125.00 126.47 126.49 126.50 126.49 126.60 0.02 -0.09
PROMEDIO 0.00 -0.03
FRECUENCIA (ANEMOMETRO)
140.00
120.00 /
100.00
80.00 L FRECUE!\ICIA
(ANEMOMETRO)
60.00 ——Linealidad del sistema
40.00 y = 0.9998x - 0.0259
20.00 ‘/Q
0.00 T T ]
0.00 50.00 100.00 150.00




VELETA

DATOS CALCULOS
Valor Mediciones del Sistema L Error de
. - - - - Precision .,
Referencial medida 1 medida 2 medida 8 promedio medicion (%)
0.00 0.69 0.69 0.69 0.69 0.00 -
45.00 39.91 39.91 39.91 39.91 0.00 -11.31
90.00 90.61 90.61 90.61 90.61 0.00 0.68
135.00 136.38 136.38 136.38 136.38 0.00 1.02
180.00 181.14 181.14 181.14 181.14 0.00 0.63
225.00 233.89 233.89 233.89 233.89 0.00 3.95
270.00 272.41 272.41 272.41 272.41 0.00 0.89
315.00 324.46 324.46 324.46 324.46 0.00 3.00
PROMEDIO 0.00 -0.16
VELETA

350.00

300.00 //

250.00 /

200.00 / ¢ VELETA

150.00

/ —— Linealidad del
100.00 / sistema
50.00 y =1.0327x - 2.7092
0.00 T T T )
_50.000. 0 100.00 200.00 300.00 400.00




CORRIENTE DC

DATOS CALCULOS
Valor Mediciones del Sistema Medicién de Precision Error de
Referencial | medidal medida2  medida3 | promedio Fluke 175 medicion (%)
6 6.60 6.60 6.60 6.60 6.68 0.00 -1.20
13 13.45 13.45 13.45 13.45 12.96 0.00 3.78
16 16.71 16.71 16.71 16.71 16.47 0.00 1.44
20 19.96 19.96 19.96 19.96 19.95 0.00 0.04
23 23.22 23.22 23.22 23.22 23.22 0.00 0.02
27 27.13 27.13 27.13 27.13 26.48 0.00 2.45
30 30.39 30.39 30.39 30.39 29.90 0.00 1.63
33 33.65 33.65 33.65 33.65 33.28 0.00 1.11
37 37.23 37.23 37.23 37.23 36.64 0.00 1.61
40 40.49 40.49 40.49 40.49 39.96 0.00 1.33
44 44.40 44.40 44.40 44.40 43.18 0.00 2.83
48 48.64 48.64 48.64 48.64 47.41 0.00 2.60
PROMEDIO 0.00 1.47
CORRIENTE DC

60.00

50.00

40.00 /

© CORRIENTE DC
30.00
20.00 _— L.inealidad del
sistema
y =1.0269x - 0.2738
10.00 /
0.00 T T T T ]
0.00 10.00 20.00 30.00 40.00 50.00




CORRIENTE AC

DATOS CALCULOS
Valor Mediciones del Sistema Medicién de pinza Precision Error de
Referencial | medida 1 medida 2 medida 3 promedio amperimétrica medicion (%)
9 9.01 8.90 9.01 8.97 8.70 0.06 3.14
20 20.30 20.30 20.30 20.30 19.90 0.00 2.01
20.5 20.63 20.63 20.63 20.63 20.50 0.00 0.63
25 24.93 24.93 24.93 24.93 25.10 0.00 -0.68
30 29.43 29.43 29.43 29.43 29.60 0.00 -0.57
33 33.62 33.73 33.62 33.66 34.50 0.06 -2.44
38 37.70 37.70 37.70 37.70 38.00 0.00 -0.79
42 42.31 42.31 42.21 42.28 42.50 0.06 -0.53
47 46.71 46.71 46.71 46.71 47.00 0.00 -0.62
50 50.48 50.38 50.48 50.45 50.70 0.06 -0.50
55 55.09 55.46 55.41 55.32 55.00 0.20 0.58
60 60.75 60.64 60.64 60.68 60.07 0.06 1.01
PROMEDIO 0.04 0.10
CORRIENTE AC
70.00
60.00
50.00
40.00
¢ CORRIENTE AC
30.00 —— Linealidad del sistema
20.00 y = 1x - 0.0432
10.00 -
0.00 T T T ]
0.00 20.00 40.00 60.00 80.00




ANEXO J:

Codigo fuente para el sistema de
monitoreo



#include <DS1307RTC.h>
#include <Keypad.h>
#include <Time.h>
#include <Timelib.h>
#include <Wire.h>
#include <DS1307RTC.h>
#tinclude <SD.h>

#include <SPI.h>

#tinclude <SimpleTimer.h>
#include <FreqMeasure.h>
#tinclude <LiquidCrystal.h>

const byte numRows= 4;
const byte numCols= 4;
char keymap[numRows][numCols]= { {'1', '2', '3', 'A"},
{'4','5','6', 'B'},
{'7','8','9','C'},
{*,'0, #, "D}y
byte rowPins[numRows] = {30,31,32,33}; //Rows O to 3
byte colPins[numCols]={38,39,40,41}; //Columns O to 3
//initializes an instance of the Keypad class
Keypad myKeypad= Keypad(makeKeymap(keymap), rowPins, colPins, numRows, numCols);

constintrs=12,en=11,d4 =25,d5=24,d6 =23, d7 =22;
LiquidCrystal lcd(rs, en, d4, d5, d6, d7);

SimpleTimer timer;
double sum=0;
int count=0;

File myFile;

int savelnd=0;
float Sensor0=0;
float Sensor1=0;
float Sensor2=0;
float Sensor3=0;
float Sensor4=0;
float Sensor5=0;
float Sensor6=0;
float Sensor7=0;
float Sensor8=0;
float Sensor9=0;
float Sensor10=0;
float Sensor11=0;
float Sensor12=0;
float Sensor13=0;
float Sensor14=0;
float Sensor15=0;
float Sensor16=0;



float Sensor[17]={Sensor0, Sensorl, Sensor2, Sensor3, Sensor4, Sensor5, Sensor6, Sensor7,
Sensor8, Sensor9, Sensor10, Sensorll, Sensorl2, Sensor13, Sensorl4, Sensor15, Sensor16};
String
Unidades[17]={"Vac","Aac","Vdc","Adc","Vdc","Adc","Vdc","Adc","Vdc","Adc","Vdc","Adc","Vd
c","Adc","lum","deg","m/s"};

int Ind=0;
int IndSensor=0;

int Ind0=0;
int Ind1=1;
int Ind2=2;
int Ind3=3;

void setup() {
//Serial.begin(9600);

Icd.begin(20, 4);

Icd.clear();
Icd.setCursor(6,0);
lcd.print("Datalogger");
Icd.setCursor(2,1);
lcd.print("Trabajo de tesis");
Icd.setCursor(2,2);
lcd.print("Vicente Richard");
Icd.setCursor(7,3);
lcd.print("20122893");
delay(3000);

setSyncProvider(RTC.get);//sincronizar con reloj RTC
if (timeStatus() != timeSet) {//comprobar que se encuentra conectado al modulo RTC
Icd.clear();
Icd.setCursor(1,1);
Icd.print("No es posible");
Icd.setCursor(1,2);
Icd.print("sincronizar reloj");
delay(3000);}
else {
Icd.clear();
Icd.setCursor(1,1);
Icd.print("RTC ha sincronizado");
Icd.setCursor(1,2);
Icd.print("tiempo del sistema");
delay(3000);}

Icd.clear();



Icd.setCursor(2,1);
lcd.print("Iniciando SD ...");
delay(3000);

if (ISD.begin(4)) {//comprobar que se encuentra la tarjeta micro sd en canal 4
Icd.clear();
Icd.setCursor(0,1);
Icd.print("No pudo inicializar");
return;

}

Icd.clear();
Icd.setCursor(3,1);
lcd.print("Inicializacion");
Icd.setCursor(6,2);
lcd.print("exitosa");
delay(3000);
SD.begin(4);

if(1SD.exists("datalog.csv"))//comprobar si no existe el archivo datalog.csv
{
myFile = SD.open("datalog.csv", FILE_WRITE);//crear archivo
if (myFile) {
Icd.clear();
Icd.setCursor(3,1);
lcd.print("Archivo nuevo");
Icd.setCursor(1,2);
Icd.print("Escribiendo fila 1");
delay(3000);
myFile.printIn("sep=,");//definir "," como separador
myFile.printIn("Fecha(DD/MM/YYY),Hora,Vacl,lacl,PotAC1,Vdcl,ldc1,PotDC1,Vdc2,ldc2,P
otDC2,Vdc3,ldc3,PotDC3,Vdc4,ldc4,PotDC4,Vdc5,ldc5,PotDC5,Vdc6,ldc6,PotDC6,IntLum,D
irViento,VelViento");//Indices de valores
myFile.close();

timer.setinterval(1000, mainCode);//ejecutar mainCode cada 1000 milisegundos
FreqMeasure.begin(); //iniciar medicién de frecuencia
Ind==0;



void loop() {
timer.run(); //iniciar timer

if (FreqgMeasure.available()) {//calcular promedio de lecturas
sum = sum + FregMeasure.read();
count = count +1;
if (count > 30) {
Sensorl6 = ((FregMeasure.countToFrequency(sum / count))*96)/125;
sum =0;
count=0;
}

}
char keypressed = myKeypad.getKey();
if (keypressed = NO_KEY){
if (Ind==0){
if (keypressed=="1"){
Ind=1;
IndSensor=0;
}
else if (keypressed=="2"){
Ind=2;
}
else if (keypressed=="'3"){
Ind=3;
}
else if (keypressed=="'4')}{
Ind=4;
}
}
else if (Ind==1){
if (keypressed=='D"){
Ind=0;
!
else if (keypressed=="'B'){
if (IndSensor<16){IndSensor=IndSensor+1;}
else {IndSensor=0;}
}
else if (keypressed=="A"){
if (IndSensor>0){IndSensor=IndSensor-1;}
else {IndSensor=16;}
1
}
else if (Ind==2){
if (keypressed=='D"){
Ind=0;
!
}



else if (Ind==3){
if (keypressed=='D"){
Ind=0;
}
}
else if (Ind==4){
if (keypressed=='D"){
Ind=0;
1
}

void mainCode(){
Sensor0 = analogRead(A0)*(5.0/1023.0)*62.459061; //VAC1
Sensor[0] = SensorO0;
Sensorl = analogRead(A1)*(5.0/1023.0)*21.4289912; //1AC1
Sensor[1] = Sensorl;
Sensor2 = analogRead(A12)*(5.0/1023.0)*24; //VDC1
Sensor[2] = Sensor2;
if(analogRead(A13)<=3){Sensor3=0;}
else {Sensor3 = (((analogRead(A13)*(5.0/1023.0))-2.55)*66.666667);} //IDC1
Sensor[3] = Sensor3;
Sensor4 = analogRead(A10)*(5.0/1023.0)*24;
Sensor[4] = Sensor4;
if(analogRead(A11)<=3){Sensor5=0;}
else {Sensor5 = (((analogRead(A11)*(5.0/1023.0))-2.55)*66.666667);}
Sensor[5] = Sensor5;
Sensor6 = analogRead(A8)*(5.0/1023.0)*24;
Sensor[6] = Sensor®6;
if(analogRead(A9)<=3){Sensor7=0;}
else {Sensor7 = (((analogRead(A9)*(5.0/1023.0))-2.55)*66.666667);}
Sensor[7] = Sensor7;
Sensor8 = analogRead(A6)*(5.0/1023.0)*24;
Sensor[8] = Sensor8§;
if(analogRead(A7)<=3){Sensor9=0;}
else {Sensor9 = (((analogRead(A7)*(5.0/1023.0))-2.55)*66.666667);}
Sensor[9] = Sensor9;
Sensorl0 = analogRead(A4)*(5.0/1023.0)*24;
Sensor[10] = Sensor10;
if(analogRead(A5)<=3){Sensor11=0;}
else {Sensorll = (((analogRead(A5)*(5.0/1023.0))-2.55)*66.666667);}
Sensor[11] = Sensorl1;
Sensorl2 = analogRead(A2)*(5.0/1023.0)*24;
Sensor[12] = Sensor12;
if(analogRead(A3)<=3){Sensor13=0;}
else {Sensor13 = (((analogRead(A3)*(5.0/1023.0))-2.55)*66.666667);}



Sensor[13] = Sensor13;

Sensorl4 = analogRead(A14)*(5.0/1023.0)*606.060606; //sensado de intensidad luminosa
Sensor[14] = Sensor14;

Sensorl5 = analogRead(A15)*(5.0/1023.0)*71; //sensado de direccidn de viento
Sensor[15] = Sensor15;

Sensor[16] = Sensor16;

if (Ind==0){Home();}

if (Ind==1){Measurements();}
if (Ind==2){Status();}

if (Ind==3){Utilities();}

if (Ind==4){Settings();}

if(savelnd<14){ //guardar datos cada 15s
savelnd=savelnd+1;

}

else {
saveSD();
savelnd=0;

}

!

void Home(){
Icd.clear();
Icd.setCursor(0,0);
lcd.print("1. Medidas");
Icd.setCursor(0,1);
lcd.print("2. Status");
Icd.setCursor(0,2);
lcd.print("3. Utilidades");
Icd.setCursor(0,3);
lcd.print("4. Settings");

void Measurements(){

if(IndSensor==14){
Indo=14;
Ind1=15;
Ind2=16;
Ind3=0;

}

if(IndSensor==15){
Ind0=15;
Ind1=16;
Ind2=0;
Ind3=1;

1



if(IndSensor==16){
Ind0=16;
Ind1=0;
Ind2=1;
Ind3=2;
}
if((IndSensor>=0)&&(IndSensor<=13){
IndO=IndSensor;
Ind1=IndSensor+1;
Ind2=IndSensor+2;
Ind3=IndSensor+3;

}

Icd.clear();
Icd.setCursor(0,0);
Icd.print(Ind0);
lcd.print(". ");
Icd.print(Sensor[Ind0]);
lcd.print("");
Icd.print(Unidades[IndO0]);
Icd.setCursor(0,1);
lcd.print(Ind1);
lcd.print(". ");
Icd.print(Sensor[Ind1]);
lcd.print(" ");
lcd.print(Unidades[Ind1]);
Icd.setCursor(0,2);
lcd.print(Ind2);
lcd.print(". ");
lcd.print(Sensor[Ind2]);
lcd.print(" ");
lcd.print(Unidades[Ind2]);
Icd.setCursor(0,3);
lcd.print(Ind3);
lcd.print(". ");
Icd.print(Sensor[Ind3]);
lcd.print("");
lcd.print(Unidades[Ind3]);

void Status(){
Icd.clear();
Icd.setCursor(0,1);
lcd.print("2. Status");

}



void Utilities(){
Icd.clear();
Icd.setCursor(0,2);
lcd.print("3. Utilidades");
}

void Settings(){
Icd.clear();
Icd.setCursor(0,3);
lcd.print("4. Settings");
}

void saveDigits(int digits) {
myFile.print(":");
if(digits < 10)
myFile.print('0');
myFile.print(digits);
}

void saveSD(void) {
myFile = SD.open("datalog.csv", FILE_WRITE); //abrir el archivo

if (myFile) {
//guardar datos en la tarjeta micro sd
myFile.print(day());
myFile.print("/");
myFile.print(month());
myFile.print("/");
myFile.print(year());
myFile.print(",");
myFile.print(hour());
saveDigits(minute());
saveDigits(second());
myFile.print(",");
myFile.print(Sensor0);
myeFile.print(",");
myFile.print(Sensorl);
myFile.print(",");
myFile.print(Sensor1*Sensor0);
myFile.print(",");
myFile.print(Sensor2);
myFile.print(",");
myFile.print(Sensor3);
myFile.print(",");
myFile.print(Sensor3*Sensor2);
myFile.print(",");
myFile.print(Sensor4);



myFile.print(",");
myFile.print(Sensor5);
myFile.print(",");
myFile.print(Sensor5*Sensor4);
myFile.print(",");
myFile.print(Sensor6);
myFile.print(",");
myFile.print(Sensor7);
myFile.print(",");
myFile.print(Sensor7*Sensor6);
myFile.print(",");
myFile.print(Sensor8);
myFile.print(",");
myFile.print(Sensor9);
myFile.print(",");
myFile.print(Sensor9*Sensor8);
myFile.print(",");
myFile.print(Sensor10);
myFile.print(",");
myFile.print(Sensor11);
myFile.print(",");
myFile.print(Sensor11*Sensor10);
myFile.print(",");
myFile.print(Sensor12);
myFile.print(",");
myFile.print(Sensor13);
myFile.print(",");
myFile.print(Sensor13*Sensor12);
myFile.print(",");
myFile.print(Sensor14);
myFile.print(",");
myFile.print(Sensorl5);
myFile.print(",");
myFile.printIn(Sensor16);

myFile.close(); //cerrar el archivo

}

else {
Icd.clear();
Icd.setCursor(3,1);
Icd.print("Error al abrir");
Icd.setCursor(5,2);
lcd.print("el archivo");
delay(3000);
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